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INTRODUCTION 

 

AutoCAD software is used by draftsmen and other professionals for preparing the layouts and designs in 

architecture industry. It is also used in other industries for designing the layout of the products and their 

components in three dimensions. 

 

The National Vocational & Technical Training Commission (NAVTTC) has developed a national 

qualification entitled, “National Vocational Certificate Level-2 in Information Technology (CAD-AutoCAD)”. 

Relevant industry and employers were consulted in the design and validation processes in order to come 

up with a national qualification that fulfills the requirements of the sector in general and the occupation in 

particular. 

 

This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum 

of the AutoCAD national qualification. It includes three learning modules which are as under: 

 

Module 1:  Perform Basic Computer Operations. 

Module 2:  Develop 2D Drawings using AutoCAD. 

Module 3:  Develop 3D Model using AutoCAD. 

 
 

This TLM provides support for more effective training and productive learning. Each of the learning modules 

contains learning outcomes and information regarding learning elements in the form of knowledge, skills 

and attitudes. At the end of every learning module are Frequently Asked Questions (FAQs) and Test 

Yourself which will help learners in self-assessment before proceeding to modular or final assessment. 
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Module 1: Perform Basic Computer 
Operations 
 
 
Objective: 

The objective of this module is to provide skills and knowledge related 

to basic computer hardware, software, applications and troubleshooting. 

You will be able to demonstrate your skills in operating a computer 

system and computer applications such as MS Word, MS PowerPoint, 

MS Excel as well as installation and troubleshooting of operating system 

and software. 

 
 
Learning Outcomes: 

After Completion of this learning module, you will be able to: 
 

· Configure Computer System 

· Create a Document using MS Word 

· Preparer a Worksheet using MS Excel 

· Prepare a presentation using MS PowerPoint 
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Learning Unit 1:  

Configure Computer System 

 
 

After completion of this Learning Unit you will be able to: 
 

v Connect computer components and peripherals as per 
requirements. 
 

v Install system software and application software according to the 
Instructional Manual. 

 
v Troubleshoot applications to trace and fix faults (if any) to bring it 

in a running condition. 
 

v Follow health, safety and security procedures to ensure safe 
working environment. 
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1. Configure Computer System

 

In communications or computer systems, a configuration of a system refers to the arrangement of each 

of its functional units, according to their nature, number and chief characteristics. 

Often, configuration pertains to the choice of hardware, software, firmware, and documentation. 

1.1. Computer components and peripherals  

 

A peripheral is a "device that is used to put information into the computer or 

get information out of the computer. Peripheral device is generally defined 

as any auxiliary device such as a computer mouse or keyboard that connects 

to and works with the computer in some way. Other examples of peripherals 

are image scanners, tape drives, microphones, loudspeakers, webcams, 

and digital cameras. This learning unit covers about most commonly used 

peripheral devices and commonly used communication ports in computer. 

After completion of this learning unit you will be able to describe different 

types of peripheral devices and their use. And most commonly used hardware ports. 

 

 

1.1.1. Identify basic components and peripheral devices of computer system. 
A computer peripheral device is an external device that provides input and output for the computer. 

There are three types of peripheral devices one is input that is used for providing input to the 

computer, second is output that is used for providing output and the last one provides input and 

output both 

 

· Input 

Everything that we give to computer is known as Input. Some common input devices include: 

i. Keyboard 

ii. Mouse 

iii. Scanner 

iv. Microphone 

v. Joystick:  

 
 
 
 

i. Mouse 

A mouse is an input device used to point and select items on the computer screen. A 

Mouse controls the movements of cursor. A mouse usually 

has two buttons: A primary button (usually the left button) 

and a secondary button. Many mouse also have a wheel 

between the two buttons, which allows to scroll for ups and 

down options. 

 
 

 

The word computer 
comes from a Latin 
word “Compute” 
which means to 
calculate. 
 

Remember 

Computer is an 
electronics machine 
that accepts the 
instruction in the 
form of Input and 
after process gives us 
information in the 
form of Output. 
 

Remember 
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ii. Keyboard 

A keyboard is used for typing text into the computer. There are many types of keys on 

the keyboard like, Numeric Keys, Alphabet Keys and Function Keys. 

 
 

 
 

iii. Scanner: 

A scanner is an input device that is used to send 

text, graphics or images into computer 

 

iv. Microphone: 

Microphone is an instrument for converting sound waves 

into electrical signal. 

It is sometimes abbreviated as “mic”. A microphone is a 

peripheral that allows computer users to input audio into 

their computers.  

 

v. Joystick: 

Joystick is a lever that moves in all directions and controls the 

movement of a pointer or some other display symbol. A 

joystick is similar to a mouse. 

Joysticks are used mostly for computer games. 

 

 

 

· Output 

Everything that we receive after process is knows as output. Some common output 

devices include: 

 

i. Monitor 

ii. Projector 

iii. Printer 

iv. Plotter 

v. Speakers 
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i. Monitor 

A monitor is an output device used to visual display 

information. Monitor looks like a television screen. 

There are four basic types of monitors: CRT 

(cathode ray tube) monitors, the LCD (liquid crystal 

display) monitors, TFT (thin film transistor) 

monitors, and LED (light emitting diodes) monitors. 

All monitors produce sharp images, but LCD, TFT 

and LED monitors have the advantage of being 

much thin and lighter. 

 

 

ii. Printer 

A printer is an output device used to transfer text, or image 

or photographs onto paper. Printer generates the hard 

copy information. 

 

iii. Projector 

A projector or image projector is an optical device that 

projects moving images onto a large screen. 

 

 

iv. Speaker: 

Speaker is one of the most common output devices 

used with computer. The purpose of speakers is to 

produce audio output that can be heard by the listener. 

 

 

v. Plotter  

Plotter is an output device similar to printer but print the 

large-scale printing 

 

 

 

 

 

· There are some devices that functions both as input and output devices,  

such as: 

 

 

i.  Hard drives 

ii. CD/DVD ROM Drive 

iii. Modems 

iv. Webcam 

 

 

You can store a large 

amount of data on 

Hard disk. External 

hard disks are also 

available for data 

backups. 

Remember 
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i. Hard disk drive 

Hard disk drive is a sealed vacuumed unit that stores 

information permanently. Hard disk comes in the market with 

different size, capacity and shape. Size means 2 ½” used in 

laptop and 3 ½” is used in personal computer and capacity and 

shape means SATA or ATA (IDE). 

 

 

ii. CD (Compact Disc) and DVD (Digital Video Disc) drives 

CD or DVD drive, usually located on the front of the system unit. 

CD drives uses lasers to read data from a CD; many CD drives 

can also write (record) data onto CDs. A DVD drive can do 

everything that CD drive do, but read DVDs also. Many DVD 

drives can record data onto blank DVDs. This readable DVD-RW is also called Combo 

drive. 

 

 

iii. Modem 

Modem is a short name for modulator-demodulator. A 

modem is a device that enables a computer to transmit 

data over telephone or cable lines. A modem converts 

between these two forms from analog to digital and digital 

to analog. There are two types of modem wired and 

wireless. 

 

 

iv. Web Cam: 

A webcam short for “web camera” is a digital camera that 

is connected to a computer. It can send live pictures. Many 

desktop computer screens and laptops come with a built-

in camera and microphone, but if it doesn’t, separate 

webcam can be connected any time. 

 

 

 

 

 

 

 

 

 

 

 

 

· Different Types of Communication Ports: 

In computer hardware, a port serves as an interface between the 

computer and other computers or peripheral devices.  A port 

generally refers to the female part of connection. Computer ports 

have many uses, to connect a monitor, webcam, speakers, or 

Any images you make 

available to others via 

webcam could remain 

on the internet forever. 

Do you know? 

Communication ports 
are the gateway for 
data between devices 
and computers. 

Remember 
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other peripheral devices. These ports are connection points or interfaces with other peripheral 

devices. 

Physical ports/ Communication ports are used for connecting a computer trough a cable and 

a socket to a peripheral device. Physical computer ports list includes: 

 

 

i. Serial ports (DB9 socket),  

ii. USB ports (USB 2.0 or 3.0 socket / connector),  

iii. Parallel ports (DB25 socket / connector), 

iv. Ethernet /internet ports (RJ45 socket / connector). 

v. VGA port (Display port) 

vi. Fire wire (IEEE 1394 interface) 

vii. E-SATA port 

viii. PS/2 port 

 

 

 
 

 

 

i. Serial Ports: 

Serial port is an electronic 

communication gateway used for 

transferring data one bit at a time. 

Serial port was used almost for all 

type of information transfer 

between a computer and other 

peripheral devices. Nowadays serial port has been 

replaced with dedicated ports like USB port. The serial port 

is also known as COM port and when a device is connected to it you will found it in 

device manager on port COM1 or COM2. 

 

Serial ports transfer 
data bit by bit and 
parallel port transfer 

data byte by byte. 

Do you know! 
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ii. USB Port: 

USB port (Universal Serial Bus) is the most useable connection 

point for data transfer in the world. It was created in the mid-

1990s with the intention of replacing all other PC ports like serial 

port, parallel port, PS/2 port.  A standard USB connector is a 

simple socket with 4 pins: one for power, one for ground and two 

for data transfer.  Is used for USB.  

 

 

iii. Ethernet Port: 

Ethernet port is a network 

hardware interface used for data 

transfer and control between 

two devices that can support the 

IP protocol. The Ethernet port 

speed can vary 10Mbps up to 10Gbps. 

 

 

iv. VGA Port: 

The VGA port is used for connecting a 

computer to a monitor. It was the 

replacement of MDA, CGA and EGA 

standards. 

With the development of new and 

powerful processing units came the need 

of a new video standard and this is how 

the VGA port was invented. This new standard brought with VGA monitors compatible 

with 640×480 resolution. 

 

 

v. E-SATA Port: 
An e-SATA is a combined connection for external 

storage devices. An e-SATA or USB device can be 

plugged into an e-SATA port. SATA is a computer 

bus interface for connecting host bus adapters to 

mass storage devices such as hard disk drives and 

optical drives.  e-SATA combines the functionality 

of an e-SATA and a USB port, and a source of power in a single connector. E-SATA 

can supply power at 5 V and 12 V. 

 

 

Ethernet port is also 
called internet 
connection port.   

Do you know! 
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· Basic Parts of Computer System 

A computer is an electronic device which takes input from the 

user, processes it and gives output. Computer consists of 

several parts like CPU, Mouse, Keyboard monitor, LCD, Printer, 

and Speakers. These parts may be different according to the 

system. Like in laptops, touchpad replaces mouse, built in 

speakers in LCD and built in laptop. 

 

 

· Basic Components of Computer System 

There are three basic components of computer system. CPU or system unit, Input unit and 

Output unit. 

 
 

 

 

i. CPU or System unit 

System unit is a base for computer system that is 

commonly known as CPU (Central Processing Unit). 

The central processing unit is "brain" of computer, 

which consists of the following three main parts: 

 

ii. Memory unit 

consists of primary memory and secondary memory. In primary memory, RAM 

(Random Access Memory is primary memory that loads the required data and erase 

it at the time of shutdown/restart. In secondary memory which store information on disc 

drives / devices permanently can be used in future again and again.  

 

iii. Control Unit 

it controls all the devices (peripheral devices) which attached to the computer.  

 

The word computer 
comes from a Latin 
word “Compute” which 
means to calculate. 
So, it is also called a 
calculating device.   

Remember 

There are three basic 
components of 
computer system 
input unit, output unit 
and system unit. 

Remember 
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iv. ALU (Arithmetic Logic Unit) 

It is also called Microprocessor which is the brain of the computer, and deals with all 

the arithmetic (additions, multiplication, subtractions) and logical operations (greater, 

less then, equal etc.) of the computer. 

 

 

 
 

 

 

Learning Activity: 

 Define different types of ports colors according to their connectors. 

 Plug out all the ports from the computer and connect them again for practice. 

 Write the difference between hardware and software? 

 Find out what types of drives are on your computer (CD-ROM, DVD-ROM, etc.). 

 Count the number of USB ports on your computer. 

 What are some of the peripherals you can use with your computer? 
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1.2. Install System Software and Application Software 

 

Computer consists of two main parts Hardware and Software. In software, system software (Operating 

system) is main software which control and manage the computer and all the devices attached to it. This 

learning unit covers the procedure of installing operating system; describes different types of operating 

systems, precautions and hardware requirements for installing operating system. After completion of this 

learning unit, you will be able to demonstrate the procedure for installing Operating System and describes 

the different types of operating system and computer parts. 

 

 

· Hardware and Software: 

Following are the two major elements of the computer. 

 

i. Hardware: 

Hardware are the physical parts of Computer that can be 

seen or touched.  This includes the computer casing, 

monitor, keyboard, and mouse. It also includes all the 

parts inside the computer casing, such as the hard disk 

drive, motherboard, video card, LAN card and many 

others.  

 

 

ii. Software: 

The set of instructions given to the computer to perform a task is called software. 

Computer software or software is any set of machine-readable instructions that 

directs a computer's processor to perform specific operations.  The two main types of 

software are system software and application software. Following are the two main 

types of software. 

 

System software: System software is computer software designed to operate and 

control the computer hardware and to provide a platform for running application 

software. It includes software like operating system language software, device drivers 

 

Application Software includes word processing software, spreadsheet software, 

database software, education software, entertainment software and many more. 

 

 

· Types of Operating Systems: 

 

Operating System: 

An operating system (OS) is a master kind software that control overall system including 

hardware and software and application software. During running it coordinate with all hardware 

and software and utility programs. 

 

Types of Operating Systems: 
Mostly people use the operating system that preinstalled on their computer, but it is possible to 

upgrade or even reinstall new operating systems. The most common operating systems for 

personal computers are:  

Microsoft Windows, Apple Mac OS X, and Linux, Unix etc.

Hardware is tangible 
elements and software 
is intangible elements of 
computer. Hardware 
and Software are 
dependents on each 
other 

Remember 
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i. Microsoft Windows: 

Microsoft created the Windows operating system in 

themid-1980s. Over the years, there have been many 

different versions of Windows, but the most popular 

ones are Windows 7 (released in 2009), Windows Vista 

(2007) and Windows XP (2001). Windows is very 

compatible and user friendly which makes it the most 

popular operating system in the world. If you're buying a new computer or upgrading 

to a new version of Windows, you can choose from several different editions of 

Windows, including Home, Premium, Professional, and Ultimate. 

 

ii. Apple Mac OS X: 

Mac OS is a line of operating systems created by Apple Inc. It is also preinstalled on 

all new Macintosh computers, or Macs. All of the recent versions are known as Mac 

OS X (pronounced Mac O-S Ten), and their specific version names are Lion (released 

in 2011), Snow Leopard (2009) and Leopard (2007). Apple also offers a version 

called Mac OS X Server, which is designed to operate on servers. The Apple operating 

system does have some disadvantages, primarily in regard to software and hardware 

compatibility. 

 

iii. Linux: 

Linux operating system is developed on a kernel, based on Unix. It is known as one of 

the most secure platforms, yet Linux is often viewed as more complex. Linux 

(pronounces LINN-ux) is a family of open source operating systems, which means 

that they can be modified and distributed by anyone around the world. This is very 

different from proprietary software like Windows, which can only be modified by the 

company that owns it (Microsoft). The advantages of Linux are that it is free, and there 

are many different distributions (versions) that can choose from. Each version has a 

different look and feel, and the most popular ones include Ubuntu, Mint, Red Hat and 

Fedora. Linux is named after Linus Torvalds, who created the Linux kernel in 1991. 

 

 

· What is Office Suite. 

The Microsoft Office suite is a set of programs for common productivity tasks, including a word 

processing program, a spreadsheet tool, presentation software, an email program and others. 

Often abbreviated as the MS Office suite, it is among the most popular software packages in 

the world, though it does face competition from other commercial products, including some from 

Apple and Google and from open source packages such as LibreOffice. Parts of the Microsoft 

suite of programs are available both for use in a web browser and local use on a computer. 

 

· MS- Office 

Microsoft office sometimes calls MS-Office is an application software that perform the specific 

task. Microsoft Office is a popular set of software programs from Microsoft that includes a word 

processor, a spreadsheet tool, a database program, an email utility and other productivity 

software commonly used in modern offices. You can either purchase a copy of MS Office to use 

on your computer or sign up for a subscription to Microsoft's cloud-based version of Office.  

 
· Google Docs 

Google Docs is a free Web based application in which documents and spreadsheets can be 

created, edited and stored online. Files can be accessed from any computer with an internet 

Windows is a multi-
tasking operating 
system. 

Remember 
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connection and a full-featured Web browser. Google Docs is a part of a comprehensive 

package of online applications offered by and associated with Google. 

 
· Sheet 

A sheet is another name for a single piece of paper or a hard copy, In software, a sheet is a 

single page in a word processor or single worksheet in a spreadsheet.  

 

 

1.2.1. Precautions to Be Taken Before Installing Windows: 

Before installing any operating system, following precautions must be followed for safety and 

security of important data / software’s. 

 

i. Regularly take backup of your computer system data. 

ii. Check the prefix for Installation of new Operating system. 

iii. Check the compatibility issue before installing windows. 

iv. Create check points/restore points. 

 

· System requirements for Windows 10: 

For installing windows 10 we need 

 

i. 1 gigahertz (GHz) or faster for 32-bit (x86) or 64-bit (x64) processor. 

ii. 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit). 

iii. 16 GB available hard disk space for (32-bit) or 20 GB for (64-bit). 

iv. DirectX 9 graphics device with WDDM 1.0 or higher driver. 

 

· Installation Of Operating System 

Step by Step Windows Installation 

 Boot/Start Computer from Window 10, bootable DVD or 

Bootable USB Flash 

 Press Esc, F10, F2 or Delete key from Keyboard 

depending upon your manufacturer. 

 If prompted, press any key to Boot from CD/DVD……” then press any key 

 The obvious place to start in Win 10 is with the installation process 

 

F2 key is used for 
entering setup of the 
computer system. 

Remember 
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 Click on Install Now 
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 Enter product key or skip  

 

 
 

 

7. Click “I accept the license terms” and Select Custom 
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8. Select the drive where you want to install windows. 
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9. Now system has been restart. 

 

 
 

10. After Restart system shows this window 
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11. Enter user name, password and hint.  

 
 

 

12. After completion of all the steps the windows will prepare your desktop 
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Learning Activities: 

 What is an operating system? 

 Mention the name of the operating system installed in your computer. 

 Visit the Microsoft and Apple websites to learn more about each operating system. 

 If you have a PC and currently use an older version of Windows, such as Windows 10 starter, upgrade to 

win 7 ultimate versions. 
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1.2.2. Install Software Applications 

Application software is a type of software that is used to do specific tasks. 

This learning unit covers different types of application software and 

procedure of installing this software. After completion of this learning unit 

you will be able to describe various types of application software and how 

to install this software. 

 

Different Software Applications 

Application software is the software that is used at offices, home and school. Application software 

consists of programs like Word processing, Spreadsheets, Database, Graphics software, designed 

to perform specific tasks for users. 

 

1.2.3. Installing Microsoft Office 2010 

Step by Step Installation of Microsoft Office 2010 

Installation of Microsoft office 2010 is very easy. If you are running an earlier version of office, such 

as Office 2007 the process will also upgrade you to Office 2010. 

 

 

 Insert the office 2010 DVD or double click on the downloaded setup.exe file, you will see the 

option 

 

 

Extracting files 

 

 Then a window will appear simply pop a tick in the accept license conditions and click continue. 

 

Accepting License Agreement 

An application 
is a program, or 
group of 
programs, that 
is designed for 
the end user. 

Remember 
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 Then it will ask about the product key. 

 

Asking for Product Key 

 Copy the product key from the text file given in the CD and paste it in the given box. Or if it is 

a downloaded setup the product key text file will be available with it. 

 

 

Giving Product Key 

 You now get the option to run the default install or a custom install as seen below. 
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Select Install now 

 

 Now the installation process will be started and it will take several minutes for completion of 

installation. 

 

 

Processing installation 

 

 After this the completion of installation window will appear. 
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Completing installation 

Now the installation is completed and your software is ready to use. 

 

1.2.4. Configuration of Printer 

A printer does not work without driver. If driver is not available then it can be downloaded from 

internet. 

 

Connecting the printer to the computer 

Connect the printer to the computer either using a USB cable, parallel port 

cable, or SCSI cable and then connect the power plug to a power outlet. 

 

Setup printer and install software: 

 After everything has been plugged in turn the computer on. 

 

 Insert the CD that came with 

the printer. If the CD does 

not automatically start, open 

My Computer, double-click 

on the CD drive, and then 

click the Setup or Install file.  

 

 If you have downloaded the 

drivers, run the downloaded 

setup file. 

 

 Follow the installation 

wizard and once completed, 

the software is installed. 

If you do not 
see your printer 
in the printer’s 
list, your printer 
is not installed 

Do you know 
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1.2.5. Installing a Scanner 

Before scanning the documents into the computer with a scanner, it needs to install the scanner 

driver, so that scanner and computer can communicate. Start by connecting the scanner to 

computer’s USB port. Plug and Play, a technology that Windows uses to recognize equipment and 

automatically install and set it up. If a scanner is Plug and Play-enabled, Windows 7 shows a Found 

New Hardware message in the Taskbar notification. Most Plug and Play devices will then 

automatically install, the message will change to verify the installation is complete. But now most 

new peripherals are available with their driver’s installation CD. 

 

 Turn on the scanner. 

 Click the found new hardware message, click Yes, this time only, and then click Next again. 

 Insert the driver’s CD in CD drive and click next. 

 Windows 7,8,10 searches for your scanner driver software automatically and installs it. 

 Click on start button in search bar type Add Device. 

 Click the Add Device button and then click Next. 

 The Scanner and Camera Installation Wizard window appears. When you click Next, the next 

screen of the wizard appears. 

 

installing Scanner 

 Click a Manufacturer in the list on the left and then click a model in the list on the right. 

 (Now it’s just a matter of following the wizard directions based on the model of scanner you 

choose and whether you have a manufacturer’s disc (a CD- or DVD-ROM). If you don’t have a 

disc, Windows can help you download software from the Internet.) 

 Click Finish when the wizard ends 

 Now the installation is complete and scanner is ready to use. 

 

Learning Activity: 

 What are some examples of application software you have on your computer? 

 Install MS Office 2010 using CD/DVD on your computer. 

 Install Printer on your computer 

 Install Scanner on your Computer 

 Install VLC media player on your computer 
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1.2.6. Uninstalling a computer Software 

The proper way to uninstall a program is to use the uninstall routine that is provided with the 

program itself. This will remove the files, Windows Registry information, and other configuration 

from your computer to avoid conflicts in future. This learning unit covers about basic precautions to 

un install a software application, how and where to take backup of necessary data files, also 

demonstrate various features of control panel and the procedure for uninstalling a software from 

the computer. 

 

Software must be un installed through a proper way it cannot be removed by deleting its icon from 

the computer or deleting its folder from windows because a large amount of information regarding 

configuration left in the Windows Registry as well as files that may be installed in locations other 

than the program's folder. These files and Registry data may cause conflicts on your computer thus 

leading to problems. 

 

 

Procedure for Un-Installing A Software 

 Click on start button. 

 Click on control panel. 

 Click on programs and features. 

 Select a program, and then click Uninstall. Some programs include the option to change or 

repair the program in addition to uninstalling it, but many simply offer the option to uninstall. To 

change a program, click Change or Repair. 

 

Uninstalling a software 

 A dialogue box will appear for uninstallation. 
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Completing Uninstalling a software 

 Then another dialogue box will appear for asking do you want to remove History. 

 

· Click on Yes. 

· Then click on OK.  

 

 
 

 

Learning Activity: 

 Uninstall any unwanted software from computer? 

 Change the background of your computer? 

 Check and list the installed hardware in your computer?? 
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1.3. Troubleshoot Applications to trace and fix faults (if any) to bring it in a running 
condition. 

 

Software troubleshooting is the process of scanning, identifying, diagnosing and resolving problems, errors 

and bugs in software. The software troubleshooting process starts with identifying the problem, checking 

on possible issues that can cause such problems and then working on measures and alternatives to find a 

solution.  

This learning unit covers that what is software troubleshooting, describe the general software errors like 

computer bug, track or path corruption also will demonstrate the precautions about software 

troubleshooting. After completion of this learning unit, you will be able to describe what is software 

troubleshooting also will be able to troubleshoot errors in software. 

 

 

1.3.1. Troubleshooting common Errors in windows: 

Troubleshooting using Control Panel contains several troubleshooting programs that can 

automatically fix some common problems with computer, such as problems with networking, 

hardware and devices, using the web, and program compatibility. 

Although troubleshooters aren't designed to fix every problem, they are useful to often save your 

time and efforts. 

 

 Open troubleshooting by clicking the Start button then clicking Control Panel, and then, 

under System and Security, click Find and fix problems 

 
 

Simple solutions to common Computer Errors: 

Problem: An application is running slowly: 

 

Solution 1: Close and reopen the application. 

Solution 2: Update the application. To do this, click the Help menu and look for an option to check 

for Updates. If don’t find this option, another idea is to run an online search for application updates. 

 

Problem: An application is hang: 
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Sometimes an application may become frozen. When this happens, you won't be able to close the 

window or click any buttons within the application. 

 
Solution 1: Force quit the application. On a computer, Press (and hold) Ctrl+Alt+Delete on 

keyboard to open the Task Manager. 

Select the unresponsive application and click End task 

 

 

 
 

 

Learning Activity: 

 Write the steps you will take if a program on a computer is completely unresponsive. 

 Write your last initiative to resolve the issue if you've tried everything and the problem still isn't fixed. 

 Write the difference between System testing and structural testing? 

 Set windows Help to troubleshoot the software errors and write the steps you have followed in 

troubleshooting? 
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1.4. Health, Safety and Security procedures to ensure safe working environment. 

 

Safety, health and security in the workplace is important to workers and to the general morale of the 

employees of a company. Much of this is common sense, but there are government agencies and 

regulations that govern this aspect of running a business in order to ensure the health and safety of the 

workforce. 

 

1.4.1. Working in Computer Labs. 

When Computer Lab is set up, many things are considered for its setup so that the computer user 

may work easily and effectively and the computers may also work in recommended situation. The 

things which are considered in the setup of computer lab are as under.   

  

· The Number of Computers   

First of all, it is necessary to know how many computers will be installed in the computer lab 

and what will be their accessories? So that, we have may prepare computer tables accordingly. 

 

· Sitting Arrangement 

A Computer table must have such a space so that the computers as well as its accessories 

may be placed easily. The design of the computer table would be such as the system unit may 

be placed in the airy space it can be opened and closed very easily and it should be of 

appropriate size. The chair should be revolving so that the user may move easily. Furniture of 

the lab should be short so that atmosphere of that should look spacious and airy. 

 

 
 

 

 

TVET SSP does not secure copyright of these pictures
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· Lab Temperature  

It is very important for the setup of computer lab, so that the user and computer may work more 

effectively and efficiently. According to our atmospheres, the temperature should be 25C to 

30C. 

 

· Power Management 

 A Computer consumes energy according to its type. We must install and check on daily bases 

these devices for safety. 

 

i. Uninterruptable Power Supply (UPS) 

ii. Wiring 

iii. Electric Safety 

iv. Short Circuit Breaker 

v. Power Plug 

vi. Earth Ground 
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Learning Unit 2:  

Create a Document using MS Word  

 

 

Objective: 

In this learning unit you will learn how to open and save file with desired 

name and location in MS Word and how you can type in the document. 

After completion of this learning unit you will be able to type speedily 

and error free in MS Word. 
 

After completion of this Learning Unit you will be able to: 

 

v Compose a document as per the requirements. 

v Assign name and location to save a file in word file format.  

v Format word document according to given requirements. 

v Generate hard copy according to job requirements. 
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2. MS-word

 

MS Word 2010 Microsoft Word is part of the Microsoft Office. Its main function is for 

producing documents that includes text, graphics, table, clip art, etc. The most familiar 

application among the members of the Office is MSWord.  

 

Features of Standard Word Processor 

· File Management:  

Many word processors contain file management capabilities that 

allow you to create, delete, move, and search for files. 

 

· Font specifications:  

Allows you to change fonts within a document. For example, you can specify bold, italics, and 

underlining. Most word processors also let you change the font size and even the typeface 

 

 

 

By Default, MS 
Word Document 
open with the name 
“Document1”. 

Do you know! 
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2.1.   Compose Documents as per the requirements. 

2.1.1. Formatting and modify documents. 

· Page Layout  

To setup a page in MS Word a Page Layout tab is available in the 

Tabs. In page Layout tab a group is available for the page setup as 

shown in picture below: 

 

 
In Page Set-up group the following options can be set: 

· Margin:  

A Margin is the space between the text and the edge of your document. 

 

 
 

 

· Orientation: 

Paper on which text is printed could have two 

orientations – portrait and landscape. In 

portrait orientation, height of the paper is larger 

than its width whereas in landscape 

orientation, the width is larger than the height 

 
 

In MS Word 

default paper size 

is US Letter 

(8.5”x11”) or A4 

(8.27”x11.69”) 

Do You Know? 
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· Size: 

Books and magazines are printed in a variety of sizes. Different sizes of paper are required to 

set the requirement of printing. Microsoft Word allows you to choose a variety of paper sizes 

for your documents. MS Word offers a large menu of standard paper sizes to choose from and 

also allows setting of a custom paper size of your own. 

 

 
 

· Columns 

Columns are used in many types of documents, but most commonly used in newspapers, 

magazines, academic journals, and newsletters. Columns can improve document's 

organization and increase its readability. They also allow you to utilize all of the available space 

on the page. 
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· Hyphenation: 

In word processing, hyphenation refers to splitting a word that would 

otherwise extend beyond the right margin. 

 

· Inserting Table: 

A table is a grid of cells arranged in rows and columns. Tables can 

be customized and are useful for various tasks such as presenting 

text information and numerical data.  

 

Inserting a blank table: 

The procedure to insert a blank table in MS Word has following steps: 

 

i. Place your insertion point in the document where you want the table to appear. 

ii. Select the insert tab. 

iii. Click the table command. 

 

 

· Procedure of Inserting Header and footer: 

To set up a header and footer for your document, click on the insert tab at the top of Word. 

Now locate the Header & Footer panel: 

 

 
 

Hyphens that you 

add explicitly by 

entering the dash 

character are 

called hard 

hyphens. 

Remember: 
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Click on the Header item and you'll see a drop down list appear: 

 

 
 

 

· Page Numbering 

We can attach page number in every page or in footer. 

 

 
 
 

1) From the Design tab, click the Date & Time command.  
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2) Select a date format in the dialog box that appears. 

 

 

·  Alignment 

In Word, there are several options for adjusting the font of text, including size, color, and 

inserting special symbols. You can also adjust the alignment of the text to change how it is 

displayed on the page. The text formatting toolbar is given below with the options related to 

text formatting. 

 

Basic Four allignments 

i. Left: Aligns all selected text to the left margin 

ii. Center: Aligns text an equal distance from the left and right margins 

iii. Right: Aligns all selected text to the right margin 

iv. Justify: Aligns text equally on both sides and lines up equally to the right and left 

 

 

The selected Table 
is converted into 
Text. Each row gets 
converted into a 
paragraph. The text 
in each cell of the 
row gets separated 
by tabs. 
 

Do you know! 
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· Change the background color 

 

i. Click Design > Page Color. 

ii. Click the color you want under Theme Colors or Standard Colors 

 

 
 

· Themes/Style 

Styles and themes are powerful tools in Word that can help you easily create professional-

looking documents. A style is a predefined combination of font style, color, and size of text that 

can be applied to selected text. A theme is a set of formatting choices that can be applied to 

an entire document and includes theme colors, fonts, and effects. 
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· Page / Paragraph borders 

Microsoft Word gives you hundreds of page border options that allows you to surround a page 

with a clean or fancy border. Follow the steps below to insert a border in your Microsoft Word 

document 

 

i. Open Microsoft Word. 

ii. Click on the Page Layout tab. In Word 2013 and 2016 click on the Design tab instead. 

iii. In the Page Background group, click the Page border option. 

iv. In the Borders and Shading window (shown below), click the Page Border tab. 

v. Select Box if you want a square border around your page. 

vi. Select the Style of border you want on the page, which can be solid, dotted, or dashed. 

Select the Color and Width of the border. If you want to select artwork to use as the 

border, click the down arrow for the Art drop-down list. In the example below, we're 

using the hearts art as a border 

 

 

 

· References 

To insert a bibliography using the Bibliography tool, you must first enter references and 

sources, which can be done simultaneously. 
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i. Step 1: 

Open your document in Microsoft Word 2010 and click on the References tab. 

 

 

ii. Step 2: 

Place your cursor where you would like the citation inserted. Select your style of 

references in the Style menu, shown in the screenshot below 

 

 
 
 

iii. Step 3: 

In the screenshot below, APA Fifth Edition is shown in the Style menu. Click on 

the Insert Citation button to produce the drop-down menu shown below, and 

select Add New Source. 
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iv. Step 4: 

A Create Source window will appear. Choose the source type from the drop-down 

menu. 

  

 

 

v. Step 5: 

Enter the source information in the fields provided and click OK. 

  
 

 

 

vi. Step 6: 

In the screenshot below, note that a reference has been entered. Follow Steps 2–5 to 

insert your remaining references. 
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vii. Step 7: 

Once you have entered all references and sources, place your cursor at the end of 

your document. The bibliography will be inserted wherever you place the cursor. 

  
Click on the Bibliography button, shown below, and select 

either Bibliography or Works Cited. 

  
 

 
 
 
 

viii. step 8: 

To update the bibliography after entering new sources, click anywhere on the 

bibliography table. Click on Update Citations and Bibliography. 
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· Review option 

There are different group in Review group, proofing (in proofing check spelling & grammar 

checking), Comments (add comments), Changing (changing the words), and protect 

documents.  

 

 

 

· Editing tools (Cut/copy/paste, Undo/redo, Delete/insert 

Edit menu cannot be find in the Ribbon in MS 2010, because all the toolbars and menus are 

redesigned and relocated in it.  For example, the Select function stays in the Editing group 

of Home tab; the Paste function stays in the Clipboard group of Home tab 
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Cut: Removes the selection from the active document and places it on the 

clipboard. Short Key of Cut command is CTRL+X. 

Copy:  Copies the selected text to the clip board 

Paste:  Paste the contents of the clipboard at the insertion point (cursor) or 

whatever is selected. 

Clear: Deletes the selected object or text, but does not place it on the 

clipboard. 

Select All:  Selects all text and graphics in the active window. 

Find:  Searches for specified text in the active document. 

Replace: Searches for and replaces specified text and formatting. 

 
· Copying and Pasting Text 

The procedure to Copy and paste the text has following steps: 

 

i. Select the text you want to copy. 

ii. Click the Copy command on the Home tab. You can also right-click your 

document and select Copy  

iii. Place your insertion point where you want the text to appear. 

 

 

 
 
 

· Cutting and Pasting Text 

i. Select the text you want to copy. 

ii. Click the Cut command on the Home tab. You can also right-click the document and 

select Cut. 
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· Undo 

Repeat the last action it can found quick access toolbar. The Undo command is activated by 

pressing the Ctrl+Z  

 

· Redo 

To do last one step Ctrl+Y 

 

 
 

· One drive location 

Save As function allows you to choose a name and location for your document. It's useful if 

you've first created a document or if you want to save with different name while keeping the 

original document. 

 

The procedure to save a word file through Save As function has the following steps: 

 

i. Open the word File 

ii. Click the File tab. 

iii. Select Save As. 

iv. The Save As dialog box will appear. Select the location 

where you want to save the document 
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· Print Document:  

i. Select document for print (Type Ctrl+P) 

ii. Select/Chose Printer  

iii. Select Page Orientation 

iv. Select Page size 
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Practice-1 

Create Business Cards using Shapes, text, colors and take a print.  

i. Go to inset tab and select the shape group. 

ii. Select rectangular shape 

iii. Choose color according to their choice. 

iv. Type text and contents information. 

 

 

 

 

 

 

 

Practice-2 

Create Resume with the following requirement 

 

i. Name of Candidate must be in center with “Capitalize each word” case. 

ii. First heading size = 16 pt. 

iii. 2nd Heading size= 14 pt. 

iv. Insert Picture to left top corner   

v. Font family = Calibri. 

vi. Apply water mark 

vii. Take a print of the Resume. 
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FIRST NAME LAST NAME 
Address · Phone 

Email · LinkedIn Profile · Twitter/Blog/Portfolio 

To replace this text with your own, just click it and start typing. Briefly state your career objective, or 

summarize what makes you stand out. Use language from the job description as keywords. 

EXPERIENCE 

DATES FROM – TO 

JOB TITLE, COMPANY 

Describe your responsibilities and achievements in terms of impact and results. Use examples, 

but keep it short. 

DATES FROM – TO 

JOB TITLE, COMPANY 

Describe your responsibilities and achievements in terms of impact and results. Use examples, 

but keep it short. 

EDUCATION 

MONTH YEAR 

DEGREE TITLE, SCHOOL 

It’s okay to brag about your GPA, awards, and honors. Feel free to summarize your coursework 

too. 

MONTH YEAR 

DEGREE TITLE, SCHOOL 

It’s okay to brag about your GPA, awards, and honors. Feel free to summarize your coursework 

too. 

SKILLS 

· List your strengths relevant for the role you’re 

applying for 

· List one of your strengths 

· List one of your strengths 

· List one of your strengths 

· List one of your strengths 

ACTIVITIES 

Use this section to highlight your relevant passions, activities, and how you like to give back. It’s good to 

include Leadership and volunteer experiences here. Or show off important extras like publications, 

certifications, languages and more. 
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Practice-3 

Practice hyperlink and create links between word document texts 

. 

i. Select the text or picture to use as a link, and then click Insert > Hyperlink. 

 

 

 
 

ii. Click OK. 

 

 

iii. After applying hyperlink show above image result 

iv. To go any hyperlink attachment (CTRL+ Left click) 
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Practice-4 

Take a double column newspaper and create similar paragraph style in the word document. 

 

i. Select the document 

ii. Go to layout tab and select number of columns. 

 

 

 

 

Practice-5 

Download the Educational template in Microsoft Word from Internet and edit those templates with your content. 

 

How to access Microsoft Word’s stock templates 

Fortunately for us, Microsoft provides many hundreds of templates for all of its programs. Note that most of 

Microsoft’s templates are online, which means you cannot access them unless you’re connected to the internet. 

To open one of the system-provided templates in Word: 

 

i. Open Microsoft Word and select New. 

ii. Persue the Suggested Search categories: Business, Personal, Industry, Design Sets, Events, Education, 

or Letters. For this exercise, select Business. 

iii. Word displays a message that says, “Searching thousands of online templates.” 

iv. Word displays template search results on-screen, plus a comprehensive list of categories in a scrolling 

panel on the right. 

v. Scroll down the page or choose a different category, then select a template that fits your current project. 
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Learning Unit 3:  

Preparer a Worksheet using MS Excel 

 

Objective: 

This learning unit covers the procedure for creating workbook and 

spreadsheet, the basic concept of spreadsheets, types of spreadsheets 

in Excel and procedure for creating workbook in Excel. After completion 

of this learning unit you will be able to explain the types and uses of 

worksheets and the procedure of creating a worksheet. 

 
 
After completion of this Learning Unit you will be able to: 

v Develop a worksheet as per given data.  

v Format the worksheet according to given job requirement. 

v Apply formula according to given criteria. 

v Generate Charts / Graphs according to the given data and security 

procedures to ensure safe working environment. 
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3. MS-Excel

 

Microsoft Excel 2010 is an excellent program for organizing, formatting, and 

calculating numeric data. Excel displays data in a row-and-column format, with 

gridlines between the rows and columns, similar to accounting ledger books or graph 

paper. MS Excel 2010 includes the Microsoft Office Fluent interface, which consists 

of a customizable visual system of tools and commands.  

 

3.1.  Develop Worksheet 

Worksheets Microsoft Excel consists of worksheets. Each worksheet contains columns and rows. The columns 

are lettered A to Z and then continuing with AA, AB, AC and so on to XFD (16384); the rows are numbered 1 to 

1,048,576 

 

· THE INTERFACE: 

Cell:  The intersection of a column and a row. Information is stored in cells.  

Cell Reference: Address, consisting of a column and a row IDs of a specific cell. 

Column: A vertical group of cells. Total no of columns is 16,384. 

Formula: A self-made method of calculation is called formula. 

Function: A pre-defined method of calculation is called function. 

Range: A group of cells. 

Row: A horizontal group of cells 

Value: A number that can be used in an Excel calculation. 

Workbook: A collection of worksheets contained within a single file 

 

Main parts of Spreadsheet Work Area 

 

 

Every workbook in 
MS Excel contains 
3 worksheets by 
default. 

Remember 
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3.1.1. Format Cells to Prepare the Worksheet. 
 

· Merge and Unmerge 

This document explains how to merge cells within all versions of Microsoft Excel. Merging cells 

is often used when a title is to be centered over a particular section of a spreadsheet. When a 

group of cells is merged, only the text in the upper-leftmost box is preserved. 

 

 
 

 

· Numbering and Bullets 

Numbering and bullets are used to highlight any point in a manner.  There are many types of 

bullets and numbering. 
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· Tables: 

A table in Excel is a block of cells containing related data that have been formatted as a table. 

Table can be inserted from insert tab. 

 

 
 

 

3.1.2. Applying formulas to create functional worksheet. 
 

 

· Creating Formulas 

There are different methods used for creating or inserting formulas in Excel. It can insert 

through predefined formulas, using cell references or it can create through using point and click 

method. 

 

Excel uses different standard operators for equations, such as  

i. A plus sign for addition ( + ) 

ii. Minus sign for subtraction ( - ) 

iii. Asterisk for multiplication ( * ) 

iv. Forward slash for division ( / ) 

v. Caret for exponents ( ^ ) 
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3.2. Create Charts / Graphs

 

3.2.1. Defining charts/Graphs. 

A chart is a tool that is used in Excel to present data graphically. A chart, also called a graph, is a graphical 

representation of data, in which the data is represented by symbols, such as bars in a bar chart, lines in a 

line chart, or slices in a pie chart.  A chart can represent numeric data, functions or some kinds of qualitative 

structure and provides different information. There are many types of chart / graphs used in Excel. 

 

Chart is a visual representation of data. By using elements such as columns, or lines, a chart displays series 

of numeric data in a graphical format. 

· Excel Chat Type 

MS Excel has different types of charts as shown in the picture below. 

 

 
 

3.2.2. Creating a Chart in Excel 

Select the cells that are wanted to chart, including the column titles and row 

labels. These cells will be the source data for the chart. 

 

 

Charts are (called 

graphs in math 

class) visual 

representations of 

worksheet data. 
 

Do You Know 
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1) Click the Insert tab 

2) In the Charts group, select the desired chart. 

 
 
 

3) Select the desired chart type from the drop-down menu (Clustered Column, for example) 
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4) The chart will appear in the worksheet. 

 
 

 

3.2.3. Using different charts in Excel. 

The steps for creating a basic column chart in Excel are: 

 

· Select the data which wanted to be in the chart. Insert row and column headings but not the 

title for the data table. 

· Click on the Insert tab of the Ribbon. 

· In the Charts box of the ribbon, click on the Insert Column Chart icon to open the drop-down 

list of available chart types. 

· Hover mouse pointer over a chart type to read a description of the chart. 

· Click on the desired chart. 

 

A plain, unformatted chart that displays only the columns, representing the selected series, a 

default chart title, a legend, and axes values, will be added to the current worksheet. 
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Practice-1 

Create marks sheet in excel worksheet with the following criteria 

· Minimum 5 subjects to enter 

· Each subject carry 100 marks 

· Find  

vi. Obtain marks 

i. Percentage 

ii. Average 

iii. Auto Grade calculation with the following conditions 

§ If marks >= 90% then grade = “A+” 

§ If marks>= 80% then grade= “A” 

§ If marks>= 70% then grade= “B+” 

§ If marks>= 60% then grade= “B” 

§ If marks>= 50% then grade= “C” 

§ If marks< 50% then grade= “F” 

§ Auto Status calculation with the following conditions 

 

· Status “Fail” if grade= ”F” 

· Also “Fail” if subject marks below then 40% 

· Else “Pass” 

 

 

Solution 

 

 

 

Obtain Marks formula = Sum (C1:E1) 

% Age Formula = G1/300*100 

Grade Formula = =IF(H1>=90,"A+”, IF(H1>=80,"A”, IF(H1>=70,"B+”, IF(H1>=60,"B”, IF(H1>50,"C", 

IF(H1>=60,"F")))))  

Remarks (pass or fail) 

=IF(G1>50,” PASS”,” FAIL”) 
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INSTRUCTIONS           

1. Create the worksheet given below 

2. Calculate marks obtained 

3. Calculate %age of each student while total marks = 550 

4. Calculate Pass\Fail of each student by using If statement (Fromula) 

5.  Calculate Division of each students by using formula of If while: 

      Division  1st > =  60  2nd > =  50  3rd  > = 33  & Fail < 33 

6. Calculate grade of each students by using formula of If while: 

      Grade A+ > = 80  A > = 70  B > = 60 C > = 50  D > = 40  E > = 33  & Fail  <  33 

7. Insert your remarks on grades of each student that as follows 

      Grade A + =  Mind Blowing  A = Execllent  B  = Fantastic  C  = Very Good  D  = Good  E  = Satisfactory  & 

Fail  <  33 

8. Draw a line graph of column student vs. English. 

RESULT SHEET OF CENTRAL MODEL COLLEGE BAHAWAL NAGAR 
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A B A B 

10

0 

10

0 
100 

10

0 
100 50 550 

10

0 

1 
Temoor 

85 88 85 90 91 46 485 88 Pass 1st A+ 

Mind 

Blowing 

2 Nazir 66 70 72 75 78 42 403 73 Pass 1st A Execllent 

3 Omer 45 46 44 48 62 26 271 49 Pass 3rd D Good 

4 Majid 75 78 73 74 72 36 408 74 Pass 1st A Execllent 

5 
Hafeez 

62 56 60 58 60 32 328 60 Pass 

2n

d C 
Very Good 

6 

Maqbo

ol 35 36 25 28 36 28 188 34 Pass 3rd E 

Satisfactor

y 

7 Salman 70 68 67 68 69 36 378 69 Pass 1st B Fantastic 

8 
Younis 

55 54 52 48 59 37 305 55 Pass 

2n

d C 
Very Good 

9 
Nawaz 

90 95 96 95 94 50 520 95 Pass 1st A+ 

Mind 

Blowing 

10 
Zaheer 

78 86 85 78 82 46 455 83 Pass 1st A+ 

Mind 

Blowing 
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  (Marks Obtained)  =SUM(C19:H19)        

  (% age)    =I19*100/550         

  (Pass or Fail)   =IF(J19>=33,"Pass","Fail")       

  (Division)   =IF(J19>=60,"1st",IF(J19>=50,"2nd",IF(J19>=33,"3rd","Fail")))    

  (Grade)

 =IF(J19>=80,"A+",IF(J19>=70,"A",IF(J19>=60,"B",IF(J19>=50,"C",IF(J19>=40,"D",IF(J19>=33,"E","Fail")))))) 

 (Remarks) =IF(M19="A+","Mind Blowing",IF(M19="A","Execllent",IF(M19="B","Fantastic", 

IF(M19="C","Very Good",IF(M19="D","Good",IF(M19="E","Satisfactory","Fail")))))) 
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Practical Exercise-5 

Topic: Prepare the following sheet:   Date:   08/03/2010 

INSTRUCTIONS       

1- Calculate the worksheet given below. 

2.  Calculate Maximum Score as Row Wise. 

3.  Calculate Minimum Score as Column Wise. 

4.  Calculate Minimum Score as Row Wise. 

5.  Calculate Maximum Score as Column Wise. 

6.  Calculate Minimum Score as Overall the Table. 

7.  Calculate Maximum Score as Overall the Table. 

8.  Draw a Pie and line Graph from column Batsman Name to Year 2000. 

INTERNATIOLNAL CRICKET PERFORMANCE   

            

St. # 
Batsman 

Name 

Year 

199

5 

Year 

199

6 

Year 

199

7 

Year 

199

8 

Year 

1999 

Year 

2000 

Minimu

m 

Score 

Maximu

m 

Score 

1 Inzimam 456 986 875 795 1285 968 456 1285 

2 Saeed Anwar 789 867 856 756 784 755 755 867 

3 Ijaz Ahmad 568 598 489 845 457 845 457 845 

4 Muh. Yousif 865 485 785 745 654 684 485 865 

5 Ganguly 789 864 785 458 698 792 458 864 

6 Rahul Dravid 598 854 489 456 675 985 456 985 

7 Jay Soria 756 565 785 746 458 965 458 965 

8 Mark Waugh 795 856 765 699 587 459 459 856 

9 Ricky Ponting 784 489 764 678 685 456 456 784 

10 Alec Stewart 756 597 486 684 675 255 255 756 

Minimum Score 456 485 486 456 457 255 
BEST SCORE 

Maximum Score 865 986 875 845 1285 985 

   Overall Minimum Score 255    

   Overall Maximum Score 1285    
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(Maximum Score as Row Wise)  =MAX (C15:H15) 

(Maximum Score as Column Wise)  =MAX (C15:C24) 

(Minimum Score as Row Wise)  =MIN (C15:H15) 

(Minimum Score as Colum Wise)  =MIN (C15:C24) 

(Overall Minimum Score)   =MIN (I15:I24, C25:H25) 

(Overall Maximum Score)   =MAX (J15:J24, C26:H26) 
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Learning Unit 4:  

Prepare a presentation using MS PowerPoint 

 

Objective: 
 

PowerPoint is a Microsoft’s presentation software that enables users to create engaging 

presentations consisting of individual pages, or slides, which may contain text, graphics, sound, 

movies, hyperlinks, and other objects. PowerPoint enables users to add animation and effects 

to slideshow elements. Presentations can be printed, displayed, notated, and navigated by the 

presenter.  

 

 

 

After completion of this Learning Unit you will be able to: 

 

v Insert slides with different layouts according to the requirements of presentation 

v Insert text, tables, images, etc. according to the requirements. 

v Apply a set of effects to animate the slide according to the requirements. 

v Apply slide transitions on slides according to the requirement. 

v Apply sound effects on objects/text/images according to job requirements. 
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4. Power Point 2010

Getting started with PowerPoint 2010 you will notice that there are many similar 

features to previous versions.  You will also notice that there are many new features 

that you’ll be able to utilize.  There are three features that you should remember as you 

work within PowerPoint 2010:  the Microsoft Office Button, the Quick Access Toolbar, 

and the Ribbon.   

 

   Layout and interface of PowerPoint 

4.1.1.   Presentations  

A presentation is a collection of data and information that is to be delivered to a specific audience.  

A PowerPoint presentation is a collection of electronic slides that can have text, pictures, graphics, 

tables, sound and video.  This collection can run automatically or can be controlled by a presenter.   

 

 

4.1.2.   Mini Toolbar  

A new feature in Office 2010 is the Mini Toolbar.  This is a floating toolbar that is displayed when 

you select text or right-click text.  It displays common formatting tools, such as Bold, Italics, Fonts, 

Font Size and Font Color. 
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4.1.3.   Layout of Power point 

 

 

 

 

   Define Slide and different layout of Power Point 

 

Slide Views Presentations can be viewed in a variety of manners.  On the View 

tab, the Presentation Views group allows you to view the slides as Normal, Slide 

Sorter, Notes Page, Slide Show, Slide Master, Handout Master, and Notes 

Master.   

4.2.1. Slide Master 

A slide master is the top slide that stores information about the theme and slide layouts of a 

presentation. It includes the background, color, fonts, effects, and positioning. By using Slide 

Master, affects can be added in every slide. Individual slide layouts can also be modified using this 

feature 

 

 

Every presentation 
contains at least 
one slide master 

Remember 
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4.2.2. Handout Master  

Handout master view in PowerPoint 2010. Handout master customize your presentation and will 

look as a printing handout. You can choose the design and layout of the handout, such as 

background formatting and where header/footer will appear. You can also select option your page 

setup. 
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4.2.3 Notes Master 

A presentation may have a notes master part (zero or one). The notes master determines the 

background elements and default layout of a notes page 

 

 

 

   Insert Slides with different layout. 

 

One or more slides can be added in a presentation easily. 

Following are the steps. 

 

i. Open MS Power point. 

ii. Under the Home tab. 

iii. Click on New Slides 

iv. Select the desired layout of a slides. 

v. The slide will be inserted. 

 

 

 

Duplicate slide can 
be added by copy 
and paste the 
existing slide again. 
 

Remember 
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Insert Table picture, Picture, Text Box, Shape and Action Button.

 

4.4.1.    Insert Table: 

Add table in your slide 

Following are the steps. 

 

i. Open MS Power point. 

ii. Under the Insert tab. 

iii. Click on tables 

iv. Select the desired rows and columns 

v. The table will be inserted. 

 

 
 

4.4.2.   Insert Picture 

Add picture in you slide 

Following are the steps. 

 

i. Open MS Power point. 

ii. Under the Home tab. 

iii. Click on picture 
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iv. Select the desired image file, then click inset. 

 

 

v. The picture will appear in your slide 
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i. Open MS Power point. 

ii. Under the Insert tab. 

iii. Click on text box 

iv. Select the desired rows and columns 

v. The table will be inserted on insert tab 

vi. Select  

 

 

 

4.4.4.   Inset Shape 

i. Open MS Power point. 

ii. Under the Insert tab. 

iii. Click on shapes 

iv. Select the desired shape and insert shape  

v. The shape will be inserted  

 

 

4.4.3.   Insert Textbox 
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4.4.5.   Action Button 

Action buttons are built-in shapes you can add to a presentation and set to link to another slide, 

play a sound, or perform a similar action. When someone clicks or hovers over the button, the 

selected action will occur. Action buttons can do many of the same things as hyperlinks. 

 

 
 

4.4.6.   Insert Design and Backgrounds 

i. Open MS Power point. 

ii. Under the design tab. 
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iii. Click the theme and choose appropriate theme from the available list or add new theme 

from the saved file. 

iv. For creation of new theme select customize background option and choose on choice 

background form the list. 

v. Click the variant option. 

vi. Click Font and select appropriate font 

vii. Click Color and select suitable color scheme 

viii. Click Background styles and select desired background 

ix. Click Effect and select appropriate effect 

x. Click size of the Slide, it shows two options, choose one option 

 

 

xi. Newly created slide deign is shown in the task pane 
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  Insert header/footer, date and numbering to slides 

 

i. Open MS Power point. 

ii. Under the Insert tab. 

iii. Go text group 

iv. Click on header and footer  

v. Select header and footer  

vi. In header and footer also mention time and date 
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Apply a set of effects to animate the slide

 

4.6.1.   Animation 

Animations are visual effects applied to individual items on the slide 

such as graphics, titles or bullet points. Animation can help to make a 

PowerPoint presentation more dynamic, visually interesting, 

automation and to grab the audience's attention. The most common 

types of animation effects include entrances, exits, emphasis and 

motion paths. 

 

 

Types of Animations 

· Entrance effects:  Make an object fade gradually into focus, fly 

onto the slide from an edge, or bounce into view. 

· Exit effects: Making an object fly off from the slide, disappear 

from view, or spiral off of the slide. 

· Emphasis effects: Making an object shrink or grow in size, 

change colour, or spin on its centre. 

· Motion Paths: Make an object move up or down, left or right, or 

in a star or circular pattern (among other effects). 

Applying an Animation to slides 

i. Select the text or object to apply animation 

ii. Click the animations tab from main menu 

iii. Click an animation effect from the animation group gallery. 

iv. Click the more arrow to see more options 

v. Animation applied to the object. 

vi. Click Effect options and select the effect to, how animation have effects. 

 

 To specify the timing of the effects, on the Animations tab, use the commands in the Timing group 

 

 

Animation can be 

useful in making a 

presentation more 

dynamic, and help 

to emphasize points, 

Definition 

 

Too much 

animation can be 

distracting.  

Remember 
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Perform custom Animation on one slide 

Custom animation allows you to consider the objects or the text boxes in a slide, one at a time, and 

to animate them as desired by the person not as given in the software.  

 

i. Select the slide to which the animation is to be applied. 

ii. Select the animations tab and the animation group. 

 

 

 
 

iii. Click on custom animation.                 

iv. Click add Effect. 

 

 A menu appears with a list of effect categories.  

i. Entrance effects control how the element enters the slide.  

ii. Emphasis effects make the element do something after it enters the slide.  

iii. Exit effects control how it leaves the slide.  

iv. Motion paths allow you to specify where the element travels on the slide. 

 

 
 

v. Select one of the effects. Details about the effect appear in the Animation Pane. 

vi. In the Start field, use the drop-down menu to select an event which will trigger the 

animation. 

vii. In the Direction field, use the drop-down menu to select a direction for the animation. 

The significance of the direction depends on animation type. 

viii. In the Speed field, use the drop-down menu to select a speed for the animation. 
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  Apply Sound Effects 

 

Power Point supports multimedia in the slides. You can add audio or video clips to the slides which can be played 

during the presentation. 

 

The following steps will help you add audio or video file to the slides. 

 

· Step - 1 

 Go to the Media group under the Insert ribbon 

 

· Step 2  

To insert video file, select Video as media type and Video from File to insert a video from your 

computer or hard drive. 
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· Step 3  

 In the Insert Video dialog, browse for a video file and click Insert. 
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· Step 4  

You will now see that a Video file is added to the slide. 
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· Step-5  

To insert audio file, select Audio as media type and Audio from File to insert an Audio from 

your computer or hard drive. 

 

 

· Step-6  

In the Insert Audio dialog, browse for an audio file and click Insert. 
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Practice-1 

Create 10 slides presentation about your Institute with the following instructions 

 

1) Create a slide design template 

2) Apply any option from following Animations 

· Entrance effects 

· Emphasis effects 

 

3) Apply Sound Effects to each slide 

4) Set transaction timing up to 3 seconds 

5) Set animation timing up to 5 seconds 

6) Set animation on auto. 

7) Each slide has different design 

8) Apply motion path on object in at least one slide. 

 

· Solution: 

See the above topic 1.7 (Animation) and follow instructions for said solutions. 
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This module is designed to provide skills and knowledge related to basic computer hardware, software, 

applications and troubleshooting. You will be able to demonstrate your skills in operating a computer system and 

computer applications such as MS Word, MS PowerPoint, MS Excel as well as installation and troubleshooting of 

operating system and software. 

Trainees will learn to configure Computer System. They get skill to connect computer components and peripherals 

as per requirements. Install system software and application software according to the Instructional Manual. 

Troubleshoot applications to trace and fix faults (if any) to bring it in a running condition. Follow health, safety and 

security procedures to ensure safe working environment. 

Trainee will get skill to create a document using MS Word. They will compose a document as per the requirements. 

Assign name and location to save a file in word file format. Format word document according to given 

requirements. Generate hard copy according to job requirements. 

Trainee will get skill to prepare worksheets and workbooks using MS Excel. They will develop a worksheet as per 

given data. Format the worksheet according to given job requirement. Apply formula according to given criteria. 

Generate Charts / Graphs according to the given data and security procedures to ensure safe working 

environment. 

Trainee will get skill to prepare a presentation comprising of slides using MS PowerPoint. This will enable users 

to create engaging presentations consisting of individual pages, or slides in different layouts. They will insert text, 

tables, which may contain text, graphics, sound, movies, hyperlinks, and other objects. This software also enables 

user to add animation and effects to slideshow elements. Presentations can be printed, displayed, notated, and 

navigated by the presenter. They can apply slide transitions on slides according to the requirement. Apply sound 

effects on objects/text/images according to job requirements. 

 
 
 
 
 
  

Summary of Module 
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Question and Answers: 

 

FAQ - 1 What are the common types of Operating system?? 

Answer : Most common types of operating system are Windows, Linux ,Unix, Mac OS, Solaris,  etc. 

 

FAQ - 2 What are the Peripheral devices? 

Answer : A computer peripheral device is an external device that provides input and output for the computer 

like keyboard, mouse, LCD, monitor, Printer, scanner web cam etc. 

 

FAQ - 3 What is application software? 

Answer : Application software is the software is used at offices, home and school etc., like word processing, 

spreadsheets, Database, Graphics software, designed to perform specific tasks for users. 

 

FAQ - 4 What is a software update means? 

Answer : A software update means to enhance the capability, stability and features of an existing version of 

the software. Updates usually download free of cost while upgrading means replace an older 

version of the same product with the newer version. 

 

FAQ - 5 What is the right way to uninstall a program? 

Answer : The proper way to uninstall a program is to use the uninstall routine that is provided with the 

program itself, or from using control panel. 

 

FAQ - 6 What does scanning means?? 

Answer : Scanning a computer means detect and remove viruses and malwares from the computer. 

 

FAQ - 7 What are computer viruses or bugs?? 

Answer : Computer viruses are small software programs that are designed to spread from one computer to 

another and to interfere with computer functioning. 

FAQ - 8 What is external mass storage?? 

Answer : External mass storage is the device that is attached to the computer with a network/ cable and can 

be removed without opening computer case, like hard disk, USB flash drive, CD, floppy disk etc. 

 

FAQ - 9 What is software troubleshooting process? 

Answer : The software troubleshooting process starts with identifying the problem, checking on possible 

issues that can cause such problems and then working on measures and alternatives to find a 

solution. 

 

FAQ - 10 What is internet and what are its basic parts for connectivity? 

Answer : Internet is used to send and receive email, browse the Web, watch movies, and more. Before 

accessing the Internet, there are things needed, an Internet service, internet connectivity device, 

and a web browser. 
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FAQ - 11 When you create something in MS Word what is it called? 

Answer : A document. 

 

FAQ - 12 How do you create a document in Microsoft Word from scratch? 

Answer : In the upper-left corner of the Word program window, click the File tab, and then click New. The 

New Document dialog box opens. With Blank document selected, click Create. 

 
FAQ - 13 How do you save a document in Microsoft Word? 

Answer : To save a document for the first time, you can press Ctrl+S, click the Save button on the Quick 

Access toolbar, or click Save on the File tab. All three options display a dialog box in which you 

specify a name for the document. 

 
FAQ - 14 How do you track changes to documents? 

Answer : You can use Word's Track Changes feature to record the changes made to a document. Click the 

Track Changes button in the Tracking group on the Review tab. Word highlights the button, 

indicating that the Track Changes feature is turned on. 

 
FAQ - 15 How do you format text, change font, and font size? 

Answer : To format text, in the Font group on the Home tab, click the Bold, Italic or Underline button. To 

change the font and font size click on the toolbar. Click the Font arrow to display a list of available 

fonts. Then click the Font Size arrow to select the size. 

 

FAQ - 16 What will the following key combination do: Ctrl+P? 

Answer : Ctrl+P will print the document. 

 
FAQ - 17 How do you check spellings and grammar of a MS Word document? 

Answer : Place the cursor at the beginning of the document or at the beginning of the section that you want 

to check. Click the Review tab on the tool bar. Click Spelling & Grammar on the Proofing group. 

 

FAQ - 18 Describe way of creating a new table. 

Answer : Click the Insert tab of ribbons and then click on down arrow of tables and select the number of 

columns and rows as desire. New table will be inserted. 

 

FAQ - 19 What is the shortcut keys for creating hyperlink? 

Answer : Create a hyperlink Cntrl +K 

 

FAQ - 20 How to add foot-node & end note in word? 

Answer : To add foot node, bring the cursor at the end of page where you want to add the foot node than go 

to main menu click on Reference Option click on Insert Footnotes.  Likewise you can add end note 

by clicking on “Insert endnote”. 

 

FAQ - 21 When you create something in Excel what is it called? 

Answer : A Workbook. 
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FAQ - 22 How do you create a spreadsheet in Microsoft Excel from scratch? 

Answer : When you start Excel without specifying a document to open you get a blank workbook in a new 

workbook window. This workbook, temporarily named Book1, contains three blank worksheets 

(Sheet1, Sheet2, and Sheet3). To begin to work on a new spreadsheet, you simply start entering 

information in the first sheet of the Book1 workbook window. 

 
FAQ - 23 How do you save a spreadsheet in Microsoft Excel? 

Answer : Click the Save button on the Quick Access toolbar or press Ctrl+S; then designate the drive and 

folder directory where the file should be located. 

 

FAQ - 24 How do you print a spreadsheet in Microsoft Excel? 

Answer : First, use the Print Preview feature before you print any worksheet to see exactly how the worksheet 

data will be paged when printed. You then can click the print icon in the toolbar. 

 
FAQ - 25 How do you format cells in a spreadsheet? 

Answer : First, you highlight the entire block of cells you wish to format. You then can either right click the 

block of cells to format or select one of the formatting buttons on the toolbar. 

 

FAQ - 26 What is meant by cell address? 

Answer : Excel worksheet is an array of cells arranged in columns and rows. The columns are marked by 

alphabets while the rows are numbered. Cell address is the combination of column letter and 

followed by number of row. If a cell is located in column C and in the row 7, then its cell address is 

C7. 

 

FAQ - 27 Name the categories of Operator used in Excel? 

Answer : There are four categories of operators used in MS Excel, Reference, arithmatic, comparison and 

text operators.  

 

FAQ - 28 What is a worksheet functions? 

Answer : To apply formula in Excel a command name is known as functions. There are many categories of 

functions. For example to add up values we use “SUM“ function. 

 

FAQ - 29 Can any part of a spreadsheet can be printed? 

Answer : Yes any selected part of worksheet function can be printed. 

 

FAQ - 30 What are the components of formula in a cellsof spreadsheet? 

Answer : Formula starts with equal sign „=“, then can have function and operators with text or number. 

 
FAQ - 31 When you create something in PowerPoint what is it called? 

Answer : A presentation. 

 
FAQ - 32 What type of data can be inserted in slides of Power point. 

Answer : You can insert text, tables, which may contain text, graphics, sound, movies, hyperlinks, and other 

objects.  
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FAQ - 33 Can you add animation feature in a power point? 

Answer : This software also enables user to add animation and effects to slideshow elements. 

 

FAQ - 34 Can the presentation of powerpoint be printed? 

Answer : Presentations can be printed, displayed, notated, and navigated by the presenter. 

 

FAQ - 35 What is the extension of power point file? 

Answer : The extension of powerpoint file is ppt or pptx. 

 

FAQ - 36 How do you create a new presentation? 

Answer : You would click the Office button to open the File menu and choose New to display the New 

Presentation window. Double-click Blank Presentation to open a new presentation based on the 

blank template. 

 
FAQ - 37 How do you view your presentation in full screen mode? 

Answer : Click the Slide Show view button to display the slide show starting with the currently selected slide. 

 
FAQ - 38 How do you save a PowerPoint presentation? 

Answer : Click the Office button and choose Save from the File menu to display the Save As dialog box. 

Type a name for the document and then click save. 

 
FAQ - 39 How do you build a slide in a blank presentation? 

Answer : Click the New Slide button to insert a new title and content slide. To change the layout click the 

arrow on the New Slide button and click another option from the drop-down box to insert a slide 

with a different layout. 

 
FAQ - 40 How do you select and apply Theme colors? 

Answer : Go to the Design tab and locate the Themes group. Hover over a theme to see a preview of it in 

the presentation.  Click a theme to apply it to the slides. 
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Test Yourself 

 

Multiple Choice Questions (MCQs) 

 

1) Name of the screen that recognizes touch input is:  

a) Recog screen 

b) Point Screen 

c) Touch Screen 

d) Android Screen 

 

2) Identify the device through which data and instructions are entered into a computer 

a) Software 

b) Output device 

c) Input device  

d) Memory 

 

3) Computer Monitor is also known as :  

a) DVU 

b) UVD 

c) VDU 

d) CCTV 

 

4) Arrange in ascending order the units of memory TB, KB, GB, MB  

a) TB>MB>GB>KB 

b) MB>GB>TB>KB  

c) TB>GB>MB>KB 

d) GB>MB>KB>TB 

 

5) Which one of these stores more data than a DVD ?  

a) CD Rom 

b) Floppy 

c) Blue Ray Disk 

d) Red Ray Disk 

6) The output shown on the computer monitor is called  

a) VDU 

b) Hard Copy 

c) Soft Copy 

d) Screen Copy 
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7) Eight Bits make up a  

a) Byte 

b) Megabyte 

c) Kilobyte 

d) None of these 

 

8) Which one is the result of the output given by a computer  

a) Data 

b) Instruction 

c) Information 

d) Excursion  

 

9) Which one of these also known as read/write memory?  

a) ROM 

b) RAM 

c) DVD 

d) Hard Disk 

 

10) The printed output from a computer is called  

a) Copy 

b) Soft Copy 

c) Hard Copy 

d) Paper 

 

11) What is place to the left of horizontal scroll bar ?  

a) Indicators 

b) Split buttons 

c) Tab stop buttons 

d) View buttons 

 

12) Where can you find the horizontal split bar on MS Word screen? 

a. On the top of vertical scroll bar 

b. On the bottom of vertical scroll bar 

c. On the left of horizontal scroll bar 

d. On the right of horizontal scroll bar 
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13) Tabs stop position cannot be the following alignment? 

a)   Decimal Alignment 

b) Center Alignment 

c)   Bar Alignment 

d) Justify Alignment 

 

14)  What is the use of bookmarks ? 

a) To correct the spellings. 

b) To jump to a specific location in the document 

c) To ignore spelling mistakes 

d) To save alignments as it is. 

 

15)  Which feature is used to replace straight quotes with smart quotes as you type ? 

a) Auto Correct as you type 

b) Auto Change as you type 

c) Auto Ignore as you type 

d) Auto Format as you type 

 

16) Ctrl + D is short cut used for ? 

a) Open Dialogue Box 

b) Font Dialogue Box 

c) Save as Dialogue Box 

d) Save Dialogue Box 

 

17) Ctrl + G is shortcut for ? 

a) Open Find and Replace Dialog box with activating Goto Tab 

b) Open Find and Replace Dialog box with activating Find Tab 

c) Open Find and Replace Dialog box with activating Replace Tab 

d) Open Goto Dialog box 

 

18) Ctrl + H is short cut for ? 

a) Open Insert Dialog box activating Insert Hyper Link Tab 

b) Open Find and Replace Dialog box with activating Go to Tab 

c) Open Find and Replace Dialog box with activating Find Tab 

d) Open Find and Replace Dialog box with activating Replace Tab 
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19) What can be searched by find? 

a) format 

b) characters 

c) symbol 

d) All of above 

 

20)  on which page the header or the footer is printed by default ? 

a) on first page 

b) on last page 

c) on alternate page  

d) every page 

 

21) Which of these toolbars allows changing of Fonts and their sizes ? 

a) Standard 

b) Formatting 

c) Options 

d) None of above 

 

22) To spell check which function key you will press ? 

a) F5 

b) F6 

c) F7 

d) F8 

 

23) How to insert a sound file in word document ? 

a) From insert -> sound menu option 

b) From insert -> object menu option 

c) From insert -> subject menu option 

d) From insert -> file menu option 

 

24) How many maximum number of columns can be inserted in the word document ? 

a) 45 

b) 50 

c) 55 

d) 65 
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25) Which file format can be added to a power point show? 

a) .jpg 

b) .gif 

c) .wav 

d) All a, b & c 

 

26) In   Microsoft PowerPoint to kind of Sound effects files that can be added to the presentation are 

a) .wav files and .mid files 

b) .wav files and .gif files 

c) .wav files and .jpg files 

d) .jpg files and .gif files 

 

27) Material consisting of text and numbers is best presented as 

a) A table slide 

b) A bullet slide 

c) A title slide 

d) All of the above 

 

28) What is a motion path? 

a) A type of animation entrance effect  

b) A method of advancing slides  

c) A method of moving items on a slide 

d) All of above 

 

29) What is a slide title must appear?  

a) A title area and text area of specific slide 

b) A slide master and title master merged into a single slide  

c) A slide master and title master for a specific design templet  

d) All of above 

 

30) Which of the following should you use if you want all the slides in the presentation as the same look? 

a) The slide layout option 

b) Add a slide option  

c) Outline view  

d) A presentation design templet 
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31) In the context of animations, what is a trigger? 

a) An action button that advances to the next slide  

b) An item on the slide that performs and action when clicked  

c) The name of a motion path 

d) All of above 

 

32) In Order to edit a chart, you can 

a) Triple click the chart object  

b) Click and drag the chart object  

c) Double click the chart object 

d) Click the chart object 

 

33) With which of the following all formulas in excel starts? 

a) / 

b) * 

c) $ 

d) = 

34) On an excel sheet the active cell in indicated by? 

a) A dotted border 

b) A dark wide border 

c) A blinking border 

d) By italic text 

 

35) What term describes explanatory text attached to a cell? 

a) context 

b) callout 

c) comment 

d) dialog 

 

36) How we can view a cell comment? 

a) Position the mouse point over the cell 

b) Click the comment command on the view menu 

c) Click the edit comment commands on the insert menue 

d) Click the Display comment command on the window menu 
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37) Which of these will not select all the cells in a document? 

a) Using the edit select all menu 

b) Pressing Ctrl+A on the keyboard 

c) Clicking three time with the right mouse button in the spread sheet 

d) None of these 

 

38) The default style on new data keyed in a new workbook is? 

a) comma 

b) Normal 

c) Currency  

d) Percent 

 

39) If you press __________, the cell accept you typing as its contents? 

a) Tab 

b) Ctrl+Enter 

c) Ener 

d) Alt+Enter 

 

40) To convert a column of data into row which command will you choose  

a) Edit àPast Special àTranspose  

b) Cut and paste  

c) Both of above  

d) None of above 

 

Answers key: 

 

1 C 2 C 3 C 4 C 5 C 

6 C 7 A 8 B 9 D 10 C 

11 D 12 A 13 D 14 B 15 D 

16 B 17 A 18 D 19 D 20 D 

21 B 22 C 23 B 24 A 25 D 

26 A 27 A 28 C 29 C 30 D 

31 B 32 C 33 D 34 B 35 C 

36 A 37 C 38 B 39 C 40 A 
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Module 2:  
Develop 2D Drawings using AutoCAD 
 
 
Objective: 

Objective of this module is to provide skills and knowledge to create 

2-dimensional drawings by using various tools and commands. You 

can create and modify objects and drawings in AutoCAD to meet 

specific targets according to job requirements. 

 

 
Learning Outcomes: 

After completion of this learning module, you will be able to: 
 

· Develop 2D objects 

· Prepare final setup of 2D drawing  
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Learning Unit 1:  

Develop 2D Objects 
  

Objectives 

In this learning unit you will learn how to open and save file with 

desired name and location, interface, create 2D objects and 

modifying objects. After completion of this learning unit you will be 

able to understand following. 

 

After completion of this learning unit you will be able to: 
 

· Setup drawing interface for required specifications. 

 

· Setup user interface settings for required specifications. 

 

· Create 2D objects with given measurements. 

 

· Save AutoCAD drawing files in different file formats (e.g. 

dwg, PDF, JPG). 

 

· Edit 2D objects to meet set standards. 
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This unit describes fundamentals of AutoCAD 2D. After completion of this learning unit, you will be able 

to create the new file, prepare drawing, modify, dimension the drawing and save it. 

 
1.1.1.   AutoCAD 

AutoCAD is Automatic Computer-Aided Drafting and design (CAD), developed and marketed 

by Autodesk. AutoCAD was first released in December 1982 as a desktop app running 

on micro computers with internal graphic controllers. Since 2010, AutoCAD is released as 

a mobile-and web app as well, marketed as AutoCAD 360. 

AutoCAD is used in the civil, mechanical, architecture, electrical, electronics and graphic 

designers.   

 

 
 

 

How to open the AutoCAD software 

There are different ways to open AutoCAD software, can be access from windows start button 

or icon (identification of file, folder or software), short keys. 

 

 

1.1.1.1. Introduction of AutoCAD workspaces (screen): 

The collection of tools displayed after creating or opening a drawing is called a 

workspace.  

 

 

1. Develop 2D Objects 

 Setup drawing interface for required specifications. 
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Some useful toolbars are discussed here. 

 

· Title bar 

Title bar is shown on the top of the screen and also include the file name. 

 

 
 

· Quick Access toolbar 

It is located to the right of application menu and provides immediate access to some of 

most frequently used commands to complete tasks such as creating, opening, saving ad 

plotting drawings. The Quick Access toolbar displays options to undo and redo changes 

to your file, save, print, the most use option can be added in access toolbar. 

 

.  
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· Menu Bar or Application Menu 

Horizontal bar, typically located at the top of the screen below the title bar. It contains drop-

down menus, including File, Edit, Insert, Format, Tools, Draw, Dimension, Modify, 

Parametric, Window, Help and Express.   

 

e

 
 

· Ribbon 

Ribbon includes different tabs and groups. It is located immediately below the title bar and 

serves the primary launch pad for nearly every command used to compose drawings in 

AutoCAD. 

 

 
 

· Pull down Menu 

Pull-down menus are displayed as a list under a menu bar 

 

 
 

· Standard Toolbar 

Standard toolbar is shown below menu bar and includes files like save, print, print view, 

spelling checking and open files. 
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· Command bar or Command prompt  

Command line is located in the bottom left corner of the CAD interface. The AutoCAD 

Command line is like a combined control panel and index of all AutoCAD commands you 

run 

 

 
 

· Status Bar 

Status bar is located below the command line and is shown on the bottom of screen. Status 

bar has different elements, coordinate values, drawings tool, quick properties, models, 

layouts, quick view tools, navigation tools, annotation tools workspace and clear screen. 

 

 
 

 

· Working area of AutoCAD 

In working area, we can do two or three axes of working. In working area mouse cursor 

shows in different style, crosshair and pic box.  

 
 

 
1.1.1.2. Ways to enter the command in AutoCAD 
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There are four ways to enter the command in AutoCAD those are written below. 

i. Menu bar 
ii. Tool bar 
iii. Command prompt 
iv. Short key 

 

· Command 

An order to the computer to executes a particular task 

 

· File menu 

In file menu some important point that we need to discuss here 

 

 
 

  

· Create or Open New File 

Create or open new file means to get a new drawing in AutoCAD or learner can also use 

a template already available in CAD templates library. 

 

· How to Open templates in AutoCAD 

Create New Template: Learner can open or create a template 

by clicking  
File àNew à Select Template as shown in the figure. 

 

Do you know? 

Templates: is a pre- 

define layout 

available in 

AutoCAD Software 

which assist the 

learner. 
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· Save the File 

Save the file before anything is drawn in it as a primary step to secure drawing. 

There are three methods to save a file. 

Method-1: Through   Short Cut Key: Ctrl + S 

 

Method-2: From Standard tool Bar Click on  

 

Method-3: Through File Menu: Click File → save then Name the file and Location where 

to save 

 

 

· Print 

In print we can print document 

Method-1: Through   Short Cut Key: Ctrl + P 

 

Method-2: From Standard tool Bar Click on  

 

Method-3: Through File Menu: Click File → Print/ plot  
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e  
 
 

· Function Keys 

Learner is able to set and change the limits in inches and millimeter using keyboard 

function keys. A typical keyboard complete with function key above the alphanumeric keys. 

These functions keys are labeled F1 through F12 only keys F1 through F11 will be 

discussed here 

F1=  Windows Online Help  

F2 = Toggle Between Graphic Screen / Text Screen.  

F3 =  Toggle OSNAP setting dialogue box.   

F4 =  Toggle tablet mode on or off. 

F5 =  3 Iso-plane modes to construct isometric drawing. 

F6 =  Toggle the coordinates. On/off. 

F7 = Toggle the display of Grid on or off.  

F8 =  Toggle to Ortho mode.  

F9 = Toggle Snap mode on or off. The SNAP command sets the current snap value.  

F10 =  Toggle Polar tracking on or off. 

F11 =  Object snap tracking on or off. Speakers 
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1.2.1. Types of Drawing 

i. 2-Dimensional drawing 

ii. 3-Dimensional drawing 

 

· 2-Dimensional drawing:  

A physical object in which length and width are real attributes. Any object can be drawn 

with respect to x and y coordinates. 

 
 

· 3-Dimensional drawing: 

A physical object in which length, width, and depth are real attributes—a model, with X, Y, 

and Z-axes that can be rotated for viewing from different angles 

 

 
1.2.2.   Drawing Limits 

Drawing limits are used to set the boundaries of the drawing. The 

drawing boundaries are usually set to match the size of a sheet of 

drawing paper. In AutoCAD, setting limits correctly enables you to 

display the drawing grid over your working area, among other 

things. When you want to display all grids of limits you have to on 

Grid element from the status bar. 

 

Drawing Limits define drawing sheet with horizontal and vertical coordinates as shown below. 

 
 

  Basic Drawings concepts 

Remember 
 

Limits can be 
adjusted 
according to 
Length type. 
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Procedure 

 

 

Step-1: Type limits command in command bar, you will get the following instructions. 

Step-2: Define the lower Left corner as 0, 0 

 

 
Step-3: Define the Upper Right corner as 100-feet, 100-feet. 

Step-4: Grid Display: Now you can see the defined limits to On Grid elements in status bar 
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The table below can be used to compare ISO drawing sheets (based on ISO 216) with to 

American drawing sheets (based on ANSI/ASME 14.1):  

!

ISO USA Sizes 

Letter 
Width Length 

Letter inches mm 
mm inches mm inches 

          F 28.0 x 40.0  

A0 841 33.11 1189 46.81 E 34.0 x 44.0 863.6 x 1117.6 

A1 594 23.39 841 33.11 D 22.0 x 34.0 558.8 x 863.6 

A2 420 16.54 594 23.39 C 17.0 x 22.0 431.8 x 558.8 

A3 297 11.69 420 16.54 B 11.0 x 17.0 279.4 x 431.8 

A4 210 8.27 297 11.69 A 8.5 x 11.0 215.9 x 279.4 
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1.2.3.    Unit setting 

AutoCAD drawing unit dialogue box allows for either English 

or metric units to be used as default values. Unit setting is the 

primary step to set the unit according to the discipline. Unit can 

be set by using UN command in command bar or from main 

menu through format tab.     

 
Procedure-1 

Format → Units… 

Procedure-2 

Write UN in command bar to get drawing units dialog box. 

. 

1.2.4.   Unit Control 

The dialogue box is separated into four main sections. 

 

i. Length type: Which refers to linear units: Like Decimal, Architectural, Engineering 

etc. 

ii. Angles: Referring to angular units 

iii. Precision: Precision is used to help a user to specify the precision value is to be 

needed for the drawing. Ideally precision value varies in terms of number of zeros 

after the decimal or fraction values. More Zero after decimal more precision will 

occur in drawing. 

iv. Insertion Scale: Selection of different measurement as per length type, like feet or 

inches for Architectural drawing. 

Remember 
 

 
AutoCAD can work in 
any of five units; 
scientific decimal, 
Engineering, fractional or 
Architectural 
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1.2.5.   Coordinate System 

Real object can be view in 3 dimensions (Width, 

Length and height), In AutoCAD these 3 dimensions 

are represented with three Position X, Y and Z axis, 

is known as the Co-ordinate System. 

 

· World Coordinate System: 

 
All objects drawn in AutoCAD based on a simple 

X, Y or X, Y, Z co- ordinate system is known as 

the World Coordinate System (WC,). 

 

· Cartesian Coordinate System:  
 
A system which define the point draw in a Plan with 

respect to 2 Axis (X, Y) or 3 Axis (X, Y, Z) in the 

same unit of length. 

1.2.6.    Entering Point Styles in AutoCAD 

This basic technique of making 2D drawing in AutoCAD 

and let the learner to know about different coordinate 

systems (Absolute, Relative and Polar Coordinate 

system). 

You can enter points directly on the command line using three different systems. 

i. Absolute Co-ordinate 
ii. Relative Co-ordinate 
iii. Polar Co-ordinate 

· Absolute Co-ordinates 
Coordinates those are defined in terms of their 

distance from the origin, the point where the 

axes intersect 

 

Syntax: X, Y 

 

I.e. only give two values separated by comma. 

 

  

· Relative Co-ordinate 

Coordinates that are defined in terms of their 

distance from a given starting point, rather 

than from the origin (intersection of two axes). 

 

Syntax: @X, Y 
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· Polar Co-ordinate 
The fixed horizontal line in a system of polar coordinates from which the object is drawn 
by giving distance with angle. 

Syntax: @distance<angle 
Where Distance=length < = (symbol) 
Angle= to which direction the object is required. 
 

 

 
  

In the Figure the line is drawn under the following command. 

@13<22.6 Where Distance= 13, Angle=22.6 
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Practice of co-ordinates 

 

· Absolute Coordinate  

 
This is the main purpose of using coordinates. The simplest and most Elementary form of 
coordinate values is Absolute coordinates. Absolute coordinate conform to the following 
format: (X, Y) 
 
Command: LINE 

Specify first point: 3,1 

Specify next point or [Undo]:  <Ortho 

on> 3,6 

Specify next point or [Undo]: 4,6 

Specify next point or [Close/Undo]: 4,2 

Specify next point or [Close/Undo]: 5,2 

Specify next point or [Close/Undo]: 6.3 

Specify next point or [Close/Undo]: 7,3 

Specify next point or [Close/Undo]: 7,1 

Specify next point or [Close/Undo]: c 

Command: Regenerating model. 

 
 
 

1.2.7.   Relative Coordinate Mode to Draw. 
 

The new point would be relative to the pervious 

point and for this reason this point is called a 

relative coordinate. Relative Coordinate format 

is as follows: @X, Y 

 
Command: LINE 
Specify first point: 1,1 
Specify next point or [Undo]: @4,0 
Specify next point or [Undo]: @0,3 
Specify next point or [Close/Undo]: @-4,0 
Specify next point or [Close/Undo]: @0,-3 
Specify next point or [Close/Undo]: c 

 
 
 

1.2.8.    Mode to Draw Polar Coordinate 

Another popular method of entering coordinates is by polar mode. The format is as following. 

@ Distance<Direction 

LINE command. 

Specify first point: 1.5,1.75 

Specify next point or [Undo]: @1.0<90 

Specify next point or [Undo]: @2.08<0 

Specify next point or [Close/Undo]: @2.0<30 

Specify next point or [Close/Undo]: @.75<0 

Specify next point or [Close/Undo]: @1.25<-90 

Specify next point or [Close/Undo]:  <Ortho off> 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 111 

   Module-2, (LU-1): Develop 2D Drawings 

 

  <Ortho on>  <Ortho off> 
>>Enter new value for ORTHOMODE <0>: 

Resuming LINE Command. 

Specify next point or [Close/Undo]: @1.0<180 

Specify next point or [Close/Undo]: @.5<270 

Specify next point or [Close/Undo]: @1.0<0 

Specify next point or [Close/Undo]: @1.25<270 

Specify next point or [Close/Undo]: @.75<180 

Specify next point or [Close/Undo]: @2.0<150 

Specify next point or [Close/Undo]: c 

 
1.2.8.1. User Coordinate System (UCS) 

User Coordinate System is a user 
defined coordinates system that 
adjusts a Plan for drawing and 

modeling. User can change the origin according to the object orientation. 
 
· Procedure 

Method-1: Type UCS in command Bar to View all option of UCS as shown in Figure below: 

Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/Z/ZAxis] 

<World>: 

 

Method-2: Right Click on the Standard tool bar and select 

the UCS option within the POPUP Window. 

 

  
Step-3:  You Will See UCS Icon display 
 
 
 
 
 
 
 

 

Step-1: Type UCS 

Step-2: You will see different UCS option. 
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1.3.1.   Drafting setting 

Useful command to set grid and snap, polar and object snap tracking, object snap modes, 

dynamic Input, and quick properties. 

 

· Type Drafting command in command bar and press enter 

You will get the following setting. 

 

 

· Alternate Method to Access 

You can also access drafting setting by using the following method 

 
From Menu bar àTools àDrafting Settings 

 

Right-click Snap, Grid, Polar, Osnap, Otrack, Dyn or Quick Properties on the status bar. 

Click Settings. 

 

  Setup user interface setting for required specifications. 
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1.3.2.   SNAP setting /DSETTING  

It is possible to have the cursor lock onto or snap to a grid. By default, the current snap spacing 

is 1.00 units. This can be accomplished by using the SNAP Command below or by pressing 

the F9 function key. 

 

 

 
1.3.3. Customizes the display 

In customize setting we can change AutoCAD windows elements, layout elements, display 

resolution, crosshair size. 

Procedure 
  
To customize the display type OPTION in command line window 
 
Or 
 
Select from tools menu. 
The following dialogue will be shows below.  
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· Change in background 

If you want to change you AutoCAD background colors. Follow the following procedure. 

 
STEP: 1 

Go to Options →Display→ then select the Color button. 
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In the Drawing Window Color dialog, you have complete control over the color settings of 

most everything in AutoCAD.  

 
STEP: 2 

Select Sheet/Layout → Uniform Background and then set the color you want.  

Then select Apply & close. 
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· To Change the Cursor Size / Crosshair size 

Go to Options→ Display → then crosshair size. 
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To Change the Pickbox Size & Grip size 

Procedure  

Go to Options→ Selection → then Pickbox size and Grip size. 
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· To Change the Pickbox Size & Grip size 

 

Procedure  

Go to Options→ Drafting → then AutoSnap marker size. 

- 
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1.3.4.    Layers 

A layer is like a clear/ transparent piece of paper that you can lay directly over the drawing. 

You can draw on the layer and see through it to the original drawing. As a means of organizing 

objects, a series of layers should be devised for every drawing. Layers can be thought of as a 

group of transparent overlays that combines to from the completed drawing 

 

 

· Learner is able to learn that how to create new layers properties like 

Name, On / off, Freeze, Lock, Color, Line type, Line Wight, Transparency, Plot Style, 

Plot 

New VP Freeze, Description 

 

· How to Create a New Layer in AutoCAD 

Step-1: 

Type LA at the command line and then press Enter or Click the Layer Properties button in 

the Layers panel on the Home tab of the Ribbon. The Layer Properties Manager palette 

appears. A new drawing has only one layer: Layer 0 (zero). You need to add the layers 

necessary for the drawing. 

 

Step-2: 

Click the New Layer button: A new layer appears. AutoCAD names it Layer1 but highlights 

the name in an edit box so that you can type a new name to replace it easily. 
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Step- 3: 

Type a name for the new layer. 

 

Step-4: 

On the same line as the new layer, click the color block or color name (by default, the same 

as the current layer) of the new layer. You can select any color from the color dialog box 

appears. 
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1.3.5.   How to Reset AutoCAD Defaults 

How to reset or restore the settings of AutoCAD, AutoCAD LT, AutoCAD for Mac, or other 

AutoCAD-based product to original default values. Most versions of AutoCAD have a reset 

utility to accomplish the task. Those that do not must follow the manual reset process. 

Run the app named Reset Settings to Default, located alongside AutoCAD in the list of all 

applications accessed from the Windows Start menu. For example: 

i. Windows 10: Start > AutoCAD 20xx > Reset Settings to Default 

ii. Windows 8: Search for 'reset settings to default' under the Start Screen. 

iii. Windows 7: Start > All Programs > Autodesk > AutoCAD 20xx > Reset Settings to 

Default 
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Before creation of drawing we must know about its menus, tools, and operation. 
 
1.4.1.   AutoCAD Menu 

There is different menu in AutoCAD that are displayed when we open the software. 

 
i. File Menu 

ii. View Menu 

iii. Insert Menu 

iv. Format Menu 

v. Tools Menu 

vi. Draw Menu 

vii. Modify Menu 

viii. Parametric menu 

ix. Windows menu 

x. Help menu 

xi. Express menu 

· File menu 

 

Sr. No. Operation Uses Short-key 

1 New How to open new file Crtl + N 

2 Open Open already saved file Crtl + O 

3 Save Save the file Crtl + S 

4 Save As  specify the name and location for saving Crtl + Shift + S 

5 Close Close the current drawing file. Crtl + F4 

6 Plot To print a drawing  Crtl + P 

7 Exit To close or exit a program Crtl + Q 

 

· Edit Menu 

There are some edit menu options that are listed below 

Sr. No. Operation Uses Short-key 

1 Undo Erases the last change done Crtl + Z 

2 Redo To reverse your last action Crtl + Y 

3 Cut To cut the selected drawing Crtl + X 

4 Copy To copy the selected drawing Crtl + C 

5 Paste To Paste the copy drawing Crtl + V 

6 Delete To delete the selected drawing Del 

7 Select All To Select all drawing   Crtl + Q 

· View Menu 

There are some view options in menu bar 

 

 Create 2D objects 
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Sr. No. Operation Uses 

1 Zoom To view the drawing larger or smaller   

2 Pan Shifts the view without changing the viewing direction 

3 Ariel view  Displays the entire drawing; the current view is marked with a 
wide outline box. 

4 Clear 
Screen 

To remove or clear the drawing  

5 View Port To display the some dawings parts 

6 3D view To view three dimension view 

7 Rander To create the raster image 

 

· Insert Menu 

There are some insert options in menu bar 

 

Sr. 
No. 

Operation Uses 

1 Block To insert the drawing  

2 External Reference  To insert another into drawing 

3 Layout Create a new layout/ paper space 

 

 

· Format menu 

 

Sr. No. Operation Uses 

1 Layer To make drawing in required layer 

2 Color To fill the required color 

3 Line type To select the line type as required 

4 Line weight To select the line weight 

5 Scale To select the drawing scale 

6 Text style To specify the text style 

7 Dimension style To specify dimension style 

8 Table Style To make table required style 

9 Point Style Fix the point style 

10 Unit To set drawing measuring units 

 

· Tools Menu 

 

Sr. No. Option Uses 

1 Spelling  To check or correct spelling mistakes 

2 Draw order To View different parts of drawing as required 

3 Inquiry  To take measurement of drawing 

4 Calculator For calculations 

5 Macro  To record macro 

 

· Draw menu 

 

Sr. No. Operation Uses 

1 Line To draw the line 

2 Ray To Ray line 

3 Polygon  To make polygon 
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4 Rectangle To make rectangle 

5 ARC To draw the arc 

6 Circle To draw the circle 

7 Table To insert the table 

8 Hatch To inert different style of hatch 

9 Text To draw the text  

10 Solid  To draw the solid drawing 

 

 

· Dimension menu 

 

Sr. No. Operation Uses 

1 Linear To place a linear dimension 

2 Aligned To place an aligned dimension  

3 Radius  To place a radius dimension   

4 Diameter To place a diameter dimension 

5 Angular To place an angular dimension 

 

 

· Modify menu 

 

Sr. No. Operation Uses 

1 Erase To erase the lines or drawings 

2 Copy To make duplicate of lines or drawings 

3 Mirror To Flip a lines or drawings parts 

4 Offset To take offset 

5 Array To create the objects, copy in a required pattern 

6 Move To move selected object 

7 Rotate To rotate selected object 

8 Trim To cut the extra edges  

9 Fillet To make round in line corner 

10 Break To create breaks/ distribute into two parts of line/ arc 

 

 

· Express menu 

 

Sr. No. Option Uses 

1 Layers To view the layered drawings and changing 

2 Block TO Make or change the block in drawings 

3 Text Change the text style  

4 Layout To set the line spacing of drawing 

5 Dimension To set different style in dimension  

6 Modify To make changing in drawings that save already 

7 Draw To show break line  

 

· Window Menu 

 

Sr. No. Option Uses 

1 Close To Close window 

2 Close All To close all opened windows 

3 Cascade Re-arrange the opened windows 

In creation of 2D objects, different AutoCAD commands/ tool bars are explained below     
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· Draw toolbar 
 

 

 
 
 
 

1.4.2.   Draw Menu bar 
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1.4.2.1. Line 
Line Command is used to draw straight lines between 
two defined points. 

 
 
 
 
 
 
 
 
 

Draw Manu Draw Toolbar Command Entry 

 

Line 

 

 

 

Line/L 

How to draw a line 

Step-1: Type L in command Bar 

Step-2: Line Specify First Point: 0, 0 and Press Enter 

Step-3: Line Specify Next Point: 5, 10 and Press Enter 

 

 

 

Remember

Line (0, 0) 

  

X, Y is a 2D 

 

X,Y Define First 

point as an Origin 

There are six types 
of lines using 
drafting   
 AutoCAD. 

Remember 
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1.4.2.2. Draw polyline 

A single object that is composed of line and arc Segments. 

Draw menu bar   ®PolyLine   ®click on icon 

Or  

Short key  

PL       ® Enter 

The following message will be displayed in command line 

 

 
 

 

Command: PL 

PLINE 

Specify start point: Select the point on the graphic window e.g. 2,2 enter key 

Following message will be displayed in command line 

Current line-width is 0'-0" 

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 

To respond the message, give your options as per requirements as under. 

Arc:   To draw the Arc type A and press enter 

Halfwidth: To draw the halfwidth type H and press enter 

Length: To draw the Arc type L and press enter 

Undo:  To draw the Arc type U and press enter 

Width:  To draw the Arc type W and press enter 

 

1.4.2.3. Draw spline 

Creates a smooth curve that passes through or near a set of fit points, or that is defined 

by the vertices in a control frame. 

Draw menu bar ® Spline  ® click on icon 

Or  

short key  

SPL        ® Enter  
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Command: SPL 

SPLINE 

Following message will be displayed in command line 

Specify first point: Select the point on the graphic window e.g. 2,6, enter key 

Current settings: Method=Fit   Knots=Chord 

Specify first point or [Method/Knots/Object]: 

To respond the message, give your options as per requirements as under 

i. Method: Controls whether the spline is created with fit points or with control vertices 

ii. Knots: Specifies the knot parameterization, one of several computational methods 

that determines how the component curves between successive fit points within a 

spline are blended. (SPLKNOTS system variable) 

iii. Object: Converts 2D or 3D quadratic or cubic spline-fit polylines to equivalent 

splines. 

 
 

1.4.2.4. Draw construction line 

Creates a construction line of infinite length. 

Draw menu bar → construction Line → click on icon 

Or short key  

XL → Enter 
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Command: XL or XLINE 

Following message will be displayed in command line 

Specify start point: Select the point on the graphic window e.g. 2 enter key 

Specify a point or [Hor/Ver/Ang/Bisect/Offset]: 

Hor (Horizontal): Draw the horizontal line 

Ver (Vertical): Draw the vertical line 

Ang (Angle): Draw the angle line 

Bisect:  Bisect an angle define by a vertex and two end points.  

Offset:  Draw construction line in offset. 

 

1.4.2.5. Draw Ray line 

Creates a linear object that starts at a point and continues to infinity 

Draw menu bar     ® Ray Line       ®click on icon 

Or 

short key  

Ray   ®Enter  
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Command: Ray 

RAY 

Following message will be displayed in command line 

RAY Specify start point: Select the point on the graphic window e.g. 6 enter key 

Specify through point: 

To respond the message, give your options as per requirements 

 

1.4.2.6. Draw Multi line 

Multiline are composed of parallel lines, called elements. When you draw a multiline, 

you can use the STANDARD style, which has two elements 

 

Draw menu bar → multi Line   → click on icon 

Or  

short key  

ML→ Enter 
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Command: ML¿ 

MLINE 

Current settings: Justification = Top, Scale = 1.00, Style = STANDARD 

Specify start point or [Justification/Scale/STyle]:  10,10¿ 

Specify next point:  22,10¿ 

Specify next point or [Undo]:  22,22¿ 

Specify next point or [Close/Undo]:  10,22¿ 

Specify next point or [Close/Undo]:  C¿ 

Specify start point or [Justification/Scale/STyle 

To respond the message, give your options as per requirements as under 

Justification: Draw multiline in top, bottom and center 

Scale:  Enter scale of multiline distance 

Style:  define style of multiline 

 

· Justification Option 

The justification determines how a multiline is drawn between the specified points. Three 

justifications are available for the MLINE command. They are Top, Zero, and Bottom as 

shown in following figure.   
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Figure: Justification in multiline 

i. Top 
This justification provides with the points produces a multiline in which the top line 

coincides with the points you selected on the screen. 

ii. Zero 
This option will produce a multiline in which the zero offset position o the multiline 

coincides with the selected points. 

iii. Bottom 
This option will produce a multiline in which the bottom line (the line with the least 

offset distance) coincides with the selected point when the line is drawn from the left 

to right. 

 

iv. Scale Option 
The scale option is used to change the scale of a multiline. For example, if the scale 

factor is 0.5, the distance between the lines (offset distance) will be reduced to half, 

as shown in following figure. Therefore, the width of the multiline will be half of what 

was defined of multiline style. 

 
                                                    Figure:  Different multiline scales 

 
 

· MLEDIT 

Menu Bar: Modify > object > Command:  MLEDIT 

When you invoke the MLEDSIT command, Auto CAD displays the Multiline Edit Tools 

dialog box, see Figure 3. This dialog box contains five basic editing tools. To edit a 

multiline, first select the editing operation you want to perform by clicking on the image tile. 
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Once you have selected the editing option. AutoCAD will prompt you to select the first and 

second multilines. 

 
Figure 3:  The Multiline Edit Tools dialog box 

 

 

· Line Type 

Line types can be a pattern of dashes, dots, text, and symbols, or unbroken and 
continuous. The current line type setting defines the default appearance of all new 
geometric objects. You can see which line type is current in the Properties panel of the 
ribbon Home tab when no objects are selected Or can access by entering LT command 
Type LT enter, then following windows shows by AutoCAD 
 

 
 

· Line type Scale 
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Line type scale controls the size and spacing of repetitions of the linetype pattern for each 
drawing unit. There are a number of scaling options that can affect in line by follwings 
steps. 
 
 
Type LTS enter and type scale factor. 

 
 
 
 
 
 
 
 
 
 

 
 
 

· Circle and Circle Command 

A circle is a simple closed shape 

The figure formed by the group of points that are an equal distance from a point, or center. 

The angles of a circle add up to 360 degrees. 

 

i. Circumference: Length of circle is called circumference. 

ii. Radius: A straight line from the center to the circumference of a circle 

iii. Diameter: A straight line passing from side to side through the center of a body or 

figure, esp. a circle or sphere. 

iv. Chord: Any Straight Line which connects two points of circle is called chord, where 

as it does not pass from center of circle. 

v. Tangent: Any Straight Line which touches one point of circle is called Tangent. 

vi. Arc: Part of a circle between any two points is called arc. 

vii. Sector: Any area which is constructed by two Radiuses and an Arc is called Sector. 

viii. Segment: Any area which is constructed by chord and an arc is called segment. 
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Procedure: 

How to create circle 

 

 

 

 
 

 

 

 

 
Draw Manu 

Draw Toolbar Command Entry 

 
Circle 

 

Circle/C 

 
Step-1: Type C  

Circle in command Bar and Press Enter 

 

 
 

Step-2:  

Specify any Point for Centre I.e. 5, 5 and Press Enter 
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Step-3: 

Specify radius of Circle or Diameter: 5 and Press Enter. 

 

 

· Tan Tan Radius (TTR) 

Procedure 

How to create circle with TTR 

 

Step-1: Type C and press ENTER (You See: 3P/2P/TTr) 

Step-2: Type T for (Tan Tan Radius (TTR)) 

Step-3: Specify point on object for first tangent of circle: Click on the 

First Tangent Element (Where the circle will touch) 

Step-4: Specify point on object for second tangent of circle: Click on the Second 

Tangent Element (Where the circle will touch) 

Step-5: Specify radius of circle <0'-0>: 2 
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· 3-Points circle: 

 
Procedure:  

How to create circle with 3-P 

 
Step-1: Type C Command (see methods above) 

Step-2: 3P/2P/TTR/<Center point>: Type 3p and then press. 

Step-3: Specify first point on circle: Click on First Point. 

Step-4: Specify second point on circle: Click on second Point. 

Step-5: Specify third point on circle: Click on third Point 

`  

· 2-Points 

Procedure 

How to create circle with 3-P 

 
Type C Command (see methods above) 

Step-2: 3P/2P/TTR/<Center point>: Type 2P and then press. 

Step-3: Specify first end point of circle's diameter: Click on First Point 

Step-4: Specify second end point of circle's diameter: Click on second point 
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· Tan Tan Tan (TTT) 

Another sub command of Circle you can activate from the Draw Manu: 
Draw →circle→ TTT 
 

· Procedure 

How to create circle with TTT 

 

Step-1: Click on Draw Manu: Draw→ Circle→ TTT 

Step-2: 3p Specify first point on circle: _tan to. First Point 

Step-3: 3p Specify second point on circle: _tan to. Second Point 

Step-4: 3p Specify third point on circle: _tan to. Third Point 
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Arc is used to draw an arc between two lines from one point to the next. 

 

 
 

 

 

 
Procedure 

How to draw ARC  

· Command entry: arc 

Specify start point of arc or [Center]: Specify a point, enter c, or press ENTER to start 

tangent to last line, arc, or polyline 

To create an arc, you can specify combinations of center, endpoint, start point, radius, 

angle, chord length, and direction values. 

 

i. Start Point 
Specifies the starting point of the arc.  

Note: If you press ENTER without specifying a point, the endpoint of the last drawn 

line or arc is used and you are immediately prompted to specify the endpoint of the 

new arc. This creates an arc tangent to the last drawn line, arc, or polyline. 

Specify second point of arc or [Center /End]: 

 

ii. Second Point 
Draws an arc using three specified points on the arc's circumference. The first point is 

the start point (1). The third point is the endpoint (3). The second point (2) is a point 

on the circumference of the arc. 

Draw Manu Draw Toolbar Command Entry 

 
Arc 

 

 
Arc/A 

 
1.4.2.7. Arc Command: 
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Specify end point of arc: Specify a point (3) 

 
You can specify a three-point arc either clockwise or counter clockwise. 

iii. Center 

Specifies the center of the circle of which the arc is a part. 

Specify center point of arc: 

Specify end point of arc or [Angle/chord Length]: 

iv. End Point  

Using the center point (2), draws an arc counter clockwise from the start point (1) to 

an endpoint that falls on an imaginary ray drawn from the center point through the third 

point (3). 

 
The arc does not necessarily pass through this third point, as shown in the illustration. 

v. Angle  
Draws an arc counter clockwise from the start point (1) using a center point (2) with a 

specified included angle. If the angle is negative, a clockwise arc is drawn. 

Specify included angle: Specify an angle 

 

· Chord Length  

Draws either a minor or a major arc based on the distance of a straight line between the 

start point and endpoint.  

If the chord length is positive, the minor arc is drawn counter clockwise from the start point. 

If the chord length is negative, the major arc is drawn counter clockwise. 

Specify length of chord: Specify a length 
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· End 

Specifies the endpoint of the arc. 

Specify end point of arc: 

Specify center point of arc or [Angle/Direction/Radius]: 

 

· Center Point  

Draws an arc counter clockwise from the start point (1) to an endpoint that falls on an 

imaginary ray drawn from the center point (3) through the second point specified (2). 

 

 

· Angle  

Draws an arc counter clockwise from the start point (1) to an endpoint (2), with a specified 

included angle. If the angle is negative, a clockwise arc is drawn. 

Specify included angle: Enter an angle in degrees or specify an angle by moving the 

pointing device counter clockwise. 

 

 

· Direction  

Begins the arc tangent to a specified direction. It creates any arc, major or minor, clockwise 

or counter clockwise, beginning with the start point (1), and ending at an endpoint (2). The 

direction is determined from the start point. 

Specify tangent direction for the start point of arc: 

 

· Radius  

Draws the minor arc counter clockwise from the start point (1) to the endpoint (2). If the 

radius is negative, the major arc is drawn. Specify radius of arc: 

 

 
· Center 

Specifies the center of the circle of which the arc is a part. 

Specify center point of arc: 

Specify start point of arc: 

Specify end point of arc or [Angle/chord Length]: 

· End Point  

Draws an arc counter clockwise from the start point (2) to an endpoint that falls on an 

imaginary ray drawn from the center point (1) through a specified point (3). 
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· Angle  

Draws an arc counter clockwise from the start point (2) using a center point (1) with a 

specified included angle. If the angle is negative, a clockwise arc is drawn. 

Specify included angle: 

 

· Chord Length  

Draws either a minor or a major arc based on the distance of a straight line between the 

start point and endpoint. 

If the chord length is positive, the minor arc is drawn counter clockwise from the start point. 

If the chord length is negative, the major arc is drawn counter clockwise. 

Specify length of chord: 

 

 
 

· Tangent to Last Line, Arc, or Polyline 

Draws an arc tangent to the last line, arc, or polyline drawn when you press ENTER at the 

first prompt.  

 
Specify end point of arc: Specify a point (1) 

 

 

1.4.2.8. Rectangle 
Creates a rectangular poly line from the specified the rectangle parameters (length, 

width, rotation) and type of corners (fillet, chamfer, or square). 

There are basic three types of rectangle, area, dimension and rotation. 
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Draw Manu Draw Toolbar Command Entry 

     Rectangle 
 

rec 

 

· Procedure 

How to draw rectangular 

Click Home tab Draw panel Rectangle. Specify the first corner of the rectangle. 

Specify the other corner of the rectangle. 

OR 

Short key R Enter 

 

i. Area 
Creates a rectangle using the area and either a length or a width. If the Chamfer or 

Fillet option is active, the area includes the effect of the chamfers or fillets on the 

corners of the rectangle. 

 

 
 

ii. Dimensions 
Creates a rectangle using length and width values.  

 
 

iii. Rotation 
Creates a rectangle at a specified rotation angle. 

 
 

iv. Chamfer 
Sets the chamfer distances for the rectangle. 
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v. Elevation 

Specifies the elevation of the rectangle. 

vi. Fillet 
Specifies the fillet radius of the rectangle 

 
 
 

vii. Thickness 
Specifies the thickness of the rectangle. 

 
 
 

viii. Width 
Specifies the polyline width of the rectangle to be drawn. 

 
 

1.4.2.9. Polygon 
Polygons can be used to draw equilateral triangles, squares, pentagons, hexagons, 

and other multi-sided figures. 

The following illustrations show polygons created using three 

methods: inscribed, circumscribed, and edge. In each case, two points are specifies.  
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Draw Manu Draw Toolbar Command Entry 

Polygon  
POL 

 

 

 

 

 
 

Command: polygon 

Enter number of sides <current>: Enter a value between 3 and 1024 or press ENTER 

Specify center of polygon or [Edge]: Specify a point (1) or enter e 

 

Center of Polygon 

Defines the center of the polygon. 
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Enter an option [Inscribed in circle/Circumscribed about circle] <current>: Enter i or c 

or press ENTER 

Inscribed in Circle  

Specifies the radius of a circle on which all vertices of the polygon lie. 

Specify radius of circle: Specify a point (2) or enter a value 

 
Specifying the radius with your pointing device determines the rotation and size of the 

polygon. Specifying the radius with a value draws the bottom edge of the polygon at 

the current snap rotation angle. 

 

Circumscribed about Circle  

 

Specifies the distance from the center of the polygon to the midpoints of the edges of 

the polygon.  

Specify radius of circle: Specify a distance 

 
Specifying the radius with your pointing device determines the rotation and size of the 

polygon. Specifying the radius with a value draws the bottom edge of the polygon at 

the current snap rotation angle. 

 

1.4.2.10. Ellipse 

When you draw an ellipse, its shape is determined by two axes that define its length 

and width: the major (longer) axis and the minor (shorter) axis.  

 

 
 

Draw Manu Draw Toolbar Command Entry 

         Ellipse  
EL 
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· Axis Endpoint 

Defines the first axis by its two endpoints. The angle of the first axis determines the angle 

of the ellipse. The first axis can define either the major or the minor axis of the ellipse. 

· Distance to Another Axis 

Defines the second axis using the distance from the midpoint of the first axis to the 

endpoint of the second axis (3). 

 
 

· Rotation 

Creates the ellipse by appearing to rotate a circle about the first axis. 

Move the crosshairs around the center of the ellipse and click. If you enter a value, the 

higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circular 

ellipse. 

 
Procedure 

Command entry: ellipse 

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: Specify a point or enter an 

option 

The first two points of the ellipse determine the location and length of the first axis. The 

third point determines the distance between the center of the ellipse and the end point 

of the second axis. 
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· Axis Endpoint 

Defines the first axis by its two endpoints. The angle of the first axis determines the angle 

of the ellipse. The first axis can define either the major or the minor axis of the ellipse. 

Specify other endpoint of axis: Specify a point (2) 

Specify distance to other axis or [Rotation]: Specify a distance by entering a value or 

locating a point (3), or enter r 

· Distance to second Axis  

Defines the second axis using the distance from the midpoint of the first axis to the 

endpoint of the second axis (3). 

 

· Rotation  

Creates the ellipse by appearing to rotate a circle about the first axis.  

Specify rotation around major axis: Specify a point (3), or enter an positive angle value 

less than 90 

Move the crosshairs around the center of the ellipse and click. If you enter a value, the 

higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circular 

ellipse. 

 

· Arc 

Creates an elliptical arc.  

The first two points of the elliptical arc determine the location and length of the first axis. 

The third point determines the distance between the center of the elliptical arc and the 

endpoint of the second axis. The fourth and fifth points are the start and end angles. 

 

· Drawing elliptical arcs 
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To draw an elliptical arc using start and end angles 

i. Arc 
Creates an elliptical arc.  

The first two points of the elliptical arc determine the location and length of the first 

axis. The third point determines the distance between the center of the elliptical arc 

and the endpoint of the second axis. The fourth and fifth points are the start and end 

angles. 

 
The angle of the first axis determines the angle of the elliptical arc. The first axis can 

define either the major or the minor axis depending on its size. 

Specify axis endpoint of elliptical arc or [Center]: Specify a point or enter c 

ii. Axis Endpoint 
Defines the start point of the first axis. 

iii. Specify other endpoint of axis:  
Specify distance to other axis or [Rotation]: Specify a distance or enter r. The 

descriptions of the Distance to Other Axis and Rotation options match those of the 

corresponding options under Center. 

iv. Center 
Creates the elliptical arc using a center point you specify. 

Specify center of elliptical arc:  

Specify endpoint of axis:  

Specify distance to other axis or [Rotation]: Specify a distance or enter r 
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· Drawing isometric circle to draw isometric circles 

Draw the following as per directions of the teacher 

 

 
 

 

1.4.2.11. Hatch 

Fills an enclosed area or selected objects with a hatch pattern, solid fill, or gradient fill. 

In hatch apply different material as required and justify the scale 

 

Draw Manu Draw Toolbar Command Entry 

         Hatch  
H 

 

Command: hatch 

The Hatch and Gradient dialog box is displayed. If you enter -hatch at the Command 

prompt, options are displayed. 

 
Note: By default, the program will not create a hatch pattern that consists of over 

10,000 hatch segments. The limit is set by the MaxHatch setting in the registry. To 

reset the limit to 50,000, for example, enter (setenv "MaxHatch" "50000") at the 

Command prompt. The limit can be reset to any value between 100 and 10,000,000. 

You can choose from several methods to specify the boundaries of a hatch.  
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i. Specify a point in an area that is enclosed by objects.  
ii. Select objects that enclose an area.  
iii. Drag a hatch pattern into an enclosed area from a tool palette or Design Center. 

-  

1.4.2.12. Donut  
Creates a filled circle or a wide ring or Donut is special type of circle that describes 

inside outside circle in a same time. 

A donut consists of two arc polylines that are joined end-to-end to create a circular 

shape. The width of the polylines is determined by the specified inside and outside 

diameters. If you specify an inside diameter of 0, the donut is a filled circle. 

Draw Manu Draw Toolbar Command Entry 

    Donut 

 
DO 

Specifies the inside diameter of the donut as shown. 
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Command: donut 

A donut consists of two arc polylines that are joined end-to-end to create a circular 

shape. The width of the polylines is determined by the specified inside and outside 

diameters. To create solid-filled circles, specify an inside diameter of zero. 

 
Specify inside diameter of donut <current>: Specify a distance or press ENTER 

If you specify an inside diameter of 0, the donut is a filled circle. 

Specify outside diameter of donut <current>: Specify a distance or press ENTER 

Specify center of donut or <exit>: Specify a point (1) or press ENTER to end the 

command. 

 

The location of the donut is set based on the center point. After you specify the 

diameters, you are prompted for the locations at which to draw donuts. A donut is 

drawn at each point specified (2). How the interior of a donut is filled depends on the 

current setting of the FILL command. 

 
 
 
 
 

1.4.2.13. Block 

A block is simply a collection of objects (it could be one object) that has a name. Blocks 

have several advantages: 

i. You can insert them again and again, saving time. In fact, you can insert them into 

other drawings as well. 
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ii. A block uses less electronic space than individual objects, so your drawing file is 

smaller. 

iii. By updating a block’s definition, you can update all the blocks in the drawing. 

· How do you create a block? 

To create a block, follow these steps: 

 
i. Draw the objects that you want in the block. 
ii. Choose Home tab> Block panel> Create to start the BLOCK command. 

The Block Definition dialog box opens. 
iii. Type a name in the Name text box. The name can have spaces. 
iv. You need to specify a base point. That’s the point at which you’ll insert the block. In 

the Base Point section, click Pick Point. Be sure to use an object snap for accuracy! 
You’ll immediately be returned to the dialog box. 

v. In the Objects section, click the Select Objects button. Select the objects and press 
Enter to return to the dialog box. Tip: You can select the objects before using the 
command and they’ll show up in the dialog box. 

vi. Just below, choose Retain, Convert to Block, or Delete. These options control what 
happens after you create the block.  

vii. In the Behavior section, you can make a block Annotative (more info here), force it to 
scale uniformly and choose whether to allow exploding. 

viii. In the Settings area, choose the block unit. You can choose Unitless but if you 
choose a unit, AutoCAD will try to scale the block appropriately when you insert it 
into another drawing. You can also add a hyperlink if you want. 

ix. Finally, you can add a description in the Description box. A description is helpful in 
the Design Center, when you want to insert the block from another drawing. 

x. Click OK to complete the box. If you chose Delete, the objects disappear. You can 
use the OOPS command to bring them back. 
 

1.4.2.14. Point 

To set point style and size 

POINT Creates a point object. 

 

Draw Manu Draw Toolbar Command Entry 

      Point 

 
point 
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Command entry: point 

· Specify a point: 

Points can act as nodes to which you can snap objects. You can specify a full three-

dimensional location for a point. The current elevation is assumed if you omit the Z 

coordinate value. 

The PDMODE and PDSIZE system variables control the appearance of point objects. 

PDMODE values 0, 2, 3, and 4 specify a figure to draw through the point. A value of 1 

specifies that nothing is displayed.  

 

Specifying the value 32, 64, or 96 selects a shape to draw around the point, in addition 

to the figure drawn through it: 

 
 

PDSIZE controls the size of the point figures, except for PDMODE values 0 and 1. A 

setting of 0 generates the point at 5 percent of the drawing area height. A positive 

PDSIZE value specifies an absolute size for the point figures. A negative value is 

interpreted as a percentage of the viewport size. 

After you change PDMODE and PDSIZE, the appearance of existing points changes 

the next time the drawing is regenerated. 

You can use MEASURE and DIVIDE to create points along an object. Use DDPTYPE 

to specify point size and styles easily. 

 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 155 

   Module-2, (LU-1): Develop 2D Drawings 

 

i. To create a region by selecting objects 

ii. To create regions using boundaries 

iii. To create a composite region by subtraction 

iv. Create composite solids or regions from the intersection of two or more solids or 

regions and remove the areas outside of the intersection 

REGION Converts an object that encloses an area into a region object. 

Draw Manu Draw Toolbar Command Entry 

Region 

 REG 

 

Select objects: Use an object selection method and press ENTER when you finish 

Regions are two-dimensional areas you create from closed shapes or loops. Closed 

polylines, lines, and curves are valid selections. Curves include circular arcs, circles, 

elliptical arcs, ellipses, and splines.  

You can combine several regions into a single, complex region. 

 

Regions can be used for 

· Extracting design information 

· Applying hatching and shading 

· Combining simple objects into more complex ones with Boolean operations. 

 

 
Command: REG 

Select objects: Select Object and press enter 

Select objects: 1 found 

1 loop extracted. 

1 Region created. 

  

1.4.2.15. Regions 
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1.4.2.16. MEASURE 

 

Draw Manu Draw Toolbar Command Entry 

Point 

 ME 

 
Creates point objects or blocks at measured intervals along the length or perimeter of 

an object. 

 

Command entry: measure 

Select object to measure: 

Specify length of segment or [Block]: Specify a distance or enter b 

The resulting points or blocks are always located on the selected object and their 

orientation is parallel to the XY plane of the UCS. 

Use DDPTYPE to set the style and size of all point objects in a drawing. 

 

 
1.4.2.17. DIVIDE 

 

Draw Manu Draw Toolbar Command Entry 

   Point 

 DIV 

 
 

Creates evenly spaced point objects or blocks along the length or perimeter of an 

object. 

 
Access Methods 

Command entry: divide 

Select object to divide: Use an object selection method 

Enter number of segments or [Block]: Enter a value from 2 through 32,767, or enter b 

 

Number of Segments 

Places point objects at equal intervals along the selected objects. 

 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 157 

   Module-2, (LU-1): Develop 2D Drawings 

  
 

1.4.2.18. Table  

Creates an empty table object. 

 

Draw Manu Draw Toolbar Command Entry 

   Table  
Table 

 

A table is a compound object that contains data in rows and columns. It can be created 

from an empty table or a table style. A table can also be linked to data in a Microsoft 

Excel spreadsheet. 

 
Command: Table 

The following window will show in AutoCAD 

 

 
 

· Table Style 

Choose a table style from within the current drawing from which to create a table. You can 

create a new table style by clicking the button next to the drop-down list. 

 

· Insert Options 

Specifies the method for inserting your table. 

i. Start from Empty Table 
Creates an empty table that can be filled in with data manually. 

ii. Start from Data Link 
Creates a table from data in an external spreadsheet. 

iii. Start from Data Extraction (not available in AutoCAD LT) 
Launches the Data Extraction wizard. 
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· Preview 

Controls whether a preview display. If you start from an empty table, the preview displays 

an example of the table style. If you create a table link, the preview displays the resulting 

table. Clear this option to improve performance when working with large tables. 

 

· Insertion Behavior 

Specifies the location of the table. 

i. Specify Insertion Point 

Specifies the location of the upper-left corner of the table. You can use the pointing 

device or enter coordinate values at the Command prompt. If the table style sets the 

direction of the table to read from the bottom up, the insertion point is the lower-left 

corner of the table. 

ii. Specify Window 

Specifies a size and a location for the table. You can use the pointing device or 

enter coordinate values at the Command prompt. When this option is selected, the 

number of columns and rows and the column width and row height depend on the 

size of the window and the column and row settings. 

 

· Column & Row Settings 

Set the number and size of columns and rows 

i. Columns Icon 
Indicates columns. 

 

ii. Rows Icon 
Indicates rows. 

 

iii. Columns 
Specifies the number of columns. When the Specify Window option is selected and 

you specify a column width, the Auto option is selected, and the number of columns 

is controlled by the width of the table. If a table style containing a starting table has 

been specified, then you can choose the number of additional columns you would 

like added to that starting table. 

 

iv. Column Width 
Specifies the width of the columns. When the Specify Window option is selected and 

you specify the number of columns, the Auto option is selected, and the column 

width is controlled by the width of the table. The minimum column width is one 

character. 

 

v. Data Rows 
Specifies the number of rows. When the Specify Window option is selected and you 

specify a row height, the Auto option is selected, and the number of rows is 

controlled by the height of the table. A table style with a title row and a header row 

has a minimum of three rows. The minimum row height is one line. If a table style 

containing a starting table has been specified, then you can choose the number of 

additional data rows you would like added to that starting table. 

 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 159 

   Module-2, (LU-1): Develop 2D Drawings 

  
 

 

vi. Row Height 
Specifies the height of the rows in number of lines. The height of a line is based on 

the text height and the cell margin, which are both set in the table style. When the 

Specify Window, option is selected and you specify the number of rows, the Auto 

option is selected, and the row height is controlled by the height of the table. 

 

· Set Cell Styles 

For table styles that do not contain a starting table, specifies a cell style for rows in the new 

table. 

 

i. First Row Cell Style 

Specifies a cell style for the first row in the table. The Title cell style is used by 

default. 

ii. Second Row Cell Style 

Specifies a cell style for the second row in the table. The Header cell style is used by 

default. 

iii. All Other Row Cell Styles 

Specifies a cell style for all other rows in the table. The Data cell style is used by 

default. 

 

1.4.2.19. Text  

Creates a single-line text object. You can use single-line text to create one or more 

lines of text 

 

Draw Manu Draw Toolbar Command Entry 

    Text  
Text 

 

 
Command entry: text 

Current text style: <current> Current text height: <current> Annotative: <current> 

Specify start point of text or [Justify/Style]: Specify a point or enter an option 

 

You can use single-line text to create one or more lines of text, where each text line is 

an independent object that you can relocate, reformat, or otherwise modify. 

 

The TEXT command creates a single-line text object. It displays a simplified version 

of the In-Place Text Editor that consists of a bounding box that is the height of the text 

and expands as you type. Right-click to select options on the shortcut menu. 

 

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of 

Text prompt skips the prompts for paper height and rotation angle. The text that you 

enter in the In-Place Text Editor for single-line text is placed directly beneath the 

previous line of text. The point that you specified at the prompt is also stored as the 

insertion point of the text. 

 

If the DTEXTED system variable is set to 1, text created using TEXT or DTEXT 

displays the Edit Text dialog box.  
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If DTEXTED is set to 2, the In-Place Text Editor is displayed. When creating text, you 

can click anywhere in a drawing to create a new text block. You can also use the 

keyboard to move among text blocks (for example: for new text created using the TEXT 

command, you can navigate through text groups by pressing TAB or Shift + TAB, or 

edit a group of text lines by pressing ALT and clicking each text object.)  

Note: Text that would otherwise be difficult to read (if it is very small, very large, or is 

rotated) is displayed at a legible size and is oriented horizontally so that you can easily 

read and edit it. 

You can enter special characters and format text by entering Unicode strings and 

control codes.  

Use -TEXT to honor the TEXTEVAL system variable. 

DTEXT is the same as TEXT. 

 

· Start Point 

Specifies a start point for the text object. 

Specify height <current>: Specify a point (1), enter a value, or press ENTER 

The Specify Height prompt is displayed only if the current text style is not annotative and 

does not have a fixed height. 

Specify paper text height <current>: Specify a height, or press ENTER 

The Specify Paper Text Height prompt is displayed only if the current text style is 

annotative. 

Specify rotation angle of text <current>: Specify an angle or press ENTER 

Enter text in the In-Place Text Editor for single-line text.  

 

· Justify 

Controls justification of the text. 

Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML /MC/MR/BL/BC/BR]: 

You can also enter any of these options at the Specify Start Point of Text prompt. 

· Align  

Specifies both text height and text orientation by designating the endpoints of the baseline.  

Specify first endpoint of text baseline: Specify a point (1) 

Specify second endpoint of text baseline: Specify a point (2) 

Enter text in the In-Place Text Editor for single-line text.  

The size of the characters adjusts in proportion to their height. The longer the text string, 

the shorter the characters. 

 

· Fit  

Specifies that text fits within an area and at an orientation defined with two points and a 

height. Available for horizontally oriented text only. 
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Specify first endpoint of text baseline: Specify a point (1) 

Specify second endpoint of text baseline: Specify a point (2) 

Specify height <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 

The height is the distance in drawing units that the uppercase letters extend from the 

baseline. Designated text height is the distance between the start point and a point you 

specify. The longer the text string, the narrower the characters. The height of the 

characters remains constant. 

· Center  

Aligns text from the horizontal center of the baseline, which you specify with a point. 

Specify center point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

The rotation angle specifies the orientation of the text baseline with respect to the center 

point. You can designate the angle by specifying a point. The text baseline runs from the 

start point toward the specified point. If you specify a point to the left of the center point, 

the text is drawn upside down. 

 

· Middle  

Aligns text at the horizontal center of the baseline and the vertical center of the height you 

specify. Middle-aligned text does not rest on the baseline. 

Specify middle point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

The Middle option differs from the MC option in that it uses the midpoint of all text, including 

descenders. The MC option uses the midpoint of the height of uppercase letters.  

 

· Right  

Right-justifies the text at the baseline, which you specify with a point. 

Specify right endpoint of text baseline: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  
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· TL (Top Left)  

Left-justifies text at a point specified for the top of the text. Available for horizontally 

oriented text only. 

Specify top-left point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 
 

· TC (Top Center)  

Centers text at a point specified for the top of the text. Available for horizontally oriented 

text only. 

Specify top-center point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 
 

· TR (Top Right)  

Right-justifies text at a point specified for the top of the text. Available for horizontally 

oriented text only. 

Specify top-right point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 
 

· ML (Middle Left)  

Left-justifies text at a point specified for the middle of the text. Available for horizontally 

oriented text only. 

Specify middle-left point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 

· MC (Middle Center)  

Centers the text both horizontally and vertically at the middle of the text. Available for 

horizontally oriented text only. 

Specify middle-center point of text: Specify a point (1) 

Specify height of text <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  
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The MC option differs from the Middle option in that it uses the midpoint of the height of 

uppercase letters. The Middle option uses the midpoint of all text, including descenders. 

 
 

· MR (Middle Right)  

Right-justifies text at a point specified for the middle of the text. Available for horizontally 

oriented text only. 

Specify middle-right point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 
 

· BL (Bottom Left)  

Left-justifies text at a point specified for the baseline. Available for horizontally oriented 

text only. 

Specify bottom-left point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 

· BC (Bottom Center)  

Centers text at a point specified for the baseline. Available for horizontally oriented text 

only. 

Specify bottom-center point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

 
· BR (Bottom Right)  

Right-justifies text at a point specified for the baseline. Available for horizontally oriented 

text only. 

Specify bottom-right point of text: Specify a point (1) 

Specify height <current>: 

Specify rotation angle of text <current>: 

Enter text in the In-Place Text Editor for single-line text.  

· Style 

Specifies the text style, which determines the appearance of the text characters. Text you 

create uses the current text style. 

Enter style name or [?] <current>: Enter a text style name or enter ? to list all text styles 

Entering ? lists the current text styles, associated font files, height, and other parameters. 
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1.4.2.20. MULTI TEXT 

Creates a multiline text object. 

 
 

Draw Manu Draw Toolbar Command Entry 

   Text  
MULTITEXT 

 

Command entry: mtext 

Current text style: <current> Text height: <current> Annotative: <current> 

Specify first corner:  

Specify opposite corner or [Height/Justify/Linespacing/Rotation/Style/Width/Columns]: 

You can create several paragraphs of text as a single multiline text (mtext) object. With 

the built-in editor, you can format the text appearance, columns, and boundaries. 

After you specify the point for the opposite corner when the ribbon is active, the MTEXT 

ribbon contextual tab displays. If the ribbon is not active, the in-place text editor is 

displayed.  

If you specify one of the other options, or if you enter -mtext at the Command prompt, 

MTEXT bypasses the In-Place Text editor and displays additional command prompts. 

 

1.4.2.21. Helixes 

A helix is an open 2D or 3D spiral. 

 

Draw Manu Draw Toolbar Command Entry 

Helixes N/A 
Helixes 

 
 

You can use a helix as a path along which to sweep an object to create an image. For 

example, you might sweep a circle along a helix path to create a solid model of a 

spring. 

When you create a helix, you can specify the following: 

 

· Base radius 

· Top radius 

· Height 

· Number of turns 

· Turn height 

· Twist direction  
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If you specify the same value for both the base radius and the top radius, then a 

cylindrical helix is created. By default, the top radius is set to the same value as the 

base radius. You cannot specify 0 for both the base radius and top radius. 

If you specify different values for the top radius and the base radius, then a 

conical helix is created. 

If you specify a height value of 0, then a flat, 2D spiral is created. 

i. Click Home tab →Draw panel →Helix.  
ii. Specify the center point for the base of the helix. 
iii. Specify the base radius. 
iv. Specify the top radius or press Enter to specify the same value as the base radius. 
v. Specify the height of the helix. 

 
 

1.4.2.22. GRADIENT 

 
Fills an enclosed area or selected objects with a gradient fill. 
 

Draw Manu Draw Toolbar Command Entry 

 
GRADIENT 

   
GRADIENT 
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1.4.3.   Modify Toolbar 

This Modification in 2D drawing and let the leaner to know the manipulation of an object as 

desire. After completion of this toolbar you will be able to manipulate erase, delete, and Zoom 

objects. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1.4.3.1. Erase Command 
 

ERASE Command: Erase command is used to removes objects from a drawing.  

 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modify Manu Modify Toolbar Command Entry 

 
Erase  

Erase/E 

 
 

1 Erase 10 Trim 

2 Copy 11 Extend 

3 Mirror 12 Break at point 

4 Offset 13 Break 

5 Array 14 Join 

6 Move 15 Chamfer 

7 Rotate 16 Fillet 

8 Scale 17 Blend curves 

9 Stretch 18 Explode 
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· Procedure 

 
How to Erase an Object 

Step-1: Type Erase/E in command bar and Press Enter 

Step-2: Select Object and Press Enter 

The Selected Object should be Erase/Delete. 

1.4.3.2. Copy command 

Copies objects a specified distance in a specified direction or duplication of objects. 

 

 
 

Modify Manu Modify Toolbar Command Entry 

Copy  
C or CP 

 

The following prompts are displayed 

 

i. Select objects: Use an object selection method and press Enter when you finish 

ii. Specify base point or [Displacement/mode/Multiple] <Displacement>: Specify a base 

point or enter an option 

iii. Specify second point or [Array] <use first point as displacement>: Specify a second 

point or enter an option 

· Displacement 

 
Specifies a relative distance and direction using coordinates or distance 

 

Mode 

Controls whether the command repeats automatically (COPYMODE system variable). 

 

i. Single 
Creates a single copy of selected objects and ends the command. 

Do You Know! 

Alternate Method 

Select the object/s 

and Press Delete 

button 
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ii. Multiple 

Overrides the Single mode setting. The COPY command is set to repeat automatically 

for the duration of the command. 

1.4.3.3. Mirror command 
Creates a mirrored copy of selected objects 

 

 

Modify Manu Modify Toolbar Command Entry 

Mirror  
          Mi 

 

You can create objects that represent half of a drawing, select them, and mirror them across 

a specified line to create the other half. 

 

· Creates a mirrored copy of selected objects. 

Modify menu bar   ® Mirror  ® select image ® 

specify the first point of mirror line ® specify the 

second point of mirror line 

Or  

short Key 

Mi  ® Enter   
 

Command entry: mirror 

i. Select objects:  
Use an object selection method and press Enter to finish 

Specify first point of mirror line: Specify a point 

Specify second point of mirror line: Specify a point 

 

 
 

The two specified points become the endpoints of a line about which the selected 

objects are mirrored. For mirroring in 3D, this line defines a mirroring plane 

perpendicular to the XY plane of the user coordinate system (UCS) containing the 

mirror line. 

Erase source objects? [Yes/No] <N>: Enter y or n, or press Enter 

ii. Yes  

Places the mirrored image into the drawing and erases the original objects. 

iii. No  

Places the mirrored image into the drawing and retains the original objects. 
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Note: By default, when you mirror a text object, the direction of the text is not 

changed. Set the MIRRTEXT system variable to 1 if you do want the text to be 

reversed.  

 

 

 

From the library insert the followings and practice for copy, mirror commands. 

Create symbols of the followings. 

 

1.4.3.4. Offset command 

Creates a mirrored copy of selected objects  

 

Modify Manu Modify Toolbar Command Entry 

Offset  
         O 

 

You can offset an object at a specified distance or through a point. After you offset 

objects, you can trim and extend them as an efficient method to create drawings 

containing many parallel lines and curves. 

Command: OFFSET enter 

Specify offset diatance: 10 enter 

Secify object to offset: click / select by window 

Specify the point on side to offset: click 

 

i. Offset Distance 
Creates an object at a specified distance from an existing object. 
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Enters the Multiple offset mode, which repeats the offset operation using the current 

offset distance. 

 
 
 

iii. Through  
Creates an object passing through a specified point 

 

iv. Layer 
Determines whether offset objects are created on the current layer or on the layer of 

the source object 

 
1.4.3.5. Array 

Creates copies of objects arranged in a pattern. You can create copies of objects in a 

regularly spaced rectangular, polar array. 

 

Modify Manu Modify Toolbar Command Entry 

Array  
         AR 

 

The following prompts are displayed. 
Select objects 
Specifies the object to be arrayed. 

 
 

ii. Multiple 
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Distributes copies of the selected object into any combination of rows, columns, and 

levels (same as the ARRAYRECT command). 

 
 
Command: Array 

Enter Type of Array: rectangle then enter 

Select object by window / click 

Type number of Rows: 4 then enter 

Type number of columns: 4 then enter 

Row offset: 7 then enter 

Column offset: 7 then 

Angle of Array: 0 then enter 

 

 
 
 

 
i. Rectangular 
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Evenly distributes copies of the object in a circular pattern around a center point or 

axis of rotation (same as the ARRAYPOLAR command). 

 
 

 

Command: Array 

Enter Type of Array: Polar array then enter 

Select object by window / click 

Specify the center point from object then enter 

Type number of items: 10 then enter 

Type the angle: 360o then enter 

 

 
 

 

i. Polar 
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1.4.3.6. Move 

Moves objects a specified distance in a specified direction 

 

Modify Manu Modify Toolbar Command Entry 

Move 

 
M 

 

Use coordinates, grid snaps, object snaps, and other tools to move objects with 

precision. 

 
The following prompts are displayed. 

Select objects 

Specifies the object to be MOVE. 

i. Base point 
Specifies the start point for the move. 

 
ii. Second point 

In combination with the first point, specifies a vector that indicates how far, and in what 

direction, the selected objects are moved. 

If you press Enter to accept the Use first point as displacement value, the first point is 

interpreted as a relative X, Y, Z displacement. For example, if you specify 2,3 for the 

base point and press Enter at the next prompt, the objects move 2 units in 

the X direction and 3 units in the Y direction from their current position. 

 
iii. Displacement 

Specify the displacement or distance object. 

 
 

1.4.3.7. Rotate 

Rotates objects around a base point. You can rotate selected objects around a base 

point to an absolute angle 

 

Modify Manu Modify Toolbar Command Entry 

Rotate  
M 
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The following prompts are displayed. 

Select objects 

Specifies the object to be rotate 

i. Select objects 
Use an object selection method and press Enter when you finish. 

ii. Specify base point 
Specify a point. 

iii. Specify rotation angle 
Enter an angle, specify a point, enter c , or enter r. 

iv. Rotation Angle. 
Determines how far an object rotates around the base point. The axis of rotation 

passes through the specified base point and is parallel to the Z axis of the current 

UCS. 

Copy. 

Creates a copy of the selected objects for rotation. 

Reference. 

Rotates objects from a specified angle to a new, absolute angle. When you rotate a 

viewport object, the borders of the viewport remain parallel to the edges of the drawing 

area. 

 

1.4.3.8. Scale 

Enlarges or reduces selected objects, keeping the proportions of the object the same 

after scaling. 

Modify Manu Modify Toolbar Command Entry 

Scale  
SC 
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The following prompts are displayed. 

Select objects 

Specifies the object to scale 

i. Select objects 
Specifies which objects you want to resize. 

ii. Base point 
Specify a base point for the scale operation. The base point you specify identifies the 

point that remains in the same location as the selected objects change size (and thus 

move away from the stationary base point). 

iii. Scale Factor 
Multiplies the dimensions of the selected objects by the specified scale. A scale factor 

greater than 1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects. 

You can also drag the cursor to make the object larger or smaller. 

iv. Copy 
Creates a copy of the selected objects for scaling. 

v. Reference 
Scales the selected objects based on a reference length and a specified new length. 
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1.4.3.9. Stretch 
Stretches objects crossed by a selection window or polygon. Objects that are partially 

enclosed by a crossing window are stretched. Objects that are completely enclosed 

within the crossing window, or that are selected individually, are moved rather than 

stretched. Some types of objects such as circles, ellipses, and blocks, cannot be 

stretched. 

 

Modify Manu Modify Toolbar Command Entry 

Stretch 
  

S 

 

The following prompts are displayed. 

Select objects 

Specifies the object to stretch 

i. Select objects 
Specifies the portion of the object that you want to stretch. Use. Press Enter when the 

selection is complete  

 
 

ii. Displacement 
Specifies the relative distance and direction of the stretch. 
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1.4.3.10. Trim 
Trims objects to meet the edges of other objects 

Modify Manu Modify Toolbar Command Entry 

Trim 
 

 
TR 

 

To trim objects, select the boundaries. Then press Enter and select the objects that 

you want to trim. To use all objects as boundaries, press Enter at the first Select 

Objects prompt. 
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1.4.3.11. Extend 
Extends objects to meet the edges of other objects. 

Modify Manu Modify Toolbar Command Entry 

Extend 
 

 
EX 

 

To trim objects, select the boundaries. Then press Enter and select the objects that 

you want to trim. To use all objects as boundaries, press Enter at the first Select 

Objects prompt. 

 

 

 

Current settings: Projection = current, Edge = current 

Select boundary edges... 

Select objects or <select all>: Select one or more objects and press Enter, or press 

Enter to select all displayed objects 

Select object to extend or shift-select to trim or [Fence/Crossing/Project/Edge/Undo]: 

Select objects to extend, or hold down SHIFT and select an object to trim, or enter an 

option 

· Boundary Object Selection 

Uses the selected objects to define the boundary edges to which you want to extend an 

object. 

 

· Object to Extend 

Specifies the objects to extend. Press Enter to end the command. 

 

· Shift-Select to Trim 

Trims the selected objects to the nearest boundary rather than extending them. This is an 

easy method to switch between trimming and extending. 

 

· Fence 

Selects all objects that cross the selection fence. The selection fence is a series of 

temporary line segments that you specify with two or more fence points. The selection 

fence does not form a closed loop. 

Specify first fence point: Specify the starting point of the selection fence 

Specify next fence point or [Undo]: Specify the next point of the selection fence or enter 

“u” 
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Specify next fence point or [Undo]: Specify the next point of the selection fence enter 

“u”, or press Enter 

 

· Crossing 

Selects objects within and crossing a rectangular area defined by two points. 

Specify first corner: Specify a point 

Specify opposite corner: Specify a point at a diagonal from the first point 

 

Note: Some crossing selections of objects to be extended are ambiguous. EXTEND 

resolves the selection by following along the rectangular crossing window in a clockwise 

direction from the first point to the first object encountered. 

 

· Project 

Specifies the projection method used when extending objects. 

Enter a projection option [None/Ucs/View] <current>: Enter an option or press Enter 

 

· None  

Specifies no projection. Only objects that intersect with the boundary edge in 3D space 

are extended. 

 

· UCS  

Specifies projection onto the XY plane of the current user coordinate system (UCS). 

Objects that do not intersect with the boundary objects in 3D space are extended. 

 

· View  

Specifies projection along the current view direction. 
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· Edge 

Extends the object to another object's implied edge, or only to an object that actually 

intersects it in 3D space. 

 

Enter an implied edge extension mode [Extend/No extend] <current>: Enter an option or 

press Enter 

· Extend  

Extends the boundary object along its natural path to intersect another object or its implied 

edge in 3D space. 

 

· No Extend  

Specifies that the object is to extend only to a boundary object that actually intersects it in 

3D space. 

 

· Undo 

Reverses the most recent changes made by EXTEND. 

 

 

1.4.3.12. Break 

Breaks the selected object between two points 

 

Modify Manu Modify Toolbar Command Entry 

      Break 
 

 
BR 

 

You can create a gap between two specified points on an object, breaking it into two 

objects. If the points are off of an object, they are automatically projected on to the 

object. BREAK is often used to create space for a block or text. 
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Select object: Use an object selection method, or specify the first break point (1) on 

an object. The prompts that are displayed next depend on how you select the object. 

If you select the object by using your pointing device, the program both selects the 

object and treats the selection point as the first break point. At the next prompt you 

can continue by specifying the second point or overriding the first point. 

Specify second break point or [First point]: Specify the second break point (2) or enter 

“ f ” 

i. Second Break Point  
Specifies the second point to use to break the object. 

ii. First Point  
Overrides the original first point with the new point that you specify. 

Specify first break point: 

Specify second break point: 

 
 

1.4.3.13. Join 

Joins the endpoints of linear and curved objects to create a single object. 

 

Modify Manu Modify Toolbar Command Entry 

   Join 
 

 
J 

 

Combines a series of finite linear and open curved objects at their common endpoints 

to create a single 2D or 3D object. The type of object that results depends on the types 

of objects selected, the type of object selected first, and whether the objects are 

coplanar. 
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1.4.3.14. Chamfer 

Bevels the edges of objects 

 

Modify Manu Modify Toolbar Command Entry 

    Chamfer 
  

CHA 

 

The distances and angles that you specify are applied in the order that you select the 

objects. 

 

The following prompts are displayed. 

Select objects 

Specifies the object to chamfer 

 

· Polyline 

Chamfers an entire 2D polyline. The intersecting polyline segments are chamfered at each 

vertex of the polyline. Chamfers become new segments of the polyline. If the polyline 

includes segments that are too short to accommodate the chamfer distance, those 

segments are not chamfered. 

 
· Distance 

Sets the distance of the chamfer from the endpoint of the selected edge. 

If you set both distances to zero, CHAMFER extends or trims the two lines so they end at 

the same point. 

 

 
· Angle 

Sets the chamfer distances using a chamfer distance for the first line and an angle for the 

second line. 
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1.4.3.15.  lengthen 

Changes the length of objects and the included angle of arcs. 

 

Modify Manu Modify Toolbar Command Entry 

lengthen  

 
Len 

You can specify changes as a percentage, an increment, or as a final length or angle. 

LENGTHEN is an alternative to using TRIM or EXTEND. 

 
 

Select an object or [DElta/Percent/Total/DYnamic]: Select one object or enter an 

option 

 

· Object Selection 

Displays the length and, where applicable, the included angle of the object. 

LENGTHEN does not affect closed objects. The extrusion direction of the selected object 

need not be parallel to the Z axis of the current user coordinate system (UCS). 

Current length: <current>, included angle: <current> 

Select an object or [DElta/Percent/Total/DYnamic]: Select one object, enter an option, or 

press ENTER to end the command 

· Delta 

Changes the length of an object by a specified increment, measured from the endpoint 

that is closest to the selection point. Delta also changes the angle of an arc by a specified 

increment, measured from the endpoint that is closest to the selection point. A positive 

value extends the object; a negative value trims it.  

Enter delta length or [Angle] <current>: Specify a distance, enter a, or press ENTER 

· Delta Length 

Changes the length of the object by the specified increment. 

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 
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· Angle 

Changes the included angle of the selected arc by the specified angle. 

Enter delta angle <current>: Specify an angle or press ENTER 

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 

 

 
 

· Percent 

Sets the length of an object by a specified percentage of its total length.  

Enter percentage length <current>: Enter a positive nonzero value or press ENTER 

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 

· Total 

Sets the length of a selected object by specifying the total absolute length from the fixed 

endpoint. Total also sets the included angle of a selected arc by a specified total angle.  

Specify total length or [Angle] <current>: Specify a distance, enter a positive nonzero 

value, enter a, or press ENTER 

 

 
 

· Total Length 

Lengthens the object to the specified value from the endpoint that is closest to the selection 

point.  

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 

· Angle 

Sets the included angle of the selected arc. 

Specify total angle <current>: Specify an angle or press ENTER 

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 185 

   Module-2, (LU-1): Develop 2D Drawings 

 

 
 

· Dynamic  

Turns on Dynamic Dragging mode. You change the length of a selected object by dragging 

one of its endpoints. The other end remains fixed. 

Select an object to change or [Undo]: Select one object or enter u 

The prompt repeats until you press ENTER to end the command. 

 

1.4.3.16. Fillet 

Rounds and fillets the edges of objects 

 

Modify Manu Modify Toolbar Command Entry 

    Fillet 
 

 
Fillet 

 

 
Command: FILLET 

Current settings: Mode = TRIM, Radius = 0'-0" 

Select first object or [Undo/Polyline/Radius/Trim/Multiple]  

Undo:  To undo the last action 

Polyline:  To work with polyline filleting 

Radius: Specify fillet radius 

Trim:  Enter Trim mode option 

Multiple:  To multiple set of objects 

 
 

1.4.3.17. Explode 

Breaks a compound object into its component objects 

 

Modify Manu Modify Toolbar Command Entry 

    Explode 
 

 
X 
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Explodes a compound object when you want to modify its components separately. 

Objects that can be exploded include blocks, polylines, and regions, among others. 

 
 

The color, line type, and line weight of any exploded object might change. Other results 

differ depending on the type of compound object you're exploding. See the following 

list of objects that can be exploded and the results for each. 

To explode objects and change their properties at the same time, use XPLODE. 

Note: If you're using a script or an Object ARX® function, you can explode only one 

object at a time. 

· 2D and Lightweight Polyline  

Discards any associated width or tangent information. For wide polylines, the resulting 

lines and arcs are placed along the center of the polyline. 

· 3D Polyline  

Explodes into line segments. Any line type assigned to the 3D polyline is applied to each 

resulting line segment. 

 

· 3D Solid  

Explodes planar faces into regions. Nonplanar faces explode into surfaces. 

 

· Annotative Objects  

Explodes the current scale representation into its constituent parts which are no longer 

annotative. Other scale representations are removed. 

 

· Arc  

If within a nonuniformly scaled block, explodes into elliptical arcs. 

 

· Block  

Removes one grouping level at a time. If a block contains a polyline or a nested block, 

exploding the block exposes the polyline or nested block object, which must then be 

exploded to expose its individual objects. 

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with 

unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected 

objects. 

When nonuniformly scaled blocks contain objects that cannot be exploded, they are 

collected into an anonymous block (named with a “*E” prefix) and referenced with the 

nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block 

reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly 

scaled block cannot be exploded. 

Exploding a block that contains attributes deletes the attribute values and redisplays the 

attribute definitions. 
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Blocks inserted with MINSERT and external references (xrefs) and their dependent blocks 

cannot be exploded.  

 

· Body  

Explodes into a single-surface body (nonplanar surfaces), regions, or curves. 

 

· Circle  

If within a nonuniformly scaled block, explodes into ellipses. 

 

· Leaders  

Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation 

blocks), multiline text, or tolerance objects, depending on the leader. 

 

· Mesh Objects  

Explodes each face into a separate 3D face object. Color and materials assignments are 

retained. 

 

· Multiline Text  

Explodes into text objects. 

 

· Multiline  

Explodes into lines and arcs. 

 

· Polyface Mesh  

Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. 

Three-vertex meshes explode into 3D faces. 

· Region  

Explodes into lines, arcs, or splines. 
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1.4.4.   Dimension Toolbar 

 

Dimension Menu Dimension Toolbar Command Entry 

Quick Dimension 
 

QDIM 

Linear Dimension  
DLI 

Radius Dimension  
DRA 

Angular Dimension  
DAN 

Arc Dimension  
DIMARC 

Diameter Dimension  
DDI 

Jojjed Dimension  
JOG 

Ordinate Dimensions 
 

 
DOR 

Continue Dimension  
DCO 

Base Line Dimension  
DBA 

Associate Dimension   
DRE 
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Practice =1 

Create 2D ‘House Plan’ in AutoCAD having dimensions of the plan given below with the following 

requirements. 

i. Three Bed Rooms, including two bed room with attached baths 

ii. One kitchen 

iii. TV Lounge (As per space)  

iv. Car Porch (Terrace) 

v. Proper Ventilation 

vi. Space Utilization 

 

Step 1: Draw rectangle equal to house plan as above 

 

   Edit 2D Object to meet set standards 
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Step 2: Apply Offset 

 

 
 
 

Step 3: Trim extra edges 

 

 
 
 
  



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 191 

   Module-2, (LU-1): Develop 2D Drawings 

  
 

Step 4: Apply Trim, Extend, and Erase command for doors 

 

 
 
 

Step 5:  Apply Circle Command for doors  
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Step 6:  Apply Offset command for windows and trim the extra lines.  

   Change the line thickness of walls at the locations of windows. 

 

 
 

Step 7: Draw Stairs by using offset and trim command 

 

 
 
 

Step 8:  taking Dimension by using linear dimension commands 
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Step 9: Write text by using Text command 
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Practice-2  

Part-a 

Prepare the following object with its defined dimension. 
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Step 1: 

i. Open the template acadiso.dwt. 

ii. Perform drafting settings i.e. format units to decimal with accuracy of 01 mm. create 3 text styles 

using arial fonts of text height 10 mm, 15 mm & 20 mm. Load line centre line and create layers 

i.e. Object, centre line, text, dimension. 

iii. Draw a line 340 mm long horizontally taking its origin point at 50, 120 and a line 180 mm long 

vertically up from the same coordinates. 

iv. Now take off sets for vertical line to the right and for horizontal line to the upside as shown in the 

following figure step one: 

 
 

Step 2: 

i. Take offsets of vertical centre line on both sides for the distances as 10 mm, 30 mm, 40 mm & 70 
mm as shown in the figure below Step-2.. 
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Step 3: 

i. Draw a circle of radius 20 mm at top of centre line. Take an offset of 20 mm to downward of 
second line from bottom. Take off sets on both side of top horizontal line to create knob. Then 
trim the lines as per figure given below STEP-3. 

 

Step:4 

i. Draw inclined lines from centre of circle and trim the lines as given in figure Step-4 
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Step:5 

i. Take the offsets to upward and downward of the bottom line for a distance of 30 mm and 40 mm. 

ii. Take the offset to downwards for a distance of 130 mm 

iii.  Further take offset for a distance of 20 mm of this created line (line through offset command).  

iv. Extend the vertical lines upto the bottom line 

v. Trim accordingly as shown in the figure below Step-5. 

 
 
 

 

Step: 6 

i. Create fillets. 

ii. Firstly, set the radius of 50 mm in the fillet command. 

iii. Create the fillet of this radius i.e. 50 mm to both sides of the body of knob. 

iv. Set the radius of 80 mm in the fillet command. 

v. Create the fillet of this radius i.e. 80 mm to the body to create bend to downwards. 

vi. Set the radius of 20 mm in the fillet command. 

vii. Create the fillet of this radius i.e. 20 mm to both the sides of threaded body to reduce the size of 

body. 

viii. Create a circle of radius of 20 mm at bottom of centre line drawn vertically as shown in figure 

Step-6.  
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Step:7 

i. Trim the circle to from upper side. 
ii. Trim the horizontal body line passing through circle. 
iii. Set the radius of 20 mm in the fillet command. 
iv. Create the fillet of this radius i.e. 20 mm to both the sides of this semicircle obtained after trimming. 
v. Also create fillet for exit bend of tap. 
vi. Trim the horizontal and vertical extra lines to have the final shape of drawing. 
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Step:8 

i. Using offset command for a distance of 30 mm create remaining portion of centre line. 
ii. Convert both the centre lines i.e. vertical and body centre lines from continuous to the symbol of 

centre line. 
iii. Format the dimension styles for 10 mm text height. 
iv. Draw linear dimensions individual and continuous dimensions for both the horizontal and vertical 

sides. 
v.  Draw radius dimensions for all fillets (arcs). 
vi. The drawing will look exactly as shown in the figure Step-8 shown below. 
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Practice-2  

Part-b 
Prepare the following object with its defined dimension. 
 

 
 

Step 1: 
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i. Open the template acad.dwt. 
ii. Perform drafting settings i.e. format units to decimal with accuracy of0.000 inches. 
iii. Create 3 text styles using arial fonts of text height 0.10-inch, 0.15 inch, & 0.2 inch. 
iv. Create dimension styles for text height 0.1 inches with text suffix “, and 0.15 inches without suffix 
v. Load line centre line and create layers i.e. Object 0.2 mm thick, centre line, text, dimension. 
vi. Draw a line AE 5.804-inch-long horizontally taking its origin point coordinates 3, 5 inches. 
vii. Draw a line 1.875-inch-long vertically up from the same coordinates. 
viii. Now take off sets for vertical line to the right and for horizontal line to the upside as shown in the 

following figure step one: 
ix. Draw a line DF 2.312 inch at an angle of inclination of 40 degrees from point  

 

Step 2: 

i. Draw circles of radius 0.4375 inch at points A, E, & F. 
ii. Draw a circle of diameter 1.125 inch at point D. 
iii. Draw a circle of diameter 0.75 inch at point D. 
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Step 3: 

i. Take the offset of 0.3125-inch to outside for circle at point A and D. 
ii. Take the offset of 0.3125-inch to outside for circle at point D. 
iii. Take the offset of 0.4375-inch to outside for circle at point E. 
iv. Take the offset of 0.4375-inch to outside for circle at point F. 
v. Take the offset of 0.4375-inch to outside for circle at point G. 

 

 
Step 4: 

i. Draw an arc starting from point E and ending at point F with centre at point D. 
ii. Take the offset of this arc for a distance of 0.4375 to inside. 
iii. Take the offset of this arc for a distance of 0.4375 on outside. 
iv. Take the offset of this arc for a distance of 0.4375 on outside. 
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Step 5: 

i. Trim the inner circles on inner side at point E taking cutting edges of the arc meeting at its 
periphery. 

ii. Trim the inner circles on inner side at point F taking cutting edges of the arc meeting at its 
periphery. 

iii. Draw a line vertically at point A touching the circumference of outer circle. 
iv. Trim the right side of both circles at point A taking cutting edges of this vertical line. 
v. Draw lines of length= 1 inch to right side of these semicircles at point A. 

 

 
Step 6: 

i. Take the offset of 0.4375-inch to outside for bigger circle at point D. 
ii. Draw a circle of radius 0.625 with the TTR (tangent, tangent, radius command) having tangents the 

outer circle at point D and outer circle at point E. 
iii. Draw a circle of radius 0.625 with the TTR (tangent, tangent, radius command) having tangents the 

outer circle at point F and outer circle at point G. 
iv. Take the mirror of semi-circles at point A to right side having mid-point of 1 inch long lines as mirror 

axis. 
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Step 7: 

i. Draw a circle of radius 1.75 inches with the TTR (tangent, tangent, radius command) having tangents 

the outer circle at point G and top side horizontal line at point A. 

ii. Draw a line starting from bottom quadrant point of outer circle at point A and becoming a tangent to 

the outer circle at point D. 

 

 

Step 8: 

i. Trim the outer side of circle drawn by TTR command near point D and point E taking circumference 

of outer circle at point D and circumference of outer circle at point E. 

ii. Trim the outer side of circle drawn by TTR command near point F and point G taking circumference 

of outer circle at point F and circumference of outer circle at point G. 

iii. Trim the inner side of outer circle at point D taking cutting edges of inclined line & trimmed circle 

near point D & point E. 

iv. Trim the inner side of outer circle at point E taking cutting edges of trimmed circle near point D & 

point E & outer arc at point E & point F. 

v. Trim the inner side of outer circle at point F taking cutting edges of trimmed circle near point F & 

point G & outer arc at point E & point F. 

vi. Trim the outer side of circle drawn by TTR command near point G and point A taking circumference 

of outer circle at point G and top horizontal line at point A. 
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Step 9: 

i. Use 10 mm dimension style to dimension the lengths, radii and diameters of elements. 

ii. Adjust the position of dimensions. 

iii. Set the thickness of object lines. 

iv. Assign the symbols to centre lines. 
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Learning Unit 2:  

Prepare final set of 2D the Drawings. 
 
 

 

After completion of this Learning Unit you will be able to: 
 

v Use appropriate commands and tools to develop 2D drawing 

v Develop 2D drawing with given project specification and 

measurements. 

v Create title block layout as required. 

v Plot drawing on scale according to required size and orientation 
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An architect or AutoCAD operator has to prepare different types of drawings. These may be submission drawings, 

working/ shop drawings, As Built Drawings and Structural drawings. These are described as under: 

Submission Drawings 

A Submission drawing or architectural drawing is a technical drawing of a building (or any project) that falls within 

the definition of Design or architecture Design. Submission drawings are used by architects, Site Engineers or 

Supervisors and others for a number of purposes: to develop a design idea into a coherent proposal, to 

communicate ideas and concepts, to convince clients of the merits of a design, to enable a contractor to construct 

it, as a record of the completed work, and to make a record of a building that already exists. Submission drawing 

is an act of submitting drawings (as for consideration or inspection) but still not approved,  

 
Working Drawings  

Drawing that is subject to clarifications but is complete with enough plan and section views (with dimensions, 

details, and notes) to enable the depicted item's construction or replication without additional information. 

Working drawing (shop drawings) is approved drawing and issued for construction for site. 

 
Structural Drawing 

A structural drawing, a type of Engineering drawing, is a plan or set of plans for how a building or other structure 

will be built. Structural drawings are generally prepared by registered professional structural engineers, and 

informed by architectural drawings. They are primarily concerned with the load-carrying members of a structure. 

They outline the size and types of materials to be used, as well as the general demands for connections. They do 

not address architectural details like surface finishes, partition walls, or mechanical systems. The structural 

drawings communicate the design of the building's structure to the building authority to review. They are also 

become part of the contract documents which guide contractors in detailing, fabricating, and installing parts of the 

structure. 

 
Shop Drawings 

A shop drawing is a drawing or set of drawings produced by the contractor, supplier, manufacturer, subcontractor, 

or fabricator. Shop drawings are typically required for prefabricated components.  

 
As Built Drawings 

Revised set of drawing submitted by a contractor upon completion of a project or a particular job. They reflect 

all changes made in the specifications and working drawings during the construction process, and show the 

exact dimensions, geometry, and location of all elements of the work completed under the contract. 

Also called record drawings or just as-builts. 

 

  

2. Prepare final setup of 2D drawing 
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Different types of drawings are prepared at different stages. Submission drawings may be comprised of  

i. Site Plan 

ii. Propose Plan 

iii. Detail drawing 

iv. Foundation detail 

v. Block Layouts of the plan 

vi. Cross sections 

vii. Elevations 

viii. Schedule of Opening 

ix. Schedule of Area 

x. Detail of RCC (if any) 

These are described as under: 

 

2.1.1. Layout Plan 

A map or a drawing of a construction site showing the position of roads, buildings or other 

constructions. 

 

2.1.2. Landscape Plan 

Landscape planning is a branch of landscape architecture. According to Erv Zube (1931–2002) 

landscape planning is defined as an activity concerned with reconciling competing land uses while 

protecting natural processes and significant cultural and natural resources. 

 
Fig Landscape plan 

 Develop Drawing by using submission techniques 
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2.1.3. Site plan 

 A plan in which the outer shape of object is shown in relation to the direction or boundaries.  

 
Fig Site plan 

 

2.1.4. Line Plan 

 A plan drawn in a single line is called line plan. 

 
Fig  Line Plan of Building 

2.1.5. Detailed Plan. 

The single line plan is developed into a double line or solid plan. Length and width of rooms are 

shown in the plan. Plan is drawn by assuming the structure to be cut at a height of 1.5m from 

ground level. Thickness of walls, width of doors, windows, sun shades, steps and porches etc. are 

shown in the plan. The parts of structure above the cutting plane are shown by dotted lines. Plinth 

projection is also shown in the plan. 
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2.1.6. Foundation Plan. 

A horizontal plan taken below the plinth level and drawn on horizontal plan. 

 
Fig Foundation Plan 

 

2.1.7. Location Plan 

 

 
Fig  Location Plan 
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2.1.8. Elevation  

It shows the width and height of a structure. Front and side views are drawn to give frontal and side 

look of the structures. The shape of windows, doors, verandah openings, sun shade, Louvers, 

railings and parapets are shown in their true look. 

 

 
 

Fig Elevation 

 

2.1.9. Section 

The structure is supposed to be cut by a vertical plane, and the view of cut-section is drawn, which 

is termed as a section. It shows height of rooms and depth of foundations, type of roofs, floors, 

thickness of walls and plinth height etc. Section also shows type of materials used for construction. 

Different conventional symbols are used to show different materials. Height of doors, windows and 

Almirah’s including thickness of lintels are also shown in the structure.  

 
Fig  Section 
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Please send electronic attachments (in addition to any paper copies) on CD/DVD wherever possible. 

 

2.2.1. Plans and drawings 

Submit plans with a clearly identified scale where measurement is a consideration of the plans’ 

contents. 

Both the scale and the native size of the plan should be identified e.g. 1:2,500@A3. 

A scale bar must be included on all plans/drawings. 

Do not use the words “do not scale from drawings”. 

If accurate measurements cannot be determined then the application will be deemed invalid and 

returned for correction. 

Submit plans which are dated, have titles clearly describing the subject matter and reference 

numbers which are sequential and clearly indicate the revision version where appropriate. 

 

2.2.1.1. Layout Plan: 

This is a plan of the whole of the property, ie, the house, all detached buildings, garden, 

other open areas and the position/spread of all trees. 

All of the boundaries of the property should be shown, together with the exact position of 

any proposed detached building or extension. 

The suggested scale is 1:200 or 1:500. 

 

2.2.1.2. Floor Plan(s): 

It is often possible to combine the layout and floor plan. 

It is particularly important to make the existing and proposed floor plans two separate 

drawings if any demolition is involved. 

The suggested scale is either 1:50 or 1:100. 

If the proposed building is sited on a boundary please state whether or not there will be any 

encroachment (eg foundations) onto the adjoining boundary. 

The plans need to show both the existing and the proposed floor plan. 

 

2.2.1.3. Elevations: 

This is the term used to describe a drawing of what the building will look like from the 

outside. 

If the proposal is to extend the house or erect a building close by, every 

elevation should normally be included (preferably to the same scale as the floor plans); the 

whole of the existing house must be shown so that 

the relationship of the new building to the original house can be clearly 

seen. 

Drawings of both the existing and proposed elevations are required. 

 

If any boundary walls or fences are proposed then elevation details are required. This is 

also required on the layout plan. 

Where existing and proposed are shown on the same plan the proposed works should be 

clearly highlighted. 

  Guidance on the Submission of Planning Applications 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 219 

   Module-2, (LU-2): Develop 2D Drawings 

  
 

The use of the rooms and buildings proposed must be clearly indicated on the plans. 

Where the proposal effects parking within the site (eg, the conversion of 

a garage) then the available parking areas should be clearly identified on the plans. 

Where you are proposing roof terraces or balconies, you must identify them on all drawings, 

showing any safety walls or railings. 

 

2.2.1.4. General 

Submit documents which display valid copyright messages (e.g. Ordnance Survey map 

copyright) wherever appropriate and which are not copy protected. 

Submit text documents with logically referenced and headed sections rather than bullet 

points or unnumbered paragraphs, so that individual sections within the document can be 

easily referred to (e.g. ‘section 1.1.1’ etc). 

Please note that all documents you submit form part of a public register and as such these 

documents are available on our website 

 

2.2.1.5. File Structure 

Provide diagrams that are clearly annotated and include a drawing key where appropriate 

to explain the use of different shading, edging and symbols. 

Provide drawings that include a scale bar and at least one key dimension. 

Applications will be invalidated if they do not include this information. 

Provide drawings that contain a compass point marker (showing N) where appropriate. 
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To safe guard the residential property against external forces, governing bodies of societies have developed 

certain laws which must be observed during the construction for health and other environmental facts. 

These are known as building bye-laws. 

 

2.3.1.   Building permit 

Every person who intends to erect or re-erect a building or intends to make additions and 

alternations in an existing building shall apply to the authority in prescribed form with prescribed 

fees, together with plans in Ferro prints and statements in triplicate. 

 

2.3.2.  Plans 

Plan shall consist of the followings: - 

i. Site plan drawn to a scale not less than 8m = 1cm (64’=1”) showing boundaries of the 

site adjacent streets, etc., and north direction. 

ii. Building plans, elevations and sections drawn to a scale not less than 1m=1cm (8’=1”) 

and all new constructions shall be colored red. Drainage and sewer lines shall be shown 

red dotted lines. Work proposed to be dismantled shall be shown in yellow color. Location 

of W.C., sink, drains, etc., shall be shown clearly. Sectional drawings shall show the size 

of footings, walls roof, slab beams, etc. All plans shall be signed by the owner and by a 

qualified architect or engineer. 

  

2.3.3.   Size of rooms— 

Drawing room Standard type Ordinary type 

Drawing room …4.2 × 4.8m to 5.4 × 7.2m 
(14’ × 16 to 18’ × 24’) 

4.2 × 4.8m (14’ × 16’) 

Dining room …4.2 × 4.8m to 4.8 × 6.0m 
(14’ × 16 to 16’ × 20’) 

Combined drawing and 
dining room 

Bed room …4.2 × 4.8m (14’ × 16’) 3.0 × 4.2m (10’ × 14’) 

Office room …3.0 × 3.6m (10’ × 12’) — 

Kitchen …3.0 × 3.0m (10’ × 10’) 2.5 × 3.0 (8’ × 10 

Store …3.0 × 3.0m (10’ × 10’) 2.5 × 2.5m (8’ × 8’) 

Pantry …2.5 × 3.0m (8’ × 10’) — 

Dressing …2.5 × 3.0m (8’ × 10’) — 

Bath and W.C. …1.8 × 2.5m (6’ × 8’) 1.8 × 1.8m (6’ × 6’) 

Latrine … — 1.2 × 1.2m (4’ × 4’) 

 Building Bye-Laws 
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Bath … — 1.2 × 1.8m (4’ × 6’) 

Box room …1.8 × 1.8m (6’ × 6’) — 

Verandah …2.5 × 3.0m wide 
(8’ to 10’ wide) 

1.8 t 2.5m (6’ to 8’ wide) 

Garage …3.0 × 6.0m (10’ × 20’) — 

Servant’s room …3.0 × 3.0m (10’ × 10’) — 

Height of main 
rooms 

…3.6 to 4.8m (12’ to 16’) 3.6m(12’) 

Height of other 
rooms 

…3.0m (10’) 2.7 to 3.0m (9’ to 10’) 

 

2.3.4.        Minimum floor area of rooms and heights— 

 

Drawing room Standard type Ordinary type 

Living …10sq m (100 sq ft) 
(breadth min. 2.7m or 9’) 

…3.3m (11’) 

Kitchen …6sq m (60 sq ft) …3.0m (10’) 

Bath …2sq m (20 sq ft) …2.7m (9’) 

Latrine …1.6sq m (16 sq ft) …2.7m (9’) 

Bath and W.C. 
combined 

…3.6sq m (36 sq ft) …2.7m (9’) 

Servant’s room …10.0sq m (100 sq ft) …3.0m (10’) 

Garage …2.5 × 4.8 m (8’ × 16’) …3.0m (10’) 

Minimum height of plinth for main building …0.6m (2’) 

Minimum height of plinth for Servant’s Quarters …0.3m (1’) 

Minimum depth of foundation …0.9m (3’) 

Thickness of wall — 20cm to 30cm (9” to 13½”) 

D.P.C 2cm to 2.5cm (¾” to 1”) thick — full width of plinth wall 

  

2.3.5.   Method of placing rooms of a residential building w.r.t the direction of the sun 

 

The method of placing rooms of a residential building w.r.t the direction of the sun is being illustrated 

in Fig. Drawing or living rooms should be placed in SE and W; dining rooms in SE and SW; 

Verandahs in South and West, Kitchen in NE and SE; Stairs and stores in NW and NE as shown 
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in the figure. The position of the Kitchen should not create smoke nuisance in other rooms of the 

building. The drawing room may face towards west or southwest but should be protected by a 

verandah. In the absence of a verandah, sun breakers, consisting of thin R.C.C. slabs, are provided 

horizontally or vertically.  

       MINIMUM AREA OF THE OPENINGS FOR VENTILATION OF SPECIFIC ROOMS 

 

Ventilation consists of an inlet of fresh air and exit of vitiated or stagnant air, and maintaining a 

movement of air in the rooms and the building.  

For proper ventilation windows and ventilates should be provided to the requisite numbers, opening 

directly into external air or into open verandah. For proper ventilation windows should have 

minimum area of 1/8 of the floor area of the room and the aggregate area of the doors and windows 

should not be less than ¼ of the floor area of the room. Windows should be provided 60 to 90cm 

above floor level. In addition to the doors and windows ventilators should be provided having a total 

area of 4 percent of floor area. Ventilators serve as good exit for inside air and should be provided 

as near to the ceiling as possible within 60cm from the ceiling. The area of each ventilator should 

not be less than 1 sq. Meter. 

In living room at least two windows should be provided one in each of the opposite walls, if that is 

not possible there should be at least two windows one in each of the adjoining walls, bathrooms, 

toilet and kitchens should have at least one window of 0.9×0.12m size 

Area of windows for proper ventilation of rooms may be calculated for various formulae:- 

i. A = B×L×H   ii. 
B×L×H

100
   iii. 

B×L
8

  

Where A = total clear opening of window 

 L = length of room 

 B = breathe of room and H = Height of Room 

The relation between height (h) and width (w) of window may be taken as w = 0.7h, though 

this may vary according to the requirement and aesthetic point of view. 

 

2.3.6.  POSITION OF DIFFERENT OPENINGS 

To have the best living atmosphere, there should be provision of openings for ventilation of 

buildings. The proper availability in rooms for passage of air and light opening must be provided at 

proper locations. These opening may be doors, windows, ventilators etc. 

 

2.3.6.1. Position of doors 

Doors should be located in such a way that free movement in and out of the rooms of a 

building is ensured. To fulfill this object and other purposes of providing doors in a building, 

the following factors should be considered while deciding the location of doors in a building. 

i. Doors should preferably be located at a distance of about 20cm from the corner of a 

room. 

ii. Doors should be preferably be located in the opposite walls in case the room is to be 

provided with more than one door so as to have a good ventilation in the room. 

Doors should be located keeping in view also the interior decoration of the room. 
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2.3.6.2. Size of doors 

 

Location Size 

Drawing rooms, bed room 
1200 × 2100mm 

(1.2m × 2.1m) 

Stores 
1000 × 2100mm 

(1.0m × 2.1m) 

Kitchen, bathrooms 
900 × 1900mm 

(0.9m × 1.9m) 

  

2.3.6.3. Position of Windows 

Windows located on north side would be highly effective. The following factors should be 

considered while deciding the location of windows in a building: 

i. Windows should be located opposite to each other or opposite to door, wherever 

possible. 

ii. The sill of windows should preferably be placed at a height of 80cm from the floor level. 

In residential buildings situated just near public places like cinema halls, shopping 

centers or where the privacy of rooms on the ground floor is necessary, sill of the 

windows should be placed at higher level, which may be about 2m above ground level. 

Windows should be located in such a way that they should fulfill the requirements of 

distribution of light, control of ventilation, privacy etc. 

 

Sizes of windows Location Size 

Living room of common residential 
building 

1200 × 1400mm 
(1.2m × 2.1m) 

Kitchen, stores 
900 × 1400mm 
(0.9m × 1.4m) 

 

2.3.6.4. Position of ventilators 

The ventilators provided in a wall under the roof but above the adjoining verandah of a room 

are called clerestory windows or C-windows. 

When there is not adjoining verandah, the arrangements made near the roof level for natural 

ventilation and entrance of light in a room are called ventilators. The leaf of a ventilator is 

fixed to the sides by swinging it on two horizontal pivots so that it can be opened or closed 

by means of cords as shown. 

· Size of ventilator 

a) 1800 × 600mm 

 (1.8m × 0.6m) 

b) 900 × 600mm 

 (0.9m × 0.6m) 
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2.3.6.5. Material used in construction 

The following materials are used in construction of buildings: 

i. Stones 

ii. Bricks and other clay products such as floor tiles, roofing tiles. 

iii. Cement such as Portland cement, white cement, colored cement. 

iv. Lime 

v. Aggregates in the form of broken brick, crushed stone, gravel, sand, surkhi, etc. 

vi. Timber and timber products such as plywood, hard board, batten board etc. 

vii. Metals in the forms of rolled steel sections, mild steel and tensile steel. 

viii. Paints, varnishes and washes etc. 

ix. Glass in various forms 

x. Plastic materials / sheet 

xi. Insulating materials 

xii. Bituminous materials as asphalt 

xiii. Door and window fittings 

xiv. Earth / Mud / Clay 

xv. Water 

  

 

2.3.7.   Minimum Area of the building services 

 

Sr. 
No. 

Name of the Room Area of floor in 
standard building 
in m² 

Area of floor in 
ordinary house 
in m² 

Minimum 
area in m² 

1. Bed room 15 — 25 20 12 

2. Dining room 15 — 25 Drawing room 
may be used 
for the purpose 

13.5 

3. Drawing room 20 — 30 20 10.0 

4. Guest room 9 — 10.5 — 7.0 

5. Office room 7 — 9 — 6.50 

6. Dressing room 4 — 7 — 5.0 

7. Box room 5 — 7 — 4.0 

8. Kitchen 7 — 9 7 — 8 5.5 

9. Pantry 5.5 — 7.0 — 4.5 

10. Store 7.0 — 9.0 5.5 — 6.0 5.5 

11. Attached bath and 
W.C. combined 

4.5 —— 2.80 

12. Bath — 2.5 – 3.5 1.80 

13. W.C. — 1.2 — 1.5 1.10 

14. Servant room 9 — 10 — 9 

15. Garage 15 — 18 — 11 

16. Verandah 2.5 — 3.0 wide 1.8 — 2.5m 
wide 

1.5m wide 

 

According to building Bye Laws minimum heights of various rooms should be as follows: 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 225 

   Module-2, (LU-2): Develop 2D Drawings 

  
 

Height of the rooms  = 2.75m 

Height of the kitchen  = 2.75m 

Servant quarter   = 2.40m 

Store, Bath and W.C.  = 2.40m 

  

2.3.8.   Height / Thickness of the Plinth 

For important buildings  = 6.0cm 

For ordinary buildings  = 3.0cm 

Level of inside courtyard and garage above the level of road in front of the building, should be 

minimum 15cm. 

  

2.3.9.   Shape of Plan for the Building 

As far as possible, plan of the building should be kept square instead of rectangular. Length of the 

walls in case of square plan is about 15 to 20% less than that in case of rectangular plane. For 

example let there be two plans of same area. One is 8m × 8m and other is 16m × 4m. Lengths of 

perimeter in case of square plan is 32m, where as it is 40m in case of rectangular plan. 

  

2.3.10. Correct Area of the Building 

Building plots may be classified according to area as follows: 

A type plots — 1000m² and above 

B type plots — 750m² and above 

C type plots — 500m² and above 

D type plots — 225m² and above 

The sizes of plots given above are not standard ones and the size may vary according to economic 

conditions of the people. 

Roughly, minimum size of residential plot should not be less than 150m² and maximum not greater 

than 1600m².  
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The provision of a blank border will enable prints to be trimmed, if necessary with incurring the use of 

uneconomical sizes of sensitized material to allow for trimming. The title block is an important feature in a 

drawing, since it facilitates obtaining uniformity and present details like title of drawing, name of firm, 

drawing number, scale, date of drawing etc. in a definite manner. It is recommended that the title block 

should have space for the following information: - 

i. Name of the project or description or title of drawing. 

ii. Drawing number. 

iii. Scale. 

iv. Symbol denoting the method of projection. 

v. Name of office/firm and Ref. No. 

vi. Dated initials of staff designing, preparing tracing and comparing the drawing, checking of 

accuracy and checking for standards. 

vii. Signatures of officers approving the design. 

 

· Where appropriate, additional information and notes may be included as follows: - 

i. Job order number. 

ii. Material or part list. 

iii. Treatment, finish, etc. 

iv. Key to machining and other symbols and legends. 

v. Tolerance on dimensions. 

vi. Tool, gauge, jig and fixture references. 

The items in the title should be lettered in accordance with their relative importance. Some companies adopt 

standard title form and have them printed in standard sheets of tracing cloth or paper, so that the draftsman 

required merely filling in the blank spaces. 

Following figure shows a Title Block for class work. It should include the following: - 

i. Heading or title of drawing  

ii. Scale    

iii. Date 

iv. Name of institution   

v. Name of city 

vi. Sheet No. 

vii. Name of student 

viii. Class with branch  

ix. Roll No. 

  Create Title Block/ Title Strip Layout as required 
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Fig. Title Block 

 

A Title block with other annotations e.g. Specifications, Schedule of Areas, Schedule of Openings may be 

as under 

SUBMISSION DRAWING 

Plot No.____________ Block: ____________ 

Specifications 

Detail of specifications 

Schedule of Area 

Schedule of Openings 

Proposed Plan of House Plot No.  , Street: __________ Colony 

Name: ____________, Town___________, Tehsil & District Names. 

Owner Name: _______________ S/O ______________ 

Submitted by:  

 

 

Signatures: __________________ 

Name: ______________ 

Dated: ______________ 

Prepared by Architect:  

 

 

Signatures & Stamp: __________________ 

 

Submission by T.M. A. Approved Architect: 

 

Signatures & Stamp: __________________ 

 

Approved By:  

Society Name: __________________ 

 

Signatures & Stamp: __________________ 

Engineer 

Drawn by Draftsman Checked by 

Engineer 

Revision/ Issue No.: 

_______ 
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Plotting for Save drawing in different format (e.g. dwg, PDF, JPG). 

In this unit learner able to print out the Drawing in different formats like  

 

.PDF 

.JPG etc 

 

Note: How we can do working in PDF and JPG printing  

 

· Method of Saving Drawing in PDF  

Step 1 

Applying command print in AutoCAD then show the dialog box of print / plot like (show in picture)  

Then click the PDF option 

 

 

 Demonstrate plot command to print plan with different scale to size and orientations. 
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Step 2 

Select the Drawing with Window option lick (showing in the picture) 

and click the OK option 

 

 
 

Step 3 

Then give the path where you want save drawing lick (showing in the pictures) 
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Method of Saving Drawing in JPG. 

Step 1 

Applying command print in AutoCAD then show the dialog box of print / plot like (show in the picture)  

Then click the JPG option 
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Step 2 

Select the Drawing with Window option lick (showing in the picture) 

And click the OK option 

 

 

 
Step 3 

Then give the path where you want save drawing lick (showing in the pictures) 
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Practice - 1 

Develop a set of submission drawings in AutoCAD. 

 
Step 1: Draw and annotate the Ground Floor Plan 

Step 2: Draw and annotate the First Floor Plan 

Step 3: Draw and annotate the Ground Floor Plan 

Step 4: Draw and annotate the Front Elevation 

Step 5: Draw and annotate the Cross Section 

Step 6: Draw and annotate the Cross sections of walls 

Step 7: Draw and annotate the Site plan 

Step 8: Draw and annotate the Location Plan 

Step 9: Draw and annotate the other main services plans and section. 

Step 10: Prepare complete Title along with components 

Step 11: Create a layout. Distribute evenly the space of drawing sheet as per requirement. Proposed layout 

of the submission drawing as per standards is as under.  

Ground floor plan at bottom left corner. First floor plan adjacent to ground floor plan to the right. 

Elevation at top left corner of sheet parallel to ground floor plan. Cross section adjacent to the 

elevation right side. Sections of walls and columns etc. adjacent to the cross section. Site plan and 

location plans adjacent to the First-floor plan to the right. Services adjacent to left of the title block 

which will be to the right side and other annotations (Schedule of openings, Schedule of areas etc.) 

For the purpose take new view ports and adjust the same as per size and location of the concerned 

drawing. 
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Practice - 2 

Print the completed submission plan plan with the following requirement  

 
Step 1:  Open the Submission drawing CAD files 

 

 

 
 

Step 2: Select the command print or with shortkey Ctrl+P then appears dialog box of Plotter  

 

Select the given option 

You can set the layout as explained in development of submission drawing. You can rename the 

layouts. One layout may have one or more parts of drawings. 

 

You can also print the parts of drawings from the model. You can select the parts of drawing with 

window or extents. 

After selecting the print/ plot command the following window will appear. Select the printer/ plotter 

from which you want to take print out. Select the window option for printing of specific area of 

drawing. Select the scale if you want to print on some specific scale. Select the paper/ drawing 

sheet size. Select other options for offsets from left or bottom. Select number of copies to print. 

Select the paper orientation (Portrait/ Landscape). As shown in the following picture. 
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Step 3: Set the paper size: A3 

 

ee  
 

Step 4: Select with Given option: Window to print from model or layout for layout printing. 

Set the plot offset: Center 

Drawing orientation: Landscape 
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Summary of Module 

 
This module is designed to provide skills and knowledge to create 2-Dimensional drawings by using various tools 

and commands. Trainees can create and modify objects and drawings in AutoCAD to meet specific targets 

according to job requirements. 

Trainees will learn to setup drawing interface for required specifications. they will have the skill to setup user 

interface settings for required specifications. They will have the skills to execute the different commands to draw, 

modify, dimension, annotate, mode settings, UCS settings, drafting settings, via tool bars, menu options, use of 

command line window. The Trainees will have the skill to create 2D objects with given measurements by using the 

commands, tools Co-ordinate system (Coordinate, Absolute, Relative, Polar, etc.). AutoCAD drawing files will be 

saved by them in different file formats (e.g. dwg, PDF, JPG). They will also edit 2D Objects to meet set standards/ 

bye laws of controlling agency. 

Trainee will get skill to use appropriate command and tools to develop 2D drawings in general. In the specific 

condition they will develop 2D Drawing with given project specification and measurements. For the purpose of 

presenting the drawing they will have the skill to create title blocks, layouts as per required scenario. For the hard 

copy output they will have the skill to plot drawings on scale according to required size of sheets and orientation of 

drawing sheets. They will have the skill to prepare submission drawings and working/ construction drawings in 2D. 

The sheets will contain all the necessary information like Schedule of openings, Schedule of areas, Specifications 

etc.  

 

 
 
 
 
 
  



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 
| 240 

Module 2: Develop 2D Drawings 

 

Question and Answers: 

 

FAQ - 1 What Is The Purpose Of Auto Cad Software? 

Answer : 

i. AutoCAD software provides the design and the shape for the products that needs to be 

created. 

ii. It provides flexible and user friendly features with the tools to design the applications and 

document the workflows. 

iii. This involves aggregate and import models for the formats and usually allows the design 

to get created without any change in source model. 

iv. It provides tools to provide the formats by detailed designing the layouts and drawings 

using the views automatically. 

v. It also has the provision to create detailed design layouts and views can be drawn 

automatically using the source model. 

 

FAQ - 2 What Are The Uses Of Auto Cad? 

Answer : 

i. AutoCAD software is used to draw and design the documents and the applications with 

easy customization options. 

ii. AutoCAD provides a platform to be used by professionals to create the designs and 3D 

models. 

iii. It allows the creation of the professional technical drawings and conceptual designs used 

for representation of the logics. 

iv. It allows the drafter to provide the finishing touches and designing with the detailing and 

linking to the online data. 

v. It provides suppliers or operational professionals to review the drawings and modify it 

according to the requirements. 

 

FAQ - 3 What Is The Main Purpose Of Auto Cad? 

Answer : 

i. AutoCAD is used to create the computer aided designs or software applications including 

drafting. 

ii. AutoCAD develops the application in both the 2D and 3D formats and provide the 

information to the application. 

iii. AutoCAD provides tools to design the softwares used in the industry, architects and 

project management. 

iv. It provides an easy way to design the software with the designs and architect it according 

to the need. 
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FAQ - 4 What Are The File Formats Used In Design? 

Answer : 

i. There is a use of native format like .dwg for the AutoCAD and it provides an 

interchangeable format. 

ii. The file format that is interchangeable has the extension as DXF and it provides the data 

operability. 

iii. AutoCAD includes the .dwg format and provide the support as well. It provides a way to 

use the files that are active. 

iv. It provides a way to estimate the total number of active .dwg files that can be made in 

collaboration with other files. 

v. It provides languages that can be used and the localization part of the software can be 

modified to meet the requirements. 

 
FAQ - 5 Question 5. What Is The Function Of Vertical Integration? 

Answer : 

i. AutoCAD uses the vertical integration program to enhance the architectural designing of 

3D objects. 

ii. The 3D objects can include walls and other things that are associated with the data 

having intelligence and association with the simple objects like lines and circles. 

iii. The data is programmed such that it represents only the architectural products and the 

extracted files. 

iv. The information for the data and the actions on the like modifies and creates the 

relationship of an object. 

v. It consists of the tools that allow the estimation and other objects related representation 

in the 2D drawings. 

vi. The elevations and sections used as a 3D architectural model specifies the standard 

calculations used in creating applications. 

 

FAQ - 6 Question 6. What Is The Use Of Variants In Auto Cad? 

Answer : 

i. AutoCAD uses lots of variants including the releases that provide capabilities to build an 

application. 

ii. The 3D capability that is being provided by the AutoCAD gives fewer rises to the releases 

of the applications. 

iii. Variants are used to increase the variations present in the application or the package 

used in particular program. 

iv. AutoCAD provides variants that help in creation, visualization and rendering of the 3D 

models that provide the 3D printing as well. 

v. Variants provide a way to use different functionalities of the function in the application 

and execute it according to the needs. 
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FAQ - 7 What Are The Differences Present In The Software's Features? 

Answer : The difference in the software’s features is shown as: 

i. 3D Capabilities: this is a way through which AutoCAD can view the overall progress of 

creation, visualization and rendering of the 3D objects. 

ii. Network Licensing: is being provided by the AutoCAD to be used for the multiple 

machines over the network. 

iii. Customization: is another feature of AutoCAD that doesn’t support LISP, ARX, and VBA 

for the customization part. 

iv. Management and automation capabilities: is being provided with the management and 

automate the whole process of creation. 

 

FAQ - 8 What Are The Features Involved With The Auto Cad Ws? 

Answer : 

i. AutoCAD is a platform that provides Mobile Apps (iOS) to be created by providing certain 

options for view, edit and share.   

ii. The user can easily share the applications wherever they go on fly and it makes creating 

application less time consuming. 

iii. The applications can be downloaded and installed from many other places that require 

licensing for the mobile applications. 

iv. The users can save the file in whichever way they want and the application can run on 

any platform. 

v. AutoCAD applications provide a way to let the user share information on cloud and use 

the technology to enhance more features. 

 

FAQ - 9 What Are The Different Ports Used In Different Os? 

Answer : 

i. AutoCAD doesn’t have major improvements and some changes can be made to improve 

the capabilities of it. 

ii. It requires the improvements to be made on the ports so to provide the easy accessibility 

to the applications and devices. 

iii. The changes have been made to suit the environment and it included: 

iv. Canvas control: this is being done in an increased manner and it controls the area that is 

being defined by the canvas. 

v. Associated arrays: this provides the arrays that are being associated with other arrays or 

other parts. 

vi. 3D model manipulation: that is being done by the tools used in the operating systems and 

allows easy portability of the application. 
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FAQ - 10 What Is The Procedure To Create User Interface? 

Answer : 

i. The user interface can be created by using the command prompts to draw the plots and 

dialog boxes. 

ii. The displaying of the dialog boxes can be seen by the use of PLOT command and the 

external database (ASE) commands. 

iii. Setting of CMDDIA to 1 takes place that enables the dialog boxes to run the command 

and enter the spaces of use. 

iv. The user interface creation also requires the command line to display the entire file so 

that it can be easily customized or edited. 

FAQ - 11 What Is The Procedure To Draw A Line More Than One Time And Save It Automatically? 

Answer : 

i. AutoCAD allows the file to be written in multiple instances of the processes and it limit the 

resources that needs to be used as well. 

ii. When a new line needs to be drawn the process opens up another file in a new session 

to write the file. 

iii. AutoCAD allows saving multiple drawings to be saved for each session and it can be 

used to create the application. 

iv. The files are saved by using the file extension as .dwg and it can be modified using the 

browser. 

v. The file extension needs to be hidden and it needs to show allowing the selection of the 

option as well. 

vi. The file modification takes place by checking the AutoCAD operations and opening up of 

the drawing. 

 

FAQ - 12 What Is The Procedure To Remove The Empty Layers? 

Answer : 

i. The empty layers can be removed from the drawing by using the all objects residing at 

once place. 

ii. The references of the layers are also removed so that it appears to be empty and can 

easily be created. 

iii. If the layer is empty then the PURGE will not be able to remove the layers from the 

drawing. 

iv. The layer can be made frozen on the viewport that is visible to the object and provide the 

definition of the object too. 

v. The removing of the layer is possible due to the drawing that can be made using the 

EXPORT command and the result can be created in the DXF file. 

  

FAQ - 13 What Are The Steps Need To Be Taken To Replace The Buttons On Toolbars With 
Smiley? 

Answer : 
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i. AutoCAD have the place for button icons in the toolbar and tool boxes that it gets 

replaced with the smiley. 

ii. AutoCAD provides the buttons for the template files that can be edited after customizing 

the toolbars. 

iii. The changes are being provided by the template files that can cause the menu resources 

and allow the creation of files according to the requirements. 

iv. To use smiley instead of buttons following steps are required and needed: 

v. Open the AutoCAD menu and edit the button file using the bitmap file that is saved in the 

support path. 

vi. Move or copy the icon files that are used for different menus toolbars and open it 

according to the menus chosen. 

vii. The button properties can be seen and an editor dialog box will be given according to the 

save as button. 

viii. The directory is specified with the supported path and the Apply button properties are 

also being given for the AutoCAD properties. 

  

FAQ - 14 What Are The Features Being Corrected By Autocad? 

Answer : 

i. AutoCAD identifies the problem and correct it by removing the corruption with the 

drawing parts. 

ii. It involves adding of the vertices to the poly-lines with a provision to add additional 

vertices. 

iii. The poly-line provides only the provision of using one vertex and the vertex can be added 

on run. 

iv. The corruption can be neglected or corrected by finding out the exact location of the poly-

line that has zero vertices. 

v. The objects can be deleted after there is no use of it or can be removed if there is no use 

of them in the system. 

 

FAQ - 15 What Are The Steps To Enable The Drag And Drop Feature In Autocad? 

Answer : 

i. AutoCAD provides a way to drag and drop the elements by the use of noun and verb that 

allows the object to move from one place to another. 

ii. AutoCAD provides an option to rotate or erase the selected object and allows the action 

to be taken on the application. 

iii. The editing functions like MOVE and ERASE can be used to provide the erasing of the 

objects and noun/verb. 

iv. Open the system option dialog box and choose from there Noun/Verb and turn it on from 

the menu bar. 

v. The selection tab can be selected by using the noun/verb selection of the options with the 

mouse clicks and opening of the menus. 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 245 

Module 2: Develop 2D Drawings 

  
 

FAQ - 16 What Are The Steps Involved In Setting Up The Default Drawing Directory? 

Answer : 

i. Default drawing directory is the one that involves sub directories containing the 

information using the windows commands. 

ii. AutoCAD uses the navigation paths to travel the directories and it adds a shortcut for the 

directories that doesn’t have a shortcut. 

iii. The application can be highlighted that needs to be built in and then drag and drop 

features are used to place the application. 

iv. The properties of the application are selected from the menu and dialog boxes used to 

display it on the front. 

v. AutoCAD uses the directory system to use the commands like OPEN that allows the 

selection of the files and create the shortcut in default directories. 

 

FAQ - 17 What Is The Procedure To Copy The Dimension Styles From One Drawing To Another? 

Answer : 

i. Copying the dimension of styles from one drawing to another requires setting up the 

particular dimension style. 

ii. Setting up the dimension style also requires the use of documents and creation of the 

styles while using the blank document. 

iii. The document is saved by using the document as a Drawing template and then new 

references gets created by the template document. 

iv. Templates define the system variables that can be consistent across all the platforms and 

provides the drawings like layer styles, units and blocks. 

v. It can be copied by copying the styles on single case basis and the drawings can be done 

by seeing the current drawing. 

vi. Using of the design center makes it easy for the AutoCAD tools to allow the browsing and 

copying of the styles and other drawings activities. 

 

FAQ - 18 What Are The Steps Involved In Copying A Closed Drawing? 

Answer : 

i. The copying of the closed drawing takes place from the toolbar provide in the design 

center of the AutoCAD. 

ii. Design center allows the modification of the drawing to be done using the graphical 

interface. 

iii. Open drawings are given to display the content and copy the closed drawings easily by 

using the Tree View option. 

iv. The drawing is involved with the drawing elements that can be copied with the defined 

objects that have the similar type. 

v. Dim style gets copied from one to another and it provides a drag and drop feature that 

gets opened into an open document. 
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FAQ - 19  What Is The Way To Hide The Specific Layers When Plotting? 

Answer : 

i. The prevent layers used using the plotters for plotting provides the layer manager that 

allow easy options to customize the application. 

ii. The layers used in layer manager have specific options like: 

iii. Turning off the layers 

iv. Freezing the layers 

v. Turning off the layers for plotting 

vi. Layers used in the plotting remain visible on the screen and doesn’t provide the output to 

the printer. 

vii. Individual layers can also be set up in specific viewports that allows drawing of the layers 

that contains the systems applications and options. 

viii. It uses the viewport concept that allows the different layers to be frozen on the view port 

and this way it can be hidden from other layers. 

 

FAQ - 20 Why Autocad Software Is Used? 

Answer : 

i. The shape and design of the products that is required to be created is offered by 

AutoCAD software. 

ii. This software offers features that are user friendly and very flexible with some specific 

tools to develop applications and the workflow is documented. 

iii. Aggregating and importing models is involved in it and most commonly permits to 

develop design without making any changes in the original model. 

iv. It offer some specific tools to present formats by designing layouts in detail and views can 

be used in drawings automatically. 

v. Also, it has some specifications to develop detail design layouts and automatically views 

are drawn by making use of original model. 

 

FAQ - 21 Give Autocad Uses? 

Answer : 

i. AutoCAD software is responsible for designing and drawing the documents and 

applications with simple customization options. 

ii. A platform is offered by AutoCAD for professionals to generate attractive designs and 

some 3D models. 

iii. It permits conceptual designs and qualified technical drawings formation that is effectively 

used for logical representations. 

iv. It permits drafter to offer designing and finishing by connecting to online information. 

v. It offers operational experts or suppliers to evaluate drawings and change it according to 

the necessity. 
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FAQ - 22 What Is The Main Reason For Using Autocad? 

Answer : 

i. Mainly, AutoCAD is responsible for developing designs that are computer aided or some 

software application that contain drafting. 

ii. Application can be developed in 2D and 3D formats using AutoCAD and offer information 

to application. 

iii. Some specific tools are offered by AutoCAD to develop software used in the market, 

project management and architectures. 

iv. It offers best way to develop software with designs and build it according to the 

requirement. 

 

FAQ - 23 What File Formats Are Used In Design? 

Answer : 

i. There is native format use such as .dwg for AutoCAD and it offers format that can be 

exchanged. 

ii. The format of file that can be exchanged has DXF extension and it offers data operability. 

iii. dwg format is included in AutoCAD and give the support. It gives a method to use active 

files. 

iv. It gives a way to approximate total file having extension .dwg that is created in 

association with other files. 

v. It offers languages that are used and software localization part can be changed to meet 

the needs. 

 

FAQ - 24 Question 24. Give The Variants Usage In Autocad? 

Answer : 

i. Multiple variants are used by AutoCAD that include releases offering abilities to create an 

application. 

ii. The 3D ability offered by AutoCAD provides few rises to the application releases. 

iii. Variations are increased by variants that are in the application or the package used in 

specific program. 

iv. AutoCAD offers variants that help in formation, visualizing and depicting 3D models that 

offer even 3D printing. 

v. Variants offer best method to make use of various functionalities of function and evaluate 

it according to the requirements. 

 

FAQ - 25 Give Features Involved In Autocad Ws? 

Answer : 

i. A platform that offers Mobile Apps to be developed by giving some options to view, share 

and edit is AutoCAD 
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ii. Applications can be easily shared by user when they go on fly and the applications can 

be developed in less time. 

iii. Application are downloaded and installed from different places that need license for all 

the applications developed for mobiles. 

iv. Files can be saved by the user according to their desire and that application can be run 

on any different platform. 

v. The application based on AutoCAD offer best way to let information shared by the user 

on cloud and use technology to improve features. 

 

FAQ - 26 Describe Procedure To Create User Interface? 

Answer : 

i. Command prompts are used to sketch dialog boxes and plots to create user interface. 

ii. The dialog boxes display is seen by making use of some external commands or PLOT 

command. 

iii. Set CMDDIA to 1 takes place that allows dialog boxes to run command and enter use 

spaces. 

iv. The creation of user interface needs the command line to show complete file so that it 

can be edited or customized very easily. 

  

FAQ - 27 Which Key Combinations Issues The Isoplane Command? 

Answer: CONTROL and E or F5 

 

FAQ - 28 The Effect Of Qtext Being On Is To? 

Answer : speed up drawing regeneration by replacing text with rectangles 

 

FAQ - 29 Which Is An Autocad Font For Mathematical Symbols? 

Answer : MATHC 

 

FAQ - 30 Which One Key Combinations Will Toggle Coords? 

Answer : Either F6 or CONTROL and D 
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Test Yourself 

 

 

Multiple Choice Questions (MCQs) 

 

1) Which command convert discrete objects in polyline? 

(a) Union     (b) Subtract 

(c) Join     (d)  Polyline 

 

2) When drawing in 2D, what axis do you NOT work with? 

(a) X     (b) Y 

(c) Z     (d)  WCS 

 

3) To print the entire project, you will choose to regulate what to plot? 

(a) Display     (b) Extents 

(c) Limits     (d)  Window 

 

4) If I want to draw a line in the direction 07:30 (local time) will give an angle? 

(a) -135 degrees    (b) 270 degrees 

(c) -225 degrees    (d)  None of the above 

 

5) What is the difference between the Scale command from the command Zoom? 

(a) Scale for single object, while the Zoom whole plan 

(b) No difference 

(c) A Scale can grow / shrink a shape up 10 times, while the Zoom has no limits  

 (d)  A Scale changes the size of objects, while the Zoom changes the visibility of the project 

 

 
6) The primary difference between the Model tab and the Layout tab(s) is ---------? 

(a)   The Model tab is used for drawing in 3D and a Layout is used for drawing in 2D 

(b) The Model tab is where you create the drawing and a Layout tab represents the sheet that 

you will plot or print on 

(c)   The color of the background 

(d) The Model tab displays the drawing you are copying from and the Layout tab is where 

you lay out the new drawing 
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7)

Isometric(b)Parametric(a)

Rectangular(d)Pro-optic(c)

 

What time (according to the clock) are 270 degrees a8) ccording to the conventional time? 

6 exactly(b)12 exactly(a)

3 exactly(d)9 exactly(c)

 

When to fix a block attribute?9)

After fix the block(b)When I make the block(a)

No matter the number(c)

 

10)

Because so one can distinguish man(a)

since this is the limit of graphics cards(b)

For each color we have 256 shades and colors combin(c) ation third   

Because we want compatibility between PC and Ma(d) cintosh 

 

Which of the following is NOT a property of an ob11) ject? 

Measure(b)Line weight(a)

Elevation(d)Hyperlink(c)

 

By what symbol shows the snap point to the close12) st point? 

With tw(b)With circles and dots in the center(a) o triangles 

With Diamond(d)With three orthogonal(c)

 

What you cannot create from the command Offset?13)

Concentric circles(b)Vertical straight(a)

Parallel arcs(d)Three parallel lines(c)

 

What is the usefulness of viewports?14)

Allows us to see the screen or on paper different(a)  views of the same project 

Give us the ability to see projects have become(b) a newer version of AutoCAD from us. 

We can make a change in one part of the plan, w(c) ithout affecting the rest 

None of the above(d)

Which state grid is used to design persSSP

Which state grid is used to design peSSPective?
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15) What are the various options from left to right and the opposite direction? 

(a) Choose a different category of objects  

(b) select objects according to their color 

(c) Select objects according to their position  

(d)  No difference 

 

16) When in absolute Cartesian coordinates have points A (10,8) and B (6,5), then to make a line from A 

to B with relative polar coordinates will write? 

(a) @ -5 <36.88    (b) @ 4 <30 

(c) @ 5 <216,88    (d)  @ 3 <60 

 

17) Which of the following is not a keyboard shortcut of AutoCAD? 

(a) Ctrl + P     (b) Alt + F4 

(c) Ctrl + F4    (d)  Alt + B 

 

18)  What is the minimum allowable number of layers in a drawing? 

(a) 0     (b) 5 

(c) 1     (d)  2 

 

19) When should I use the Block Editor? 

(a) To write text block   (b) To fix outer block 

(c) To fix dynamic block   (d)  To store it in another version of AutoCAD 

 

20) What setting gradient allows us to fill an open area? 

(a) Gap     (b) Tolerance 

(c) Transparency    (d)  Open 

 

21) Which is corresponded to zoom mouse wheel? 

(a) Zoom in / zoom out   (b) pan & scan 

(c) extents / all    (d)  scale 

  



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 
| 252 

Module 2: Develop 2D Drawings 

 

22) What does associative hatch? 

(a) Monitors the changes in shape that fills  

(b) Relates to the other hatch plan 

(c) Both of the above     

(d)  None of the above 

 

23) What is the command used for Plagiostomi angle? 

(a) Chamfer    (b) Fillet 

(c) Offset     (d)  Mirror 

 

24) What command allows us to select objects based on some status? 

(a) Properties    (b) Qselect 

(c) Pselect     (d)  Attributes 

 

25) How many SNAP points does an object have? 

(a) 1     (b) 4 

(c) 5     (d)  Depend on object 

 

26) Which of the following file extensions cannot open the AutoCAD? 

(a) dwg     (b) dxf 

(c) dot     (d)  dws 

 

27) A surveyor with a headband to measure the dimensions of a site, he makes measurements by? 

(a) No one method    (b) Related Cartesian coordinates 

(c) Absolute polar coordinates  (d)  None of the above 

 

28) The origin of a drawing is at? 

(a) 0,0     (b) 1,0 

(c) 0,1     (d)  1,1 

 

29) How to make a random line with an angle of 40 degrees to the x axis? 

(a) will write 0 <40    (b) will write 2 <40 

(c) will write 3<40    (d)  will write 4 <40 
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30) Scaling objects make them--------? 

(a) Smaller     (b) Bigger 

(c) Either smaller or bigger   (d)  None of the above 

 

 
 

Answers key: 
 

1 C 2 C 3 C 4 B 5 D 

6 B 7 B 8 B 9 A 10 C 

11 B 12 C 13 A 14 A 15 C 

16 A 17 D 18 C 19 C 20 B 

21 A 22 A 23 A 24 B 25 D 

26 C 27 A 28 A 29 C 30 C 
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Module 3:  

Develop 3D Objects using AutoCAD. 

 
 

Objective: 

The Objective of this module is to provide skills and knowledge to 

create 3-Dimensional models by using various tools and 

commands in AutoCAD software. You can demonstrate your skills 

to modify 3D objects and models to ensure job requirements. You 

can present a rendered 3D Model to present final outcomes. 

 
 

Learning Units: 

After Completion of this learning Units, you will be able to: 

 

v Develop 3D Objects 

v Manipulate 3D Objects Using 3D Editing Tools  

v Render 3D Model 
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Learning Unit 1:  

Develop 3D Objects 

 

Objective: 

In this learning unit you will learn how to setup the interface for 3D 

development, save file with desired name and location, create 3D 

objects and modifying objects. After completion of this learning unit 

you will be able to understand following. 

 

Learning Outcomes: 

After Completion of this learning outcomes, you will be able to: 

 
 

v Setup & Save 3D Drawing Interface for Required 

Specifications. 

v Setup 3D user interface setting for required 

specifications. 

v Create 3D objects with given measurements. 
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1. Setup & Save 3D Drawing Interface for Required Specifications 

 
The following is AutoCAD’s 3D Basic interface. The 3D Basic ribbons are as follows: 
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1.1.  Setting UP the 3D Workspace 

 

So far, you’ve been using the Drafting & Annotation workspace to create your drawings in 2D. Your first 

task in transitioning into 3D begins by switching to a new workspace for working in 3D and changing how 

AutoCAD displays the available tools. 

 

1.1.1.   Workspaces: 

AutoCAD workspaces are sets of menus, toolbars and dockable windows (such as the Properties 

palette, Design Center, and the Tool palettes window) that are grouped and organized so that you 

can work in a custom, task- oriented drawing environment. 

!

1.1.2.  Step by Step Operation 

Get ready before you begin these steps, be sure to turn on and/or log on to your computer. 

!

Procedure 

How to set 3D Workspace 

i. On the Windows task bar, click the Start button,!  then click All Programs. A menu of 

installed programs appears. 

ii. Click the Autodesk folder → Next AutoCAD2013-English 
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iii. AutoCAD opens and a new blank drawing appears. 
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iv. Click the workspace switching drop down arrow or icon. 

 
v. Click 3D Basic 

 
 

vi. The following figure show3D Basic Ribbons. 

 

 

!

vii. Or you can Click the 3D Modeling option.  
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1.1.3.   AutoCAD 3D Basic Ribbons  

For the 3D Basics options, there are following tabs for ribbons. 

HOME, RENDER, INSERT, MANAGE, OUTPUT and EXPRESS 

TOOLS. 

i. Home 

 
For the HOME tab, there are categories of Create, Edit, Draw, Modify, Selection, Coordinates 

and Layers & Views. 

 
ii. Render: 

 
For the RENDER tab, there are categories of Lights, Sun & Location, Material, and Render. 

 
iii. Insert 

 

For the INSERT tab, there are categories of Block, Reference, and Import. 

iv. Manage: 

 

Remember 

3D Basics provides 

options to create 

basic 3D object. 
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For the MANAGE tab, there are categories of Action Recorder, Customization, Applications, 

and CAD Standards. 

 
v. Output 

 
 

For the OUTPUT tab, there are categories of Plot, Export to DWF/ PDF, and 3D Print. 

 
 

vi. Express Tools 

 
 

For the EXPRESS TOOLS tab, there are categories of Blocks, Text, Modify, Layout, Draw, 

Dimension, Tools and Web. 
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1.1.4.   AutoCAD 3D Modeling Ribbons 

For the 3D Modeling option, there are following tabs for ribbons. 

 
HOME, SOLID, SURFACE, MESH, RENDER, PARAMETRIC, INSERT, ANNOTATE, VIEW, 

MANAGE, OUTPUT and EXPRESS TOOLS. 

 
i. Home 

 

 
For the HOME tab, there are categories of Modeling, Mesh, Solid Editing, Draw, Modify, 

Section, Coordinates, View, Selection, Layers, and Groups. 

 
ii. Solid 

 

 
For the SOLID tab, there are categories of Primitive, Solid, Boolean, Solid Editing, Section, 

Selection. 

 
iii. Surface 

 

 
For the SURFACE tab, there are categories of Create, Edit, Control Vertices, Curves, 

Projections, Analysis. 

 
iv. Mesh 
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For the MESH tab, there are categories of Primitive, Mesh, Mesh Edit, Convert Mesh, Section 

and Selection. 

v. Render  

 
 

For the RENDER tab, there are categories of Lights, Sun & Location, Material, and Render. 

 
vi. Parametric 

 

 
 

For the PARAMETRIC tab, there are categories of Geometric, Dimensional and Manage. 

 

vii. Insert 

 

 
 

For the INSERT tab, there are categories of Block, Block Definition, Reference, Import, Data, 

Linking & Extraction, Point Cloud 

 
 

viii. Annotate: 

 

 



Trainer and Learner Guide: Information Technology (CAD) | 265 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

 
For the ANNOTATE tab, there are categories of Text, Dimensions, Leaders, Tables, Markup, 

Annotation Scaling. 

 
ix. View: 

 
 

For the VIEW tab, there are categories of Navigate, Views, Coordinates, Visual Styles, 

Viewports, Palettes and Windows. 

 
x. Manage: 

 
For the MANAGE tab, there are categories of Action Recorder, Customization, Applications, 

and CAD Standards. 

 
xi. Output 

 
For the OUTPUT tab, there are categories of Plot, Export to DWF/ PDF, and 3D Print. 

 
xii. Express Tools 

 
For the EXPRESS TOOLS tab, there are categories of Blocks, Text, Modify, Layout, Draw, 

Dimension, Tools and Web. 
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1.1.5.   Prepare 3D interface including work space setting. 

 

· Ribbon: 

The ribbon is a user interface tool that first appeared in AutoCAD 2018. It contains various 

commands organized into tabs and panels. It can be heavily customized by administrators and 

end users. Tabs are very powerful; they appear with panels of commands and options relating 

to whatever task is at hand for example, if a HATCH object is selected, a contextual tab with 

hatch editing command appears automatically. 

 
 

1.1.5.1. Status Bar: 

Moving to the bottom of the application, you will find the Status Bar. Since AutoCAD 2015, 

the status bar contains icons only. By default, several icons are not enabled, so you might 

want to turn them on. We believe Autodesk does this because on a small monitor, all of 

the icons may not fit across on one row. But the icons will wrap up to a second row if 

needed, and on any decent sized monitor these days, at 1920×1080 resolution, you can 

enable all of the status bar icons and they fit with ease. 

 

Below is a stock status bar, along with the control icon on the far right, expanded to show 

you the other available icons (Click on the image below for a full-size version) 

 

 
 
 

1.1.5.2. File Tabs: 

File tabs provide access to all open documents in a minimal amount of space. Each open 

document has its own tab. Left-click on a tab to make it current, and right-click on a tab to 

access more options, such as Save and Close. There is always a tab containing a plus 

sign to open a new document using the QNEW command. By default, File Tabs are 

oriented at the top of the documents, below the Ribbon. 
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1.1.5.3. Layout Tabs: - 

Layout tabs provide access to Model Space and each Layout in a given document. Left-

click on a tab to make it current, and right-click on a tab to access more options such as 

Print, Move, or Rename. There is always a tab containing a plus sign for the creation of a 

new layout. By default, Layout Tabs are oriented at the bottom of the editor window in the 

status bar area. 

 

 
 

 
1.1.5.4. Toolbars: - 

Toolbars go back to the early 1990’s in AutoCAD. These are flat panels that contain buttons 

and or drop-down lists. Each button contains an icon.  Toolbars can be floating or docked 

by own. 

 

 
 
 

1.1.5.5. Command Line: - 

The command line is a palette where you can type in command names and/or command 

responses, and the view the history of both. If the command line is docked, it has a fixed 

number of visible lines. Floating command line palettes can expand when needed to show 

you more data. The F2 key in both cases will toggle open/closed, a larger command line 

history window. A typical floating command line is shown here: 
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1.2. Setup 3D User Interface Settings for Required Specifications. 

Save drawing and Activate all Tabs required for 3D to work with 3D modeling. 

Important work after starting drawing.  

We need following five steps to use before start of a drawing in Auto Cad Software. 

These five steps are given bellow: 

Open the Auto Cad 

Set the unit and area 

Z è A/E 

Set the primary unit 

Save the file 

1.2.1.   Open the AutoCAD. 

There are three methods to open the Auto Cad. 

 

i. By Icon 

ii. By Start Menu 

iii. By Run 

 

i. By Icon 

Go to the desktop è Double click on Auto Cad Software Icon. 

 
ii. By Start Menu 

Go to start è program è Auto desk è Auto Cad  

 
iii. By Run 

Go to Start è Open the start window è write the Auto Cad in Run Window ß 

1.2.2.   Set the UNIT and AREA. 

There are two methods to set the UNIT and AREA. 

 

M.M stands for 

main menu  

Remember 
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i. By Main Menu 

ii. By dialog box 

i. By Main Menu 

UNIT  

Short cut = UN 

M.M è Format è Unit  

è Open the unit window è set the unit è OK 

 

AREA 

Short cut = Limits 

M.M èFormat èdrawing limitsí è Shoe the previous size of sheet in command area bar è 

put the new sheet size in command area bar. (X, Y) 

 

 
 

ii. Set the Units and Area by Dialog Box. 

Fist Show the Startup Dialog Box in Drawing Area 
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1.2.3.   Method of Show the Startup Dialog Box. 

i. Main Menu è Tool è Option è Open the option Window è System è          

ii. Show the Startup Dialog è Apply è ok 

 
 

iii. Close the Auto CAD and then Re-open the Auto CAD Software. 

 

!
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iv. Startup Dialog Box 

 

 

Go to use a wizard è Quick setup  

è OK è Open quick setup window  

è set the Unit è next  

è set the Area  

è Finish. 

!

!

!

!

!

 

Open the drawing 

 

Start from scratch 

Use a template 

 

Use a wizard 
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1.2.4.   Z (Zoom)í  è  A (All)/ E (Extend) 

 

 

1.2.5.   Set the Primary Unit 

Short cut = D í 

M.M è Format è Dimension style Manages è Open the dimension style manager window è 

Modify è Open sub window è Go to primary unit Tab è set the primary unit è set the precision 

è OK è Close. 

 

 

 

1.2.6.   Save the file. 

Short cut = Ctrl+S 

M.M è File è Save è Open the Save window è Select location è Write the file Name è Save 
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1.3.  Create 3D Objects with Given Measurements 

 
Execute 3D Commands in AutoCAD (3D solids, surfaces, meshes, and  

Wireframe objects, 3D face and Edges, etc.) 

 
1.3.1.   Basic Mesh Command 

The basic mesh forms, known as mesh primitives, are the equivalent of 

the primitive forms for 3D solids. You can reshape mesh objects by smoothing, creasing, refining, 

and splitting faces. You can also drag edges, faces, and vertices to mold the overall form. 

Basic Mesh commands can be found out through  

Ribbon drop down Menu 

 

1.3.2.   MESH BOX 

Creates a rectangular or cubical mesh box. The base of the mesh box is drawn parallel to the XY 

plane of the current UCS (work plane). 

 

Mesh Box command of 3D Surface can be find out through the following ways 

Through Short Cut Key:  MESH enter à B enter 

Application 

Type MESH at the Command Prompt 

à[Box/Cone/Cylinder/Pyramid/Sphere/Wedge/Torus/Settings] 

<Box>:à B enter (for Box) à Specify Start point àPut the Value of @ X and Y Co-ordinate  

àPut the Value of height àenter 

UCS stands for 

“user 

coordinate 

Remember 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 274 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

 
i. Mesh Box Options 

ii. The Box option of the MESH command provides several methods for determining the 

size and rotation of the mesh boxes you create.  

 

· Cube 

· Length 

· Center Point 

 

· Cube. 

Use the Cube option to create a mesh box with sides of equal length 

· Length. 

Use the Cube or Length option if you want to set the rotation of the box in the XY plane. 

· Center Point. 

Use the Center option to create a box using a specified center point. 

 

1.3.3.   Mesh Cone 

Create a 3D surface with a circular or elliptical base that tapers symmetrically to a point or to 

a circular or elliptical planar face. You can control the smoothness of 3D curved surface, such 

as a cone, in a shaded or hidden visual. Use the Top Radius option to create a cone frustum. 

 
Through Short Cut Key MESH enter à C enter  

 

Application 

Type MESH at the Command Prompt à[Box/Cone/Cylinder/Pyramid/Sphere/Wedge/ 

Torus/SEttings] <Box>:à C enter (for Cone)à Specify center point of base àPut the base radius 

value àPut the Value of Height àenter 

 
Mesh Cone Option 

The Cone option of the MESH command provides several methods for determining the size and 

rotation of the mesh cones you create. 
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i. Center Point 

ii. Axis Endpoint 

iii. Frustum 

iv. 3P 

v. Elliptical 

vi. TTR (Tangent, Tangent, Radius) 

 

1.3.4.   Cube  

Specifies the center point of the Cone. When you specify the center point, the Cone is positioned 

so that its central axis is parallel to the Z axis of the current user coordinate system (UCS). 

Latitudinal lines are parallel to the XY plane. 

 
i. Radius             Defines the radius of the Cone. 

ii. Diameter          Defines the diameter of the Cone. 

 
i. Axis Endpoint  

Use the Axis End point option when you want to reorient the cone by placing the tip or axis 

endpoint anywhere in 3D space. 

 
ii. Frustum 

Use the Top Radius option to create a frustum of a cone, which tapers to an elliptical or planar 

face. 

 
iii. 3P (Three Points) 

The 3P (Three Points) option defines the size and plane of the base of the cone anywhere in 

3D space 

 
iv. Elliptical 

Use the Elliptical option to create a cone base whose axes are of different lengths. 
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v. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. Depending 

on the radius distance, the new cone is located as near as possible to the tangent points you 

specify. You can set up tangency with circles, arcs, lines, and some 3D objects. The tangency 

points are projected into the current UCS. The appearance of tangency is affected by the 

current level of smoothness. 

 
 
 

1.3.5.   Mesh Cylinder: - 

Creates a 3D surface with a circular or elliptical base that extends 

to the other circular or elliptical planar face. You can control the 

smoothness of curved 3D solids, such as a cylinder, in a shaded or 

hidden visual style with the FACETRES system variable. 

 
Through Short cut Key:  MESH enter à CY enter 

 

Application:  

Type MESH at the Command Prompt 

à[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/ 

Torus/Settings]<Box>:àCY enter (for Cylinder)à Specify center point 

of base àPut the base radius value àPut the Value of Height àenter 

 

 
 

· Mesh Cylinder Options: 

The Cylinder option of the MESH command provides several methods for determining the size 

and rotation of the mesh cylinders you create 

i. Axis Endpoint 

ii. 3P (Three Point 

iii. Elliptical 

iv. TTR (Tangent, Tangent, Radius) 

 

Remember 
 

During a drawing 

session, the default 

value for the base 

radius is always as 

the previously 

entered base 

radius. 

. 
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i. Axis Endpoint 

Use the Axis Endpoint option to set the height and rotation of the cylinder. The center point of 

the top plane of the cylinder is the axis endpoint, which can be located anywhere in 3D space. 

 

ii. 3P (Three Points) 

Use the 3P (Three Points) option to define the base of the cylinder. You can set three 

points anywhere in 3D space. 

 
iii. Elliptical 

Use the Elliptical option to create a cylinder base whose axes are of different lengths. 

 
1.3.5.1. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. 

Depending on the radius distance, the new cylinder is located as near as possible to the 

tangent points you specify. You can set up tangency with circles, arcs, lines, and some 3D 

objects. The tangency points are projected onto the current UCS. The appearance of 

tangency is affected by the current level of smoothness. 

 

1.3.6.   Mesh Pyramid 

By default, a pyramid is defined by the center of the base point, a point on the middle of the edge, 

and another point that determines the height. Initially, the default base radius is not set to any value. 

During a drawing session, the default value for the base radius is always the previously entered 

base radius value for any solid primitive. 

 

Use the Top Radius option to create a pyramid frustum 

 
Through Short cut Key : MESH enter à P enter  

 

APPLICATION 

Type MESH at the Command Prompt à[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/ 

Torus/SEttings] <Box>:à Penter (for Pyramid)à Specify center point of baseàPut the base radius 

valueàPut the Value of Heightàenter 

 

· Mesh Pyramid Option 

The Pyramid option of the MESH command provides several methods for determining the size 

and rotation of the mesh pyramids you create. 
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i. Sides 

ii. Edges 

iii. Frustum 

iv. Axis Endpoint 

v. Inscribed or circumscribed perimeter 

 
 
 

i. Sides. 

Use the Sides option to set the number of sides for the mesh pyramid. 

 
ii. Edges. 

Use the Edges option to specify the dimension of the sides at the base. 

 
iii. Frustum 

Use the Top Radius option to create a frustum, which tapers to a planar face. The frustum 

face is parallel to and has the same number of sides as, the base. 

 
iv. Axis Endpoint 

Use the Axis Endpoint option to specify the height and rotation of the pyramid. This endpoint 

is the top of the pyramid. The axis endpoint can be located anywhere in 3D space. 

 
v. Inscribed or Circumscribed Perimeter. 

Specify whether the pyramid base is drawn inside or outside of the radius. 

 
 



Trainer and Learner Guide: Information Technology (CAD) | 279 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

 
Circumscribed                                       Inscribed 
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1.3.7.   Mesh Sphere 

You can create a sphere by specifying a center point and a point on the radius. You can control 

the smoothness of curved 3D solids, such as a sphere, in a Shaded or hidden visual style with the 

FACETRES system variable. 

 
 

Through Short Cut Key MESH enter à S enter  

 

APPLICATION 

Type MESH at the Command Prompt à[Box/Cone/CYlinder/ Pyramid/ 

Sphere/Wedge/Torus/SEttings] <Box>:à S enter (for Sphere)àSpecify center point àPut the 

radius valueàenter 

 

· Mesh Sphere Option 

i. Center point 

ii. 2p (Two Point) 

iii. 3p (Three Point) 

iv. TTR (Tangent, Tangent, Radius) 

 
 

i. Center Point 

Specifies the center point of the sphere. When you specify the center point, the sphere is 

positioned so that its central axis is parallel to the Z axis of the current user coordinate system 

(UCS). Latitudinal lines are parallel to the XY plane. 

 

Radius             Defines the radius of the sphere. 

Diameter          Defines the diameter of the sphere. 

 

ii. 3P (Three Points) 

Defines the circumference of the sphere by specifying three points anywhere in 3D space. The 

three specified points also define the plane of the circumference. 

 

iii. 2P (Two Points) 

Defines the circumference of the sphere by specifying two points anywhere in 3D space. The 

plane of the circumference is defined by the Z value of the first point. 

 



Trainer and Learner Guide: Information Technology (CAD) | 281 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

iv. TTR (Tangent, Tangent, Radius) 

Defines the sphere with a specified radius tangent to two objects. The specified tangency points 

are projected onto the current UCS. 

 
1.3.8.   Mesh Wedge 

Creates a mesh wedge with rectangular or cubical faces. The base of the wedge is drawn parallel 

to the XY plane of the current UCS with the sloped face opposite the first corner. The height of the 

wedge is parallel to the Z axis. 
 

Through Short cut Key MESH enter à W enter  

 

Application 

Type MESH at the Command Prompt à[Box/Cone/CYlinder/ 

Pyramid/Sphere/Wedge/Torus/SEttings] <Box>:à W enter (for Wedge)à Specify Start 

pointàPut the Value of @ X and Y Co-ordinateàPut the Value of Heightàenter 

 

· Mesh Wedge Option 

The Wedge option of the MESH command provides several methods for determining the size 

and rotation of the mesh wedges you create. 
 

i. Center  

ii. Cube 

iii. Length 

iv. 2 Point (With Height) 

 
i. Center 

Create the wedge by using a specified center point 

ii. Cube 

Set all edges of the mesh wedge base to be of equal length. 

iii. Length 

Creates a wedge with length, width, and height values you specify. The length corresponds to 

the X axis, the width to the Y axis, and the height to the Z axis. If you pick a point to specify 

the length, you also specify the rotation in the XY plane. 

iv. 2 point (with Height) 

Specifies that the height of the wedge is the distance between the two specified points. 
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1.3.9.   Mesh Torus 

Creates a ring-shaped surface that resembles the inner tube of a tire. A mesh torus has two radius 

values. One value defines the tube. The other value defines the path, which is equivalent to the 

distance from the center of the torus to the center of the tube. By default, a torus is drawn 

parallel to and is bisected by the XY plane of the current UCS. 

 

 

 
A mesh torus can be self-intersecting. A self-intersecting mesh torus has no center hole because 

the radius of the tube is greater than the radius of the torus. 

 

Through Short cut Key: MESH enter à T enter 

 

 

APPLICATION 

Type MESH at the Command Prompt à[Box/Cone/CYlinder/ 

Pyramid/Sphere/Wedge/Torus/SEttings] <Box>:à T enter (for Torus)à Specify center point àPut 

the radius valueàPut the Tube radius Value àenterMesh Torus Option 

The Torus option of the MESH command provides several methods for determining the size and 

rotation of the mesh tours you create. 

 
i. 3P 

ii. 2p 

iii. TTR 

iv. Radius 

 
 

i. 3P (Three Points) 

Use the 3P (Three Points) option to define the size of the mesh torus anywhere in 3D space. 

The three points also define the plane of the circumference. Use this option to rotate the 

mesh torus as you create it. 

 
ii. 2P (Two Points) 

Use the 2P (Two Points) option to define the size of the mesh torus anywhere in 3D space. The 

plane of the circumference matches the Z value of the first point. 
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iii. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. 

Depending on the specified radius distance, the path of the torus is located as near as possible 

to the tangent points you specify. You can set up tangency with circles, arcs, lines, and some 

3D objects. The tangency points are projected into the current UCS. The appearance of 

tangency is affected by the current level of smoothness. 

 
 

iv. Radius 

Defines the radius of the torus: the distance from the center of the torus to the center of the 

tube. A negative radius creates a solid shaped like an American football. 

Solid Primitive Commands 

The basic solid forms, known as solid primitives, are the equivalent of the primitive forms for 3D 

solids. 

You can create several basic 3D shapes, known as solid primitives: boxes, cones, cylinders, 

spheres, wedges, pyramids, and torus (donuts). 

By combining primitive shapes, you can create more complex solids. For example, you 

can join two solids, subtract one from the other, or create a shape based on the intersection 

of their volumes. 

 
1.3.10. Solid Primitives 

Solid primitives can easily be drawn from the Home Tab & Solid Tab 

 
i. Box 

ii. Cone 

iii. Cylinder 

iv. Pyramid 

v. Sphere 

vi. Wedge 

vii. Tours 
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1.3.10.1. Box 

The base of the box is always drawn parallel to the XY plane of the current UCS (work 

plane). The height of the box is specified in the Z-axis direction. You can enter both positive 

and negative values for the height. 

 
Through Short Cut Key àBOX enter 

 
Application 

 
Type Box at the Command Prompt àSpecify Start pointàPut the Value of @ X and Y 

Co-ordinateà Put the value of height àenter 

 

·  Box Options 

Use the following options to control the size and rotation of the boxes you create: 

 

 

i. Cube 

ii. Length 

iii. Center Point 

 
i. Cube 

Use the Cube option of the BOX command to create a box       with sides of equal length. 

 
ii. Length 

Create a box with length, width, and height values you specify. If you enter values, the 

length corresponds to the X axis, the width to the Y axis, and the height to the Z axis. If 

you pick a point to specify the length, you also specify the rotation in the XY plane. 

 
iii. Center point. 

Use the Center option to create a box using a specified center point. 
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1.3.10.2. Cone 

Create a 3D solid with a circular or elliptical base that tapers symmetrically to a  p o in t  o r  

t o  a  c i r cu la r  o r  elliptical planar face. You can control the smoothness of 3D curved 

solids, such as a cone, in a shaded or hidden visual style with the FACETRES system 

variable. 

Use the Top Radius option to create a cone frustum. 

Initially, the default base radius is not set to any value. During a drawing session, the 

default value for the base radius is always the previously entered base radius value for 

any solid primitive. 

 
Through Short Cut Key à Cone enter 

 
Application 

Type Cone at the Command Prompt à Specify center point of baseàput the base radius 

valueàPut the Value of Heightàenter 

 

·  Cone Option 

Use the following options to control the size and rotation of the cones you create. 

 
i. Center Point 

ii. Axis Endpoint  

iii. Frustum 

iv. 3P 

v. Elliptical 

vi. TTR (Tangent, Tangent, Radius) 

 
i. Center Point 

When you specify the center point, the Cone is positioned so that its central axis is 

parallel to the Z axis of the current user coordinate system (UCS). Latitudinal lines are 

parallel to the XY plane. 
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ii. Axis Endpoint 

Use the Axis Endpoint option when you want to reorient the cone by placing the tip or axis 

endpoint anywhere in 3D space. 

 

iii. Frustum 

Use the Top Radius option to create a frustum of a cone, which tapers to an elliptical or 

planar face. 

 
iv. 3P (Three Points) 

The 3P (Three Points) option defines the size and plane of the base of the cone 

anywhere in 3D space. 

 
v. Elliptical 

Use the Elliptical option to create a cone base whose axes are of different lengths. 

 
vi. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. 

Depending on the radius distance, the new cone is located as near as possible to the 

tangent points you specify. You can set up tangency with circles, arcs, lines, and some 

3D objects. The tangency points are projected into the current UCS. The appearance of 

tangency is affected by the current level of smoothness. 

 

 

1.3.10.3. Cylinder 

In the illustration, the cylinder was created using a center point (1), a point on the radius 

(2), and a point for the height (3). The base of the cylinder is always on a plane parallel 

with the work plane. You can control the smoothness of curved 3D solids, such as a 

cylinder, in a shaded or hidden visual style with the FACETRES system variable. 

 
Through Short Cut Key            à Cylinder enter 

 

Application 

Type Cyl at the Command Prompt à Specify center point of baseàput the base radius 

valueàPut the Value of Height àenter 

 
 

· Cylinder Options 

 
i. Axis Endpoint 

ii. 3P (Three Point 

iii. Elliptical 

iv. TTR (Tangent, Tangent, Radius) 
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i. Axis End point 

Use the Axis Endpoint option to set the height and rotation of the cylinder. The center 

point of the top plane of the cylinder is the axis endpoint, which can be locate anywhere in 

3D space. 

 
ii. 3P (Three Points) 

Use the 3P (Three Points) option to define the base of the cylinder. You can set three 

points anywhere in 3D space. 

 
iii. Elliptical 

Use the Elliptical option to create a cylinder base whose axes are of different lengths. 

 
iv. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. 

Depending on the radius distance, the new cylinder is located as near as possible to the 

tangent points you specify. You can set up tangency with circles, arcs, lines, and some 

3D objects. The tangency points are projected onto the current UCS. 

 

 
1.3.10.4. Pyramid 

By default, a pyramid is defined by the center of the base point, a point on the middle of 

the edge, and another point that determines the height. Initially, the default base radius is 

not set to any value. During a drawing session, the default value for the base radius is 

always the previously entered base radius value for any solid primitive. 

 

Use the Top Radius option to create a pyramid frustum. 

 
Through Short Cut Key à Pyr enter 

 

Application 

Type Pyr at the Command Prompt à Specify center point of baseàput the base radius 

valueàPut the Value of Heightàenter 

 

·  Pyramid Option 

The Pyramid option provides several methods for determining the size and rotation of the 

pyramids you create. 
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i. Sides 

ii. Edges 

iii. Frustum 

iv. Axis Endpoint 

v. Inscribed or circumscribed perimeter 

 
 

i. Sides 

Use the Sides option to set the number of sides for the pyramid. 

 
ii. Edges. 

Use the Edges option to specify the dimension of the sides at the base. 

 
iii. Frustum 

Use the Top Radius option to create a frustum, which tapers to a planar face. The 

frustum face is parallel to and has the same number of sides as, the base. 

 
iv. Axis Endpoint 

Use the Axis Endpoint option to specify the height and rotation of the pyramid. This 

endpoint is the top of the pyramid. The axis endpoint can be located anywhere in 3D space. 

 

v. Inscribed or circumscribed perimeter. 

Specify whether the pyramid base is drawn inside or outside of the radius 

 



Trainer and Learner Guide: Information Technology (CAD) | 289 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

 

Circumscribed                          Inscribed 
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1.3.10.5. Sphere 

You can create a torus by specifying the center, then the radius or diameter of the torus, 

and then the radius or diameter of the tube that surrounds the torus. You can control the 

smoothness of curved 3D solids, such as a torus, in a shaded or hidden visual style with 

the FACETRES system variable. 

 

Through Short Cut Key à Sphere enter 

 

Application 

Type Sphere at the Command Prompt àSpecify center point àPut the radius valueàenter 

 

 

·  Sphere Option 

Use the following options to draw a sphere with the 

SPHERE command: 

 
i. Center point 

ii. 2p (Two Point) 

iii. 3p (Three Point) 

iv. TTR(Tangent, Tangent, Radius) 

 

i. Center Point 

Specify the center point of the sphere. When you specify the center point, the sphere is 

positioned so that its central axis is parallel to the Z axis of the current user coordinate 

system (UCS). Latitudinal lines are parallel to the XY plane. 

 
Radius             Defines the radius of the sphere. 

Diameter          Defines the diameter of the sphere. 

 
ii. 2P (Two Points) 

Define the circumference of the sphere by specifying two points anywhere in 3D space. 

The plane of the circumference is defined by the Z value of the first point. 

 
iii. 3P (Three Points) 

Define the circumference of the sphere by specifying three points anywhere in 3D space. 

The three specified points also define the plane of the circumference. 

 
iv. TTR (Tangent, Tangent, Radius) 

Define the sphere with a specified radius tangent to two objects. The specified tangency 

points are projected onto the current UCS. 
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1.3.10.6. Wedge 

The direction of the taper is always in the positive X-axis direction of the UCS. Entering a 

positive value draws the height along the positive Z axis of the current UCS. Entering a 

negative value draws the height along the negative Z axis 

 
 
 

Through Short Cut Key            à Wedge enter 

 

Application  

Type Wedge at the Command Prompt Specify Start point Put the Value of @ X and Y 

Co-ordinate Put the Value of Height enter 

 

 

·  Wedge Option 

The Wedge option provides several methods for determining the size and rotation of the 

wedges you create. 

 
i. Center 

ii. Cube  

iii. Length  

iv. 2pints with weight) 

 
 

i. Center 

Create the wedge by using a specified center point. 

 
ii. Cube 

Set all edges of the mesh wedge base to be of equal length. 

 
iii. Length 

Create a wedge with length, width, and height values you specify. The length corresponds 

to the X axis, the width to the Y axis, and the height to the Z axis. If you pick a point to 

specify the length, you also specify the rotation in the XY plane. 
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iv. 2 point (with Height) 

Specify that the height of the wedge is the distance between the two specified points. 

1.3.10.7. Torus 

You can create a torus by specifying the center, then the radius or diameter of the torus, 

and then the radius or diameter of the tube that surrounds the torus. You can control the 

smoothness of curved 3D solids, such as a torus, in a shaded or hidden visual style with 

the FACETRES system variable. 

 
Through Short Cut Key            à Tor enter 

 

Application 

Type Tor at the Command Prompt à Specify center point of TorusàPut the radius value 

of Torus àPut the Tube radius Value àenter 

 
 
 

·  Torus Option 

The Torus option provides several methods for Determining the size and rotation of the 

mesh tours you create. 

 

3P 

i. 2p 

ii. TTR 

iii. Radius 

 

i. 3P (Three Points) 

Use the 3P (Three Points) option to define the size of the torus anywhere in 3D space. 

The three points also define the plane of the circumference. Use this option to rotate the 

torus as you create it. 

 
ii.  2P (Two Points) 

Use the 2P (Two Points) option to define the size of the torus anywhere in 3D space. The 

plane of the circumference matches the Z value of the first point. 
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iii. TTR (Tangent, Tangent, Radius) 

Use the TTR (Tangent, Tangent, and Radius) option to define points on two objects. 

Depending on the specified radius distance, the path of the torus is located as near as 

possible to the tangent points you specify. You can set up tangency with circles, arcs, 

lines, and some 3D objects. The tangency points are projected into the current UCS. 

 
iv. Radius 

Define the radius of the torus: the distance from the center of the torus to the center 

of the tube. A negative radius creates a solid shaped like an American football. 

 
 

1.3.11. Poly Solid Command 

 

You can create walls with straight and curved segments of constant height and width. With the 

POLYSOLID command, you can convert an existing line, 2D polyline, arc, or circle to a solid with 

a rectangular profile. A polysolid can have curved segments, but the profile is always rectangular 

by default. You can draw a solid with POLYSOLID just as you would a polyline. The PSOLWIDTH 

system variable sets the default width for the solid. The PSOLHEIGHT system variable sets the 

default height for the solid. 

 
Through Short Cut Key            à Ploysoild enter 

 

Application 

Type polysolid at  the  Command Prompt à  Specify start  point or  [Object/Height/Width/Justify] 

<Object>àSpecify next point or [Arc/Undo]à Specify next point or [Arc/Undo] àenter 

 

 

· POLY SOLID OPTIONS 

Use the following options to control the size and shape of the polysolid you create. 

 
i. Object 

ii. Height  

iii. Width  

iv. Justify 
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i. Object 

Specify an object to convert to a solid. You can convert: 

 

a. Line 

b. Arc 

c. 2D polyline 

d. Circle 

 
i. Height 

Specify the height of the solid 

 
ii. Width 

Specify the width of the solid. 

 
iii. Justify 

Set the width and height as the solid to be left, right, or center justified when defining the profile 

with the command. The justification is based on the starting direction of the first segment of the 

profile. 

 
1.3.12. Wireframes 

A wireframe model is a skeletal description of a 3D object. There are no surfaces in a wireframe 

model; it consists only of points, lines, and curves that describe the edges of the object. With 

AutoCAD you can create wireframe models by positioning 2D objects anywhere in 3D space. 

AutoCAD also provides some 3D wireframe objects, such as 3D polylines (that can only have a 

CONTINUOUS linetype) and splines. Because each object that makes up a wireframe model must 

be independently drawn and positioned, this type of modeling can be the most time-consuming. 

Wireframe lines in 3D 
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1.3.13. Solids 

Solid modeling is the easiest type of 3D modeling to use. With the AutoCAD solid modeler, you can 

make 3D objects by creating basic 3D shapes: boxes, cones, cylinders, spheres, wedges, and tori 

(do- nuts). You can then combine these shapes to create more complex solids by joining or 

subtracting them or finding their intersecting (over- lapping) volume. You can also create solids by 

sweeping a 2D object along a path or revolving it about an axis. 

 

 

1.3.13.1. 2D Solid 

Creates solid-filled triangles and quadrilaterals. 

Type SOLID at the command prompt. 
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Command: SOLID  

First point: P1 

Second point: P2 

Third point: P3 

Fourth point: P4 

Third point: enter 

 

1.3.14. 3D Faces 

3DFACE creates a three or four sided surface anywhere in 3D space. You can specify different Z 

coordinates for each corner point of a 3D face. 

3DFACE differs from SOLID, which creates a three- or four-sided surface that is parallel to the 

current UCS and can be extruded. 

i. Begin a new drawing. 

ii. Set the visual style to Conceptual. 

iii. Type 3DFACE at the command prompt. 

Command: 3DFACE 

First point: pick 

Second point: pick 

Third point: pick 

Fourth point: pick 

Third point: enter 

 

3D Wireframe Lines     3D faces 
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1.3.14.1. 3D Face Invisible Edge 

With 3DFACE, you control which edges of a 3D face are visible, allowing accurate 

modeling of objects with holes. Entering i or invisible before the first point of an edge makes 

the edge invisible.Type 3DFACE at the command prompt. 

 

i. Draw an irregular shaped object similar to the one 

shown below. 

ii. Set the visual style to Conceptual. 

iii. Type 3DFACE at the command prompt. 

 

Command: 3DFACE  

First point: P1 

Second point: P2 

Third point: i P3 

Fourth point: P4 

Third point: i P5 

Fourth point: P6 

Third point: P7  

Fourth point: P8 

Third point: enter 

 

NOTE: You must enter an “i” for invisible before the face is chosen. 
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1.3.15. Edge Command 

 

i. Type EDGE at the command prompt. 

Command: EDGE 

Specify edge of 3dface to toggle visibility or [Display]: 

pick edge 

 

Pick edge 

Specify edge of 3dface to toggle visibility or [Display]: D 

Enter selection method for display of hidden edges [Select/All] <All>: A 

** Regenerating 3DFACE objects...done. 

Specify edge of 3dface to toggle visibility or [Display]: press enter 
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PFace 

Creates a three-dimensional polyface mesh vertex by vertex 

i. Type PFACE at the command prompt. 

Command: PFACE 

Specify location for vertex 1: pick point 1 

Specify location for vertex 2 or <define faces>: pick point 2 Specify location for vertex 3 or <define 

faces>: pick point 3 Specify location for vertex 4 or <define faces>: pick point 4 Specify location 

for vertex 5 or <define faces>: pick point 5 Specify location for vertex 6 or <define faces>: pick 

point 6 Specify location for vertex 7 or <define faces>: pick point 7 Specify location for vertex 8 

or <define faces>: enter 

Face 1, vertex 1: 

Enter a vertex number or [Color/Layer]: 1 (enter) 

Face 1, vertex 2: 

Enter a vertex number or [Color/Layer] <next face>: 2 (enter) 

Face 1, vertex 3: 

Enter a vertex number or [Color/Layer] <next face>: 6 (enter) 

Face 1, vertex 4: 

Enter a vertex number or [Color/Layer] <next face>: 7 (enter) 

Face 1, vertex 5: enter 

Enter a vertex number or [Color/Layer] <next face>: Face 2, vertex 1: 

Enter a vertex number or [Color/Layer]: 2 (enter) 

Face 2, vertex 2: 

Enter a vertex number or [Color/Layer] <next face>: 3 (enter) 

Face 2, vertex 3: 

Enter a vertex number or [Color/Layer] <next face>: 4 (enter) 

Face 2, vertex 4: 

Enter a vertex number or [Color/Layer] <next face>: 6 (enter) 

Face 2, vertex 5: 

Enter a vertex number or [Color/Layer] <next face>: Face 3, vertex 1: 

Enter a vertex number or [Color/Layer]: 4 (enter) 

Face 3, vertex 2: 

Enter a vertex number or [Color/Layer] <next face>: 5 (enter) 

Face 3, vertex 3: 
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Enter a vertex number or [Color/Layer] <next face>: 6 (enter) 

Face 3, vertex 4: 

Enter a vertex number or [Color/Layer] <next face>: Face 4, vertex 1: enter 

Enter a vertex number or [Color/Layer]: 

 

Basic Mesh Commands 

i. Click the 3D Modeling dropdown option from the Solids panel. 

ii. Click the Mesh tab. 

iii. Click the Primitives panel. 

iv. Click the Primitive drop-down. 

 

 

Mesh Primitive Options 

The following settings can be adjusted for mesh primitives. 
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1.3.15.1. Mesh Box 

Choose Mesh box from the Primitives panel. 

Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/ SEttings] <Box>: _BOX 

Specify first corner or [Center]: pick point Specify other corner or [Cube/Length]: @4,2 

Specify height or [2Point] <3.0000>: 2 
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1.3.15.2. Mesh Cone 

Choose Mesh cone from the Primitives panel. Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S Ettings] <C one>: CONE 

Specify center point of base or [3P/2P/Ttr/Elliptical]: Specify base radius or [Diameter] 

<1.5074>: 2 Specify height or [2Point/Axis endpoint/Top radius] <2.0000>: 5 

 

 

1.3.15.3. Mesh Cylinder 

Choose Mesh cylinder from the Primitives panel. Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/ SEttings] 

<Cylinder>: CYLINDER 

Specify center point of base or [3P/2P/Ttr/Elliptical]: Specify base radius or [Diameter] 

<2.0000>: 2 Specify height or [2Point/Axis endpoint] <5.0000>: 8 
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1.3.15.4. Mesh Pyramid 

Choose Mesh pyramid from the Primitives panel. 

Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S Ettings] 

<Pyramid>: PYRAMID 

4 sides Circumscribed 

Specify center point of base or [Edge/Sides]: Specify base radius or [Inscribed] <2.0000>: 

Specify height or [2Point/Axis endpoint/Top radius] 

<8.0000>: 4 

 

 

1.3.15.5. Mesh Sphere 

Choose Mesh sphere from the Primitives panel.  

Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S Ettings] 

<Pyramid>: SPHERE 

Specify center point or [3P/2P/Ttr]: Specify radius or [Diameter] <2.0000>: 
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1.3.15.6. Mesh Wedge 

Choose Mesh wedge from the Primitives panel. 

Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S Ettings] 

<Wedge>: WEDGE 

Specify first corner or [Center]: 

Specify other corner or [Cube/Length]: @4,2 

Specify height or [2Point] <4.0000>: 2 
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1.3.15.7. Mesh Torus 

Choose Mesh torus from the Primitives panel. 

Command: MESH 

Current smoothness level is set to : 0 Enter an option 

[Box/Cone/CYlinder/Pyramid/Sphere/Wedge/Torus/S Ettings] 

<Wedge>: TORUS 

Specify center point or [3P/2P/Ttr]: Specify radius or [Diameter] <2.0000>: 6 Specify tube 

radius or [2Point/Diameter]: 1 

 

 

1.3.15.8. Mesh Tesselations 

By default, new mesh primitives are created with no smoothness. To change the default 

smoothness, enter mesh at the Command prompt. Specify the Settings option before you 

specify the type of mesh primitive you want to create. 

Type MESH at the command prompt. 

Command: MESH 

Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge 

/Torus/SEttings] 

<Box>: SE 

Specify level of smoothness or [Tessellation] <0>: 3  

Enter an option [Box/Cone/CYlinder/Pyramid/Sphere/Wedge/ Torus/SEttings] 

<Box>: BOX 

Specify first corner or [Center]: pick point 

Specify other corner or [Cube/Length]: @5,5 

Specify height or [2Point] <3.0000>: 
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1.3.15.9. Mesh Smooth 

Converts 3D faces (3DFACE) and legacy polygonal and polyface meshes (from AutoCAD 

2009 and earlier). You can also convert 2D objects such as regions and closed polylines. 

The default mesh settings are defined in the Mesh Tessellation Options dialog box. The 

level of smoothness upon conversion depends on the mesh type setting in this dialog box. 

If the mesh type is not set to be optimized, the converted object is not smoothed 

Type MESHSMOOTH at the command prompt. 

Command: MESHSMOOTH 

Select objects to convert: pick object 

Select objects to convert: press enter 

Click Create mesh. 
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Polyline before MESHSMOOTH   2D Polyline after MESHSMOOTH 

 

1.3.15.10. Smooth and Refine Meshes 

The following commands control the smoothness of mesh objects. 

 

 

Meshsmoothmore 

Increases the level of smoothness for mesh objects by one level. 

 

Type MESHSMOOTHMORE at the command prompt. 

Command: MESHSMOOTHMORE 

Select mesh objects to increase the smoothness level: pick object. 
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Mesh before smooth increase   Mesh after smooth increase 

 

1.3.15.11. Meshsmoothless 

Decreases the level of smoothness for mesh objects by one level. 

 

Type MESHSMOOTHLESS at the command prompt. 

Command: MESHSMOOTHLESS 

Select mesh objects to increase the smoothness level: pick object. 
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Mesh before smooth decrease   Mesh after smooth decrease 

1.3.15.12. Meshsmoothrefine 

Multiplies the number of faces in selected mesh objects or faces. 

.Type MESHREFINE at the command prompt. 

Command: '_MESHREFINE 

Select mesh object or face subobjects to refine: 

Pick object 

Select mesh object or face subobjects to refine: 1 object(s) found. 

 

 

Mesh refine before   Mesh refine after 
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1.3.15.13. Add and Remove Mesh Creases 

Meshcrease 

Sharpens the edges of selected mesh subobjects. 

Type MESHCREASE at the command prompt. 

Command: MESHCREASE 

Select mesh subobjects to crease: select objects 

Specify crease value [Always] <Always>: enter 

 

 

Before crease   Selected objects   After crease 

TIPS: 

Crease value 

Sets highest smoothing level at which the crease is retained. If the smoothing level exceeds 

this value, the crease is also smoothed. Enter a value of 0 to remove an existing crease. 

Always 

Specifies that the crease is always retained, even if the object or subobject is smoothed or 

refined. A crease value of -1 is the same as Always 

· Editing Meshes 

i.  Meshextrude 

Extends a mesh face into 3D space. 

 

Type MESHEXTRUDE at the command prompt. 

 

Command: _MESHEXTRUDE Adjacent extruded faces set to: Join 
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Select mesh face(s) to extrude or [Setting]: 

pick object(s) 

Select mesh face(s) to extrude or [Setting]: Specify height of extrusion or [Direction/Path/ 

Taper angle] <0.5000>: 1 

 

Selected mesh face     Extruded mesh faces 

 

ii. Meshsplit 

Splits a mesh face into 2 faces. 

1Type MESHSPLIT at the command prompt. 

Command: _MESHSPLIT 

Select a mesh face to split: (pick object) 

 

Specify first split point on face edge or [Vertex]:MID of 

Specify second split point on face edge or [Vertex]: 

MID of 
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MIDpoint 

iii. Mergeface 

Merges adjacent faces into a single face. 

Type MESHMERGE at the command prompt. 

 
Selected mesh faces    Resultant merge 

Command: _MESHMERGE 

Select adjacent mesh faces to merge: (pick object) Select adjacent mesh faces to merge: 

(pick object) Select adjacent mesh faces to merge: press enter 

 

iv. Meshcap (Close Hole) 

Creates a mesh face that connects open edges. 

Type MESHCAP at the command prompt. 

Command: _MESHCAP 
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Select connecting mesh edges to create a new mesh face: (pick objects) 

Select connecting mesh edges to create a new mesh face: press enter 

 
Mesh object before   Selected mesh edges 

 
 

v. Converting Meshes 

Converts objects to surfaces. Objects that can be converted to surfaces include the 

following: 2D solids, 3D solids, Regions, open, zero-width polylines with thickness, lines 

with thickness, arcs with thickness, mesh objects, planar 3D faces 

Type CONVTOSURFACE at the command prompt. 

Command: CONVTOSURFACE 

Mesh conversion set to: Smooth and optimized. Select objects: pick object 

Select objects: press enter 

 

 

 

 

 

 

 

Closed “hole” 
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PLine with thickness    New converted mesh 

 
Smooth options 

 

vi. Revolved Surfaces 

Regenerates a three-dimensional model with hidden lines 

Type REVSURF at the command prompt. 

Command: REVSURF Current wire frame density: SURFTAB1=6 SURFTAB2=6 

Select object to revolve: pick path curve Select object that defines the axis of revolution: 

pick line 

Specify start angle <0>: enter 

Specify included angle (+=ccw, -=cw) <360>: enter 
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vii. Surftab Variables 

Sets the number of tabulations for both directions to be generated for RULESURF and 

TABSURF. Also sets the mesh density in ROTATE3D the M direction for REVSURF and 

EDGESURF commands. 

Type Surftab1 at the command prompt. 

Command: SURFTAB1 

Enter new value for SURFTAB1 <6>: 30 

Type Surftab2 at the command prompt. 

Command: SURFTAB2 

Enter new value for SURFTAB2 <6>: 30 

 
Type Revsurf at the command prompt. 

Command: REVSURF 
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Current wire frame density: SURFTAB1=30 SURFTAB2=30 

Select object to revolve: pick path curve 

Select object that defines the axis of revolution: 

pick line 

Specify start angle <0>: enter 

Specify included angle (+=ccw, -=cw) <360>: 

press enter 

 

 

viii. Tabulated Surfaces 

Type TABSURF at the command prompt. 

Command: TABSURF 

Select object for path curve: Select object for direction vector: 
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1.3.15.14. Ruled Surfaces 

Type RULESURF at the command prompt. Command: rulesurf 

Current wire frame density: SURFTAB1=6 Select first defining curve: P1 

Select second defining curve: P2 

 

1.3.15.15. Edge Surfaces 

Regenerates a three-dimensional model with hidden lines 

Type EDGESURF at the command prompt. 

Command: EDGESURF Current wire frame density: SURFTAB1=20 SURFTAB2=10 

Select object 1 for surface edge: P1 Select object 2 for surface edge: P2 Select object 3 

for surface edge: P3 Select object 4 for surface edge: P4 



Trainer and Learner Guide: Information Technology (CAD) | 319 

  Module-3 (LU-1): Develop 3D Model using AutoCAD 

 
  

 

 

1.3.15.16. Planesurf 

Creates a planar surface by selecting a closed object or by creating a rectangular plane. 

Type PLANESURF at the command prompt. 

Command: PLANESURF 

Specify first corner or [Object] <Object>: press enter 

Select objects: pick object 

Select objects: press enter 

Planar surface 
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Project for Students: 

 

Practice # 1 

Create a cylindrical shape object with Radius of 6” and Height 12” by using cylinder command. 

Through Short Cut Key            à Cylinder enter 

Application 

Type Cyl at the Command Prompt 

 à Specify center point of base 

à type the base radius value 6” 

àType the Value of Height 12” 

 àpress enter key 

 

 

Practice # 2 

Create a cylindrical shape object with radius of 6” and height 12” by using extrudes command. 

Through Short Cut Key            à Ext enter 

Application  

Step 1  

Type “C” and press enter key. 

 à Specify base point of circle: click on screen for center point. 

àType the Radius of circle 6” and press enter key. 

Now the circle of radius 6” has been created. 

Step 2  

Type “EXT” and press enter key. 

à Select Object: select the circle drawn on the screen. And press enter key. 

à Specify height of extrusion of the circle 12” and press enter key 
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Practice-3 

Develop a BOX with Dimensions of  

3’-0 x 4’-0 x 8’-0. 

Type “BOX” in the command line and press enter key. 

Or 

Select Box option from modeling category of Home Tab. 

àSpecify first corner (Center): click on the screen the first corner.  

Specify other corner or (Cube/ Length): Type: L and  p ress  en te r  key .  

Specify Length: Type: 3’ and  p ress  en te r  key .  

Specify width: Type: 4’ and  p ress  en te r  key .  

Specify height or [2Point] <12.0000>: 8’ and press enter key. 
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Practice-4 

Develop a Pyramid with 10” radius with the Height of 12”. 

Through Short Cut Key(alias):    PYR  

Full name of command: PYRAMID 

Type “PYR” in the command line and press enter key. 

Or 
Select Pyramid option from modeling category of Home Tab. 

Command: _pyramid 

 4 sides Circumscribed 

 Specify center point of base or [Edge/Sides]: click on screen 

 Specify base radius or [Inscribed] <6.0000>: Type ”I” and press enter key 

 Specify base radius or [Circumscribed] <6.0000>: Type ”10” and press enter key 

 Specify height or [2Point/Axis endpoint/Top radius] <96.0000>: Type ”10” and press enter key  
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Learning Unit 2:  

Manipulate 3D Objects Using 3d Editing 

Tools 

 

 

Objective: 

In this learning unit you will learn how to use modifying tools for 3D 

objects editing, prepare 3D models. 

After completion of this learning unit you will be able to understand 

following. 

 

Learning Outcomes:  

v Modify 3D objects in line with the requirements. 

v Make customized 3D models according to the requirement of 

given job. 

v Convert 3D Face objects into a single mesh object. 
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2. Manipulate 3D Objects Using 3D Editing Tools: -

 

The manipulating 3D objects by modifiing commands is known as editing the 3D modules. For the purpose 

different 3D commands for modification to be used like as  Boolean operations (Subtract and add etc.) other 

common commands for the purpose are revolve, revovlesurfs, rotate 3D, 3D array etc. 

 

2.1. Modify 3D objects in line with the requirements. 

 

In this unit, you will learn about the development of 3D solid composites. You can combine, subtract or 

intersect two or more 3D solids by using Boolean operating, able to adjust the thickness of 3D solid, you 

can draw a temporary 3D solid by interesting two sets of 3D solids. 

Execute Boolean operation to modify 3d objects (subtraction, intersection, union, etc.) 

 

2.1.1. Boolean Operations: - 

The Boolean commands work only on solids or regions. To create a solid model at initial stage in 

obtaining one or more primitives. The next stage consists in using Boolean operations of Union, 

Subtract or Intersect in order to create the solid model 

i. Union 

ii. Subtract 

iii. Intersect 

iv. Slice 

2.1.1.1. Union: 

You can combine two or more 3D solids, surfaces, or 2D regions into a single, composite 

3D solid, surface, or region. You must select the same type of objects to combine. 

Through Short Cut Key            à         UNI  enter 

Application 

Type UNI at the Command Prompt àSelect objectsà enter 

. 

 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD | 325 

  Module-3 (LU-2): Develop 3D Model using AutoCAD 

  

2.1.1.2. Subtract 

With SUBTRACT, you can create a 3D solid by subtracting one set of existing 3D solids 

from another, overlapping set. You can create a 2D region object by subtracting one set 

of existing region objects from another, overlapping set. You can select only regions for 

use with this command. 

Through Short Cut Key            à          su enter 

Application 

Type SU at the Command Prompt à SUBTRACT Select solids and regions to subtract 

from àenter à Select solids and regions to subtract à enter 

 

 

 

2.1.1.3. Intersect 

Create a 3D solid, surface, or 2D region from overlapping solids, surfaces, or regions. With 

INTERSECT, you can create a 3D solid           from the common volume of two or more 

existing 3D solids, surfaces, or regions. If you select a mesh, you can convert it to a solid 

or surface before completing the operation. 

Through Short Cut Key            à in enter 

Application 

Type IN at the Command Prompt à Select objectsà enter 
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2.1.1.4. Slice 

Creates new 3D solids and surfaces by slicing, or dividing, existing objects. 

 

The cutting plane is defined with 2 or 3 points, by specifying a major plane of the UCS, or 

by selecting a surface object (but not a mesh). Either one or both sides of the sliced 3D 

solids can be retained. 

 

The sliced objects retain the layer and color properties of the original solids. However, the 

resulting solid or surface objects do not retain a history of the original objects. 

· Objects that Can Be Used in a Slice Operation 

Objects that can be sliced Objects that can be used as cutting planes 

3D solids Surfaces 

Surfaces Circles 

  Ellipses 

  Circular or elliptical arcs 

  2D splines 

  3D polyline segments 

 

· List of Prompts 

The following prompts are displayed. 

· Objects to slice 

Specifies the 3D solid or surface object that you want to slice. If you select a mesh object, 

you can choose to convert it to a 3D solid or surface before completing the slice operation. 

i. Start point of slicing plane 

ii. Planar object 

iii. Surface 

iv. Z axis 

v. View 

vi. XY 

vii. YZ 

viii. ZX 
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i. Start point of slicing plane 

Sets the first of two points that define the angle of the slicing plane. The slicing plane is 

perpendicular to the XYplane of the current UCS. 

· Second point on plane. Sets the second of two points on the slicing plane. 

Ø Point on desired side 

Ø Keep both sides 

 

ii. Planar object 

Aligns the cutting plane with a plane that contains a selected circle, ellipse, circular or 

elliptical arc, 2D spline, or 2D polyline segment. 

· Select a circle, ellipse, arc, 2D-spline, or 2D-polyline. Specifies the object to use for 

alignment. 

iii. Surface 

Aligns the cutting plane with a surface. 

· Select a surface. Specifies a surface to be used for alignment. 

Note You cannot select meshes created with the EDGESURF, REVSURF, RULESURF, 

and TABSURF commands. 

Ø Point on desired side 

Ø Keep both sides 

iv. Z axis 

Defines the cutting plane by specifying a point on the plane and another point on the Z axis 

(normal) of the plane. 

· Specify a point on the section plane. Sets a point on the slicing plane. 

· Specify a point on the Z-axis (normal) of the plane. Specifies a point that defines the 

axis that is perpendicular to the slicing plane. 

 

Ø Point on desired side 

Ø Keep both sides 

v. View 

Aligns the cutting plane with the current viewport's viewing plane. Specifying a point defines 

the location of the cutting plane. 

· Specify a point on the current view plane. Sets a point on the object to start the slice. 

Ø Point on desired side 

Ø Keep both sides 

 

vi. XY 

Aligns the cutting plane with the XY plane of the current user coordinate system (UCS). 

Specifying a point defines the location of the cutting plane. 
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· Point on the XY-plane. Sets the location of the slice. 

Ø Point on desired side 

Ø Keep both sides 

 

vii. YZ 

Aligns the cutting plane with the YZ plane of the current UCS. Specifying a point defines the 

location of the cutting plane. 

· Point on the YZ-plane. Sets the location of the slice. 

 

viii. ZX 

Aligns the cutting plane with the ZX plane of the current UCS. Specifying a point defines the 

location of the cutting plane. 

· Point on the ZX-plane. Sets the location of the slice. 

If a single object is sliced into more than two objects, one solid or surface is created from 

the objects on one side of the plane and another solid or surface is created from the objects 

on the other side. 

 

ix. 3points 

Defines the cutting plane using three points. 

· Point on desired side 

Uses a point to determine which side of the sliced solids your drawing retains. The point 

cannot lie on the cutting plane. 

· Keep both sides 

Retains both sides of the sliced solids. Slicing a single solid into two pieces creates two 

solids from the pieces on either side of the plane. SLICE never creates more than two new 

composite solids for each selected solid. 

 

x. How to execute the command 

 

· By use of Buttons 

Ribbon: à  Home tab à Solid Editing panel à Slice 

Menu:  Modify à 3D Operations à Slice 

i. Open a drawing with 3D objects and display in a 3D view. 

ii. Choose Modify, 3D Operation, Slice. 

Or 

iii. Type SLICE at the command prompt. 

Command: slice 
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Select objects to slice: By selecting the object the message will be “1 found” 

Specify start point of slicing plane or [planar Object/Surface/Zaxis/View/XY/YZ/ZX/3points] 

<3points>: Press enter 

Specify first point on plane:  >> click at mid on one side at bottom of object 

Specify second point on plane: >> click at mid on one side at top of object 

Specify third point on plane: >> click at mid on opposite side at top of object 

Specify a point on desired side or [keep Both sides] <Both>: Type B and press enter 

 

Other options are:  

Slice by Line 

Slices objects by a plane perpendicular to the current view, defined by two points. This is 

the default option. 

i. Select Slice by Line (2 Points) from the local menu or Inspector Bar. 

 

ii. Select the objects to slice. You can use Shift to select more than one object. 

iii. Select two points the slicing plane will pass through the line defined by these points, in 

the direction normal to the current view (into the screen). 

The slice is created, though in the current view the dividing plane appears as a line. 

 

You can rotate the view and move one of the new objects to see how the original object was 

sliced. 
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Slice by Plane 

Slices objects by defining the slicing plane. The plane is defined by three points. 

i. Select Slice by Plane (3 Points) from the local menu or Inspector Bar. 

 

ii. Select the object to section. You can use Shift to select more than one object. 

iii. Select three points to define the slicing plane. 

 

The slice is created. You can move one of the new objects to see how the original object 

was sliced. 

 

Slice by Workplane 

Slices objects by using the current workplane as the slicing plane.  

i. Select Slice by Workplane from the local menu or Inspector Bar. 

 

ii. Select the object to slice. 
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Note: To slice multiple objects, start out using a different option - Slice by Line or Slice by 

Plane. Use Shift to select the objects to slice, then click the Slice by Workplane icon. The 

object is sliced. 

 

You can move one of the new objects to see how the original object was sliced. 

 

Slice by Surface 

Slices the object by using a surface. The surface must be a ACIS solid surface. 

i. Select Slice by Surface from the local menu or Inspector Bar.          

 

 

ii.  Select the object to be sliced. 

Note: To slice multiple objects, start out using a different option - Slice by Line or Slice by 

Plane. Use Shift to select the objects to slice, then click the Slice by Workplane icon. The 

object is sliced.  
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iii. Select the object to do the slicing. 

 

You can move one of the new objects to see how the original object was sliced. 

 

Slice by Facet 

Slices objects by a plane perpendicular to the current view, defined by two points. This is 

the default option. 

i. Select Slice by Facet from the local menu or Inspector Bar. 

 

ii. Select the objects to slice. You can use Shift to select more than one object. 

iii. Select the facet that will be used to slice the object. 
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You can rotate the view and move one of the new objects to see how the original object 

was sliced.  

Delete a Sliced Part  

Removes one of the new objects created by slicing objects. This option is used in tandem 

with one of the other options. 

i. Select the desired slicing option (in this case, Slice by Plane) and Delete a Sliced Part 

from the local menu or Inspector Bar.  

ii. Select the object to section. You can use Shift to select more than one object. Slice the 

object by the selected method, in this case, defining a plane by three points. 

 

iii.      The slice is created. Select the object you want to delete. 

 

  

Tip: Objects created as a result of slicing can also be deleted by selecting them and 

pressing the Delete key. 

 Note: Boolean operations can use multi-select modes to select objects as components for 

operations. 
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2.2. Make Customized 3D Models according to the requirement of Given Job. 

 

3D Models as per requirements can be created by use of basic 3d objects and then transforming the same 

to the job requirements by use of Modifying commands. Those may be above mentioned Boolean 

operations command or below mentioned modifying commands for 3D models/ objects/ surfaces. 

At the initial stage we usually create 2D objects from 2D commands. Then we modify these to be converted 

into 3D objects. 

There are two methods to convert a line into a poly line. 

· Boundary Command 

This command use for 2D close object converts in to poly line 

 

 

 

· Polyline Edit Command 

This command for 2D open object converts in to poly line 

 

· Boundary Command 

Create a region or a polyline from an enclosed area. 

Boundary command can be found out through following methods: 

 

Through Short Cut Key            à          Bo enter 

 

Application 

Type Bo at the Command Prompt à enterà Open Boundary Window àpick point àenter 
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· Polyline Edit Command 

Common uses for PEDIT include joining 2D polylines, converting lines and arcs into 2D polylines, 

and converting polylines into curves that approximate B-splines (spline-fit polylines). 

Short Cut Key à PE enter 

Application 

Type PE at the Command Prompt à enterà Select polyline à enterà J enter (For Join the line) 

à Select all lines àenter 

2.2.1. Manipulate 3D object by using Modify Commands- Extrude, Rotate, Rotate3D, Revolve, 

Revolve Surface, Shell, Sweep, Loft, etc.  

 

2.2.1.1. Thicken Command: - 

Convert a surface into a 3D solid with a specified thickness. A useful technique for modeling 

a complex 3D curved solid is to first create a surface and then convert it to 3D solid by 

thickening it. Initially, the default thickness value is zero. During a drawing session, the 

default value for the thickness is the previously entered thickness value. 

Through Short Cut Key            à          thicken enter 

Application 

Type THICKEN at the Command Prompt à Select surfaces to thicken àSpecify 

thickness <0.0000> àput the thicken value àenter 

 

 

2.2.2. 3D Rotate 

3D Rotate command helps to constrain or in rotation of 3D objects and sub-objects along any axis 

up to a specified angle 

APPLICATION 
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Pick Tool àSelect the objects OR hold Ctrl key to select sub-objects (faces, edges, and vertices) 

àRelease Ctrl key and press Enter àThe rotate gizmo is displayed attached to the cursor à Click 

to place the rotating   gizmo, specifying the base point for the move à However the cursor over an 

axis path on the gizmo until it turns yellow and the vector that represents the axis of rotation is 

displayed. à Specify angle of the rotation. 

When you drag the cursor, the selected objects and sub-objects rotate about the base point along 

the specified axis. The gizmo displays the degree of rotation from the original position of the object 

as the object moves. You can click or enter a value to specify the angle of the rotation 

 

2.2.3. Interfere Command 

Create a temporary 3D solid from the interferences between two sets of selected 3D solids. 

Interferences are highlighted with a temporary 3D solid that represents the intersecting volume. 

You can also choose to retain the overlapping volumes 

Through Short Cut Key            à          inf enter 

Application 

Type INF at the Command Prompt à Select first set of objects or [Nested selection/Settings] 

àSelect solids àenter. 

 

2.2.4. Extrude Command 

Extrusions can extend in the Z direction or be set to taper or follow a path. You can extrude an 

open or closed object to create 3D surface or solid 

Through Short Cut Key            à Ext enter 

Application 
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Type Ext at the Command Prompt à Select Object àenter à Specify height of extrusion or 

[Direction/Path/Taper angle] àenter 

 

· Extrude Command Options 

i. Height of extrusion  

ii. Direction 

iii. Path 

iv. Taper angle 

i. Height of extrusion 

Note: Select face and edge sub objects by pressing Ctrl while you select them Extrudes 

objects along the positive Z axis of the object's coordinate system if you enter a positive 

value. If you enter a negative value, the objects are extruded along the negative Z axis. 

Objects do not have to be parallel to the same plane. If all the objects are on a common 

plane, the objects are extruded in the direction of the normal of the plane.  

 

ii. Direction 

Specifies the length and direction of the extrusion with two 

points you specify. (The direction cannot be parallel to the plane 

of the sweep curve created by the extrusion.  

 

 

Ø Start point of direction. Specifies the first point in the direction vector. 

Ø End point of direction. Specifies the second point in the direction vector 

iii. Path: 

Specifies the extrusion path based on an object that you select. The path is moved to the 

centric of the profile. Then the profile of the selected object is extruded along the chosen 

path to create solids or surfaces. 

By default, planar 

objects are extruded 

in the direction of the 

object’s normal. 

Remember 
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The path should not lie on the same plane as the object, nor should the path have areas of 

high curvature. 

The extrusion starts from the plane of the object and maintains its orientation relative to the 

path. If the path contains segments that are not tangent, the program extrudes the object 

along each segment and then miters the joint along the plane bisecting the angle formed by 

the segments. If the path is closed, the object should lie on the miter plane. This allows the 

start and end sections of the solid to match up. If the object is not on the miter plane, the 

object is rotated until it is on the miter plane. Objects with multiple loops are extruded so 

that all the loops appear on the same plane at the end section of the extruded solid. 

Application 

Type Ext at the Command Prompt à Select Object àenterà Specify height of extrusion 

or [Direction/Path/Taper angle] àP enter (For Path) àSelect Pathà enter 

 

Circle Extruded Along a Path 

 

 

Hidden Line Removal of Extruded Circle 
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iv. Taper Angle 

Positive angles taper in from the base object. Negative angles taper out. The default 

angle, 0, extrudes a 2D object perpendicular to its 2D plane. All selected objects and 

loops are tapered to the same value. Specifying a large taper angle or a long extrusion 

height can cause the object or portions of the object to taper to a point before reaching the 

extrusion height. Individual loops of a region are always extruded to the same height. When 

an arc is part of a tapered extrusion, the angle of the arc remains constant, and the radius 

of the arc changes. 

 

Ø Angle of taper. Sets an angle between -90 and +90 degrees. 

Ø Specify two points. Sets the taper angle based on two points you specify in the drawing 

area. The taper angle applied to the extrusion is the distance between the two specified 

point 

 

Application 

Type Ext at the Command Prompt à Select Object àenterà Specify height of extrusion 

or [Direction/Path/Taper angle] àT enter(For Taper Angle) àPut the Value of Taper 

Angle àSpecify height of extrusion or [Direction/Path/Taper angle] àput the Value of 

Heightà enter 
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2.2.5. Extrude Faces  

You can extrude one or more faces of 3D solid at the specified height and path. Extrude faces 

command of 3D 

There are two options of Extrude faces command 

i. Height 

ii. Path 

 

APPLICATION (Extrude faces with Height) 

Pick tool à select faces à put the Height of extrusion àput the taper angle of extrusion 

 

APPLICATION (Extrude faces with Path) 

In the first step we draw the path in polyline. 

Pick tool à select faces àput the “P” for path option à Select the path 
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2.2.6. 3D Rotate 

3D Rotate command helps to constrain or in rotation of 3D objects and sub-objects along any axis 

up to a specified angle 

 

APPLICATION 

Pick Tool àSelect the objects OR hold Ctrl key to select sub-objects (faces, edges, and vertices) 

àRelease Ctrl key and press Enter àThe rotate gizmo is displayed attached to the cursorà Click 

to place the rotating   gizmo, specifying the base point for the move à However the cursor over an 

axis path on the gizmo until it turns yellow and the vector that represents the axis of rotation is 

displayed. à Specify angle of the rotation. 

When you drag the cursor, the selected objects and sub-objects rotate about the base point along 

the specified axis. The gizmo displays the degree of rotation from the original position of the object 

as the object moves. You can click or enter a value to specify the angle of the rotation. 

 

2.2.7. Revolve Command 

Open profiles create surfaces and closed profiles can create either a solid or a surface. The Mode 

option controls is a solid of surface is created. When creating a surface. You cannot revolve objects 

contained within a block or objects that will self-intersect. REVOLVE ignores the width of a polyline 

and revolves from the center of the path of the polyline. The right-hand rule determines the positive 

direction of rotation. For more information, see Understand the UCS in 3D. 

Through Short Cut Key            à          Rev enter 

Application 

Type Rev at the Command Prompt àSelect Objectàenterà Specify start point for axis of 

revolution à 

Select first point of axis àSelect 2nd point of axisà Specify angle of revolution <360>àput the 

revolving angle àenter. 
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· Revolve Options 

i. Mode 

ii. Start Angle 

iii. Reverse 

iv. Expression 

 

i. Mode 

Control whether the revolve action creates a solid or a surface. Surfaces are extended 

as either NURBS 

surfaces or procedural surfaces, depending on the SURFACEMODELINGMODE system 

variable 

ii. Start Angle 

Specify an offset for the revolution from the plane of the object being revolved. Drag your 

cursor to specify and preview the start angle of the object. 

 

iii. Reverse 

Change the direction of the Revolve; similar to entering a - (minus) angle value. The 

revolved object on the right shows a spline revolved at the same angle as the object on the 

left, but using the reverse option 
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iv. Expression 

Enter a formula or equation to specify the revolve angle. See Constrain a Design with 

Formulas and Equations. 

 

2.2.8. Revolves Surfaces 

Select a line, arc, circle, or 2D or 3D polyline to sweep in a circular path around a selected axis. 

Regenerates a three-dimensional model with hidden lines 

The MESHTYPE system variable sets which type of mesh are created. Mesh objects are created 

by default. Set the variable to 0 to create legacy polyface or polygon mesh. 

The  density  of  the  generated  mesh  is  controlled  by  the SURFTAB1 and SURFTAB2 

system  variables. SURFTAB1 specifies the number of tabulation lines that are drawn in the 

direction of revolution. If the path curve is a line, arc, circle, or spline-fit polyline, SURFTAB2 

specifies the number of tabulation lines that are drawn to divide it into equal-sized intervals. If the 

path curve is a polyline that has not been spline fit, tabulation lines are drawn at the ends of straight 

segments, and each arc segment is divided into the number of intervals specified by SURFTAB2 

Through Short Cut Key: REVSURF à enter 

APPLICATION 

Type REVSURF at the Command Prompt à Select object to 

revolveà Select object that defines the axis of revolution àSpecify 

start angle à Specify included angle àenter 

 

By default, planar 

objects are extruded 

in the direction of the 

object’s normal 

Remember 
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2.2.9. Revolve Command 

Open profiles create surfaces and closed profiles can create either a solid or a surface. The Mode 

option controls is a solid of surface is created. When creating a surface. You cannot revolve objects 

contained within a block or objects that will self-intersect. REVOLVE ignores the width of a polyline 

and revolves from the center of the path of the polyline. The right-hand rule determines the positive 

direction of rotation. For more information, see Understand the UCS in 3D. 

Through Short Cut Key            à          Rev enter 

Application 

Type Rev at the Command Prompt àSelect Objectàenterà Specify start point for axis of 

revolution à 

Select first point of axis àSelect 2nd point of axisà Specify angle of revolution <360>àput the 

revolving angle àenter. 
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· Revolve Options 

i. Mode 

ii. Start Angle 

iii. Reverse 

iv. Expression 

 

i. Mode 

Control whether the revolve action creates a solid or a surface. Surfaces are extended 

as either NURBS 

surfaces or procedural surfaces, depending on the SURFACEMODELINGMODE system 

variable 

 

ii. Start Angle 

Specify an offset for the revolution from the plane of the object being revolved. Drag your 

cursor to specify and preview the start angle of the object. 

 

iii. Reverse 

Change the direction of the Revolve; similar to entering a - (minus) angle value. The 

revolved object on the right shows a spline revolved at the same angle as the object on the 

left, but using the reverse option 

 

 

iv. Expression 

Enter a formula or equation to specify the revolve angle. See Constrain a Design with 

Formulas and Equations. 
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2.2.10. Revolves Surfaces 

Select a line, arc, circle, or 2D or 3D polyline to sweep in a circular path around a selected axis. 

Regenerates a three-dimensional model with hidden lines 

The MESHTYPE system variable sets which type of mesh are created. Mesh objects are created 

by default. Set the variable to 0 to create legacy polyface or polygon mesh. 

The  density  of  the  generated  mesh  is  controlled  by  the SURFTAB1 and SURFTAB2 

system  variables. SURFTAB1 specifies the number of tabulation lines that are drawn in the 

direction of revolution. If the path curve is a line, arc, circle, or spline-fit polyline, SURFTAB2 

specifies the number of tabulation lines that are drawn to divide it into equal-sized intervals. If the 

path curve is a polyline that has not been spline fit, tabulation lines are drawn at the ends of straight 

segments, and each arc segment is divided into the number of intervals specified by SURFTAB2 

Through Short Cut Key: REVSURF à enter 

APPLICATION 

Type REVSURF at the Command Prompt à Select object to 

revolveà Select object that defines the axis of revolution àSpecify 

start angle à Specify included angle àenter 

 

 

 

By default, planar 

objects are extruded 

in the direction of the 

object’s normal. 

Remember 
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2.2.11. Surftab Variables 

Set the number of tabulations for both directions to be generated for RULESURF and TABSURF. 

Also sets the mesh density in ROTATE3D the M direction for REVSURF and EDGESURF 

commands. 

Method of change the Surftab1&2 values 

APPLICATION 

i. SURFTAB 1  

Type SURFTAB 1 at the Command Prompt à Enter new value for SURFTAB1 <6>:à 

Put the new value of Surftab àenter 

ii. SURFTAB 2 

Type SURFTAB 2 at the Command Prompt à Enter new value for SURFTAB2 <6>:à 

Put the new value of Surftab àenter 

Reaction of Surftab Value on object 

APPLICATION 

Type REVSURF at the Command Prompt à Select object to revolve à Select object that 

defines the axis of revolution à Specify start angle à Specify included angle àenter 

 

 

2.2.12. Shell 

You can create a shell or a hollow thin wall with a specified thickness from your 3D solid object. 

AutoCAD creates new faces by offsetting existing ones inside or outside their original positions. 

AutoCAD treats continuously tangent faces as single faces when offsetting. 

Choose Modify, Solid Editing, Shell. 

Select a 3D solid: pick solid 

Remove faces or [Undo/Add/ALL]: enter 

Enter the shell offset distance: .5 
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2.2.13. How to Apply “Imprint” Facility on 3D Solid Object 

This command is used to imprint an object on the selected solid face. The object to be imprinted 

must intersect one or more faces on the selected solid in order for imprinting to be successful. 

Imprinting is limited to the following objects: arcs, circles, lines, 2D and 3D polylines, ellipses, sp 

lines, regions, bodies, and 3D solids. 

APPLICATION 

Draw the shape in 2D polylines for imprinting on 3D solid face. 

Pick tool à  Select 3D object à  Select imprint object à   delete the source object (Yes/No) à   

Enter 

 

How to Apply “Shell” command on 3D solid object: 

Shell command is used to create a hollow, thin wall structure of a specified thickness. You can 

specify a constant wall thickness for all the faces. Also the desired faces can be removed as well. 
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APPLICATION 

Pick tool à Select 3D Solid àSelect faces to remove à Enter à put the wall thinness  Enter 

 

2.2.14. 3D MOVE 

3D move command is used to move a selection set of objects or sub-objects to a specified distance 

in a specified direction or freely constrain the movement along any axis or plane. 

To move selected objects along a plane: 

Move the cursor over the planar rectangle that intersects the plan and use to control the plane of 

constraint. When the rectangle turns yellow, click it. 

APPLICATION 

Pick Tool àSelect the objects OR hold Ctrl key to select sub-

objects (faces, edges, and vertices). àRelease Ctrl key and 

press Enter. àThe Move gizmo is displayed attached to the 

cursor àClick to place the Move gizmo, specifying the base 

point for the move. àMove the cursor over the plane put the 

specify distance of the move. 

 

 

 

 

To move selected objects along an axis: 

Move the cursor over an axis to control the gizmo until it turns yellow and the vector is displayed. 

Then click the axis handle 
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APPLICATION 

Pick Tool àSelect the objects OR hold Ctrl key to select sub-objects (faces, edges, and vertices). 

àRelease Ctrl key and press Enter. àThe Move gizmo is displayed attached to the cursor àClick 

to place the Move gizmo, specifying the base point for the move. à Handle on the gizmo until it 

turns yellow and the vector is displayed. Then click the axis handle. àPut the specified distance of 

the move.  

 

 

2.2.15. 3D Align Command 

You can specify one, two, or three points for the source object. Then, you can specify one, two, or 

three points for the destination. 

Through Short Cut Key à 3Dalign enter 

Application 

Type 3Dalign at the Command Prompt à Select object à enter àSpecify source plane and 

orientation à Specify base point or [Copy]: àSpecify second point or [Continue] àSpecify third 

point or [Continue] à Specify destination plane and orientation àSpecify first destination point 

àSpecify second destination point àSpecify third destination point 
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2.2.16. 3D Mirror Command 

Create a mirrored copy of selected 3D objects across a mirroring plane. You can specify the 

mirroring plane by aligning the objects with a specified plane or by specifying three points. 

Through Short Cut Key            à          3Dmirror enter 

Application 

Type 3Dmirror at the Command Prompt à Select object à enter àSpecify first point of mirror 

plane (3 points) or[Object/Last/Zaxis/View/XY/YZ/ZX/3points] àSpecify second point  on  mirror 

plane àSpecify third  point on mirror plane àDelete source objects? [Yes/No] <N>à enter. 

 
 

2.2.17. Sweep Command 

Creates a solid or surface by sweeping an open or closed, planar or non-planar curve (profile) 

along an open or closed path. Open curves create surfaces and closed curves create solids 

or surfaces, depending on the specified mode. You can use the following objects and paths when 

creating a swept solid or surface: 

Through Short Cut Key            à Sweep enter 

Application 

Type Sweep at the Command Prompt àSelect Object to sweep àenter àSelect sweep path 

àenter 

 

· Sweep Options 

i. Alignment  

ii. Base point  

iii. Scale 

iv. Twist 
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i. Alignment 

Specify whether the profile is aligned to be normal to the tangent direction of the sweep 

path. If the profile is not perpendicular (normal) to the tangent of the start point of the path, 

then the profile automatically aligns. Enter No at the alignment prompt to prevent this. 

 

ii. Base point 

Specify a base point for the objects to be swept. 

iii. Scale 

Specify a scale factor for a sweep operation. The scale 

factor is uniformly applied to the objects that are swept from 

the start to the end of the sweep path. 

 

 

iv. Twist 

Set a twist angle for the objects being swept. The twist angle specifies the amount of 

rotation along the entire length of the sweep path. 

Specify whether the curve(s) being swept will naturally bank (rotate) along a 3D sweep 

path (3D polyline, spline, or helix). 

 

Scale the selected 

objects based on the 

length you reference 

by picking points or 

entering values. 

Remember 
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2.2.18. Loft Command 

LOFT command creates a solid by joining several crass sections lying on different planes. The 

cross sections define the profile (Shape) of the resulting solid. Cross sections (generally, curves 

or circle).Loft draws a soli d in the space among the different cross sections. You must specify 

at least two cross sections when you use the LOFT command. 

Through Short Cut Key            à          Loft enter 

Application 

Type Loft at the Command Prompt à Select cross-sections in lofting order àSelect Cross sections 

àenter 

 

 

· Loft Command Options 

i. Guides 

ii. Path 

iii. Cross sections only 

iv. Settings 

 

i. Guides 

Specifies guide curves that control the shape of the lofted solid or surface. You can use 

guide curves to control how points are matched up on corresponding cross sections to 

prevent undesired results, such as wrinkles in the resulting solid or surface. 

Ø Intersects each cross section 

Ø Starts on the first cross section 

Ø Ends on the last cross section 

Select any number of guide curves for the lofted surface or solid and press Enter 

ii. Path 

Specify a path for the loft operation to obtain more control over the shape of the lofted 

object. For best results, start the path curve on the plane of the first cross section and end 

it on the plane of the last cross section. 
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iii. Cross-section 

Select a series of cross-section profiles to define the shape of the new 3D object. Lofted 

objects with different cross-section settings as you create a lofted object; you can adjust 

its shape by specifying how the profile passes through the cross sections (for example, a 

sharp or smooth curve). You can also modify the settings later in the Properties Inspector. 

 

iv. Guide Curves. 

Specify guide curves to match points on corresponding cross sections. This method 

prevents undesired results, such as wrinkles in the resulting 3D object. 

 

Each guide curve must meet the following criteria 

Ø Intersects each cross section 

Ø Starts on the first cross section 

Ø Ends on the last cross section 
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Preset Views2.3.1.

The view is the area of the drawing space that appears on your screen. As your drawing becomes 

larger and more complex, it's important to find views that let you work at the right location in your 

drawing, at an appropriate level of detail. 

Tip: Layers are a useful way to change how objects. You can place objects on various layers and 

then manipulate layer visibility. 

  

· Saving 3D Views 

You can use camera objects to save views with specific parameters and open them in their 

own windows. 

The ten standard views can be accessed from the View / Camera menu. 

 

 

You can also display this toolbar separately by right-clicking in the toolbar area and 

selecting Standard Views. 

 

 

And, by default, these tools are available on the local (right-click) menu. 

· Orthographic Views 

The first six views on the toolbar are orthographic views - Top (World Plan), Left, Front, 

Bottom, Back, Right. 

If your model was enclosed in a box, these views reflect how the model would appear by 

PeSSPective Projection and Parallel Projection, Orbits, Etc.)

2.3. Demonstrate  Different  Views  to  View  the  Objects  (Preset  Views,  Viewports,  Visual  Styles,

screen to dynamically rotate the model.

  Tip: If you use a wheel mouse, keep the middle mouse button pressed, and drag the cursor around the 

you can create camera objects.

and dynamically examine the model using the Walk Through tools. To save and display additional views, 
can change how the camera is oriented. You can move the camera using the Move Camera commands, 
you 
There are  several  standard orthographic  and isometric  views, and if  you need additional  peSSPective  

"camera" - equivalent to your eye. The camera is located in a specific place and faces a specific direction 
While working in 3D, there are many ways to change how you view your drawing. Views are seen by the 
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looking directly at each of the box faces. If you "unfold" the box, you can see the 

relationship between the views. 

 

 

Front View: Looks at the XZ plane of the World Coordinate System, while facing +Y. 

Top View: Looks at the XY plane while facing-  Z (down). 

Tip: The Top view can be also obtained from the Plan view by using the Roll walk through 

tool.  

Left View: Looks at the YZ plane while facing +X. 

Bottom View: Looks at the XY plane while facing +Z (up). 

Back View: Looks at the XZ plane while facing -Y. 

Right View: Looks at the YZ plane while facing -X. 

 

· Isometric Views 

The last four views on the toolbar are isometric - angled views. The views are named for 

compass directions (Isometric_SE is the view looking from the southeast). 
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· Procedure of Saving Views 

Once you have used the zoom and pan tools to arrive at the exact view of your drawing 

that you want, you won't want to repeat all that work to get back to the same view later. 

You can save views and assign them names so that you can easily return to a saved view 

at any time. 

In addition, saved views must be created if you want to create viewports in Paper Space. 

Note: For 3D views, you can also use camera object to save and display views in separate 

windows and with specific parameters.  

The Named Views tools are accessible from the View menu, or from the fly out World 

Plan icon on the Standard toolbar. 
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You can display the Named Views toolbar by right-clicking in any toolbar area and select 

Named View. 

 

Note: Saved views can also be accessed and manipulated in the Design Director, in which 

you can also create new views. Render and camera settings can be manipulated here as 

well. 

· Creating a View 

Default UI Menu: View/Named Views/Create View 

Saves a defined area of the screen as a named view. Define the rectangle that surrounds 

the area you want to save. In the Create Named View window, assign a unique name and 

click OK. 

 

Note: If the drawing is already oriented to the view you want to save (i.e. you do not need 

to define a view rectangle), you can save the view using the Named View tool. 

Named View 

Default UI Menu: View/Named Views/Named View 

The Named View window can be used to create a new saved view, or to display, modify, 

or delete a saved view.  

 

Named views are saved with your drawing and remain available unless you delete them. 

Draft Rendering: Sets the rendering type when the view is rendered in Draft rendering 

mode. 

Quality Rendering: Sets the rendering type when the view is rendered in Quality 

rendering mode. 
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· 

i. 

ii. 

iii. 

iv. 

· 

 

  

Preset 3D Viewports: -2.3.2.

You can used Command to split the windows: by typing the VPORTS command in command line. 

  

In  the Named View window,  select  the  view  you  want  to  delete,  and  click Delete.

Deleting a Saved View

drawing view, and click Modify.

view. Open the Named View window, select the view you want to replace with the current 
Use the zoom and pan tools to arrive at the view with which you want to replace a saved 

Modifying a Saved View

Tip: If you want to display the previous view, use View / Zoom / Previous View.

view and close the window, double-click on the view name.

window open, in case you want to switch to another view. To immediately go to a named 
In the Named View window, select the desired view and click Go To. This will leave the 

Displaying a Saved View

If you use names like "View 1" and "View 2," you'll quickly lose track of which is which.

Tip: Give the view a descriptive name that will help you remember it, such as "Garden Door."

Click New to add the name to the list of named views.

include spaces.

Enter a name for the view. The name can be up to 32 characters in length and can

View window.

Select Named View from the menu or click the Named View icon to open the Named 

Note: If you want to create a view using a specific area of the screen.

Use the zoom and pan tools to arrive at the view you want to save.

  Saving a View

Extents: The boundaries of the view.

UP Vector: A point defining the up direction of the camera.

Target: The location of the point the camera is facing.

Position: The location of the camera position.

Angle: The view angle for peSSPective mode.

PeSSPective: Activates PeSSPective mode.
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Step-1: Type: VPORTS 

You will get the following figure 

 

Step-2:  Type the name for the new model space viewport 

i. If you do not enter a name, the viewport configuration is applied but not saved. 

ii. If a viewport configuration is not saved, it cannot be used in a layout. 

iii. If you specify a name it can be save and can be used in a layout. 
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Step-3:  Whenever you used the viewport again you will get the layout named Aftab Viewport as 

shown in figure below 

 

 

2.3.3. Visual Style: - 

Different styles are used to display/visualize in the drawing area, these maybe as under 

· 2D Wireframe 

On applying this visual style, all hidden lines will be displayed along with the visible lines in 

the model. Sometimes, it becomes difficult to recognize the visible lines and hidden lines, 

if you set this visual style for complex models.  

 

· Conceptual 

In this visual style, the model will be displayed as shaded and the edges of the visible faces 

of the model will also be displayed. 

· 3D Hidden 

On applying this visual style, the hidden lines in the model will not be displayed, and only 

the edges of the faces that are visible in the current viewport will be displayed. 
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· Realistic 

This visual style is the same as Conceptual, but with a more realistic appearance. 

Moreover, if materials are applied to a model, this visual style will display the model along 

with the material applied. 

 

· Shaded 

In this visual style, smooth shading is applied to the faces of a model. In this case, the 

edges of the visible faces are not visible. 

 

 

· Shaded with edges 

In this visual style, smooth shading is applied to the faces of a model and the edges of the 

visible faces are visible. 
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· Shades of Gray 

In this visual style, a single shade (grey) is applied to all faces of a model. 

 

· Sketchy 

In this visual style, a model appears as if it is hand sketched. 

· Wireframe 

This visual style is used to display a solid model as a wireframe model. You can see 

through the solid model while the model is being rotated in the 3D orbit view. 

 

· X-Ray  

This visual style is used to display the model with shading and mild transparency. In this 

case, the hidden lines will be visible. 
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2.3.4.

 

 

projection. Both are based on the same viewing direction.

peSSPective 
The  following  illustration  shows  the  same  model  in  both  a  parallel  projection  and  

defined in its place.

is

view 

A peSSPective view remains in effect until the peSSPective effect is turned off or until a new 

peSSPective effects; large distances produce mild effects.

a  distance  between  a  theoretical  camera  and  target  point.  Small  distances  produce  severe 
require

The difference between peSSPective views and parallel projections is that peSSPective views 

projections of a model.

peSSPective

you  can  create  realistic  visual  effects  in  a  drawing by  defining  either  parallel  or 

PerSSPe projection and parallel projection
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2.3.4.1. Define Parallel Projections 

To determine the point or angle in model space, you can 

i. Choose a preset 3D view from the View toolbar. 

ii. Enter a coordinate or angles that represent your viewing location in 3D. 

iii. Change to a view of the XY plane of the current UCS, a saved UCS, or the WCS. 

iv. Change the 3D view dynamically with your pointing device. 

v. Set front and back clipping planes to limit the objects being displayed. 

 

Viewing in 3D is available only in model space. If you are working in paper space, you 

cannot use 3D viewing commands such as VPOINT, DVIEW, or PLAN to define paper 

space views. The view in paper space is always a plan view. 

 

Dview Command2.3.4.2.

Type DV at the Command Prompt à Select first set of objects or [Nested 

selection/Settings] àSelect solids àenter. 

 

2.3.5.

.  

PeSSPective option with respect to fly and walk orbiting to explore the use of orbiting.

zoom  (Extends,  window  etc.)  and  pan  facility  and  apply  different  projection  mode  Parallel  and 
object and on whole drawing as well. You will also be able to provide due assistance in developing 
this learning unit, you will be able to work with “3DOrbit” command for constrained orbit on selected

This unit describes familiarity with AutoCAD 3D  Orbit and its different types. After completion of

model is turning as the mouse cursor is dragged. In this way, you can specify any view of the model 
of view, moves around the target. However, from the user's point of view, it appears as if the 3D 
When 3DOrbit is active, the target of the view stays stationary and the camera location, or point 

3D Orbit) or the entire drawing within the current viewport from any angle.

3D Orbit is  used to  view the selected object/s (Selection must be apply before the command of 

Orbits
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1 Orbit Orbit/3dorbit 
Constrains orbiting to the XY plane or the Z 

direction. 

2 Free Orbit 3dforbit 
Allows orbiting in any direction, without being 

constrained to the XY plane or the Z direction. 

3 Continuous Orbit 3dcorbit 

Changes the cursor to a sphere with two 

continuous lines encircling it and enables you to set 

the objects into continuous motion. 

 

2.3.5.1. Introduction to 3D Orbit 

3D Orbit is used to view the selected object/s (Selection must be applying before the 

command of 3D Orbit) or the entire drawing within the current viewport from any angle. 

When 3DOrbit is active, the target of the view stays stationary and the camera location, or 

point of view, moves around the target. However, from the user's point of view, it appears 

as if the 3D model is turning as the mouse cursor is dragged. In this way, you can specify 

any view of the model. 

You can activate the 3D Orbit by the following methods: 

 

View Tab Button Command Entry 

Orbit 
 

3dorbit 

 

 

Sr. # Name Command Description 
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There are nine types of Orbiting, which may be used during orbiting. 

You can get the first three orbits from 3D Modelling à Viewà Navigate 

While other will you get from other Navigation option from shortcut menu, during the 

orbiting process as you will see later in this unit. 
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Sr# Name Command Description 

 

1 

 

Orbit 

 

Orbit/3dorbit 
Constrains orbiting to the XY plane or the Z direction. 

 

2 
Free Orbit 3dforbit 

Allows orbiting in any direction, without being 

constrained to the XY plane or the Z direction. 

3 Continuous Orbit 3dcorbit 

Changes the cursor to a sphere with two continuous 

lines encircling it and enables you to set the objects into 

continuous motion. 

4 Adjust Distance 3DDISTANCE 
Simulates moving the camera closer to the object or 

farther away. 

5 Walk 3DWALK 

 

6 

 

Swivel 

 

3DSWIVEL 

Changes the cursor to an arched arrow and simulates 

the effect of swiveling the camera. 

7 Fly 3DFLY.  

 

8 Zoom 3DZOOM 

Changes the cursor to a magnifying glass with plus (+) 

and minus (-) sign and simulates moving the camera 

closer to an object or further away. Works like the Adjust 

Distance option. 

 

9 
3DPANPan  

Changes the cursor to a hand cursor and moves the 

view in the direction that you drag. 

 

  

view

of the camera. Walk orbit works only in peSSPective 

plane, by dynamically controlling the location and target 
"walk through" a model at a fixed height above the XY 
Changes the cursor to a plus sign and enables you to

Fly orbit works only in peSSPective view

height above the XY plane.

"fly through" a model without being restricted to a fixed 
Changes the cursor to a plus sign and enables you to
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2.3.5.2. Procedure Apply Orbiting to Drawing 

STEP BY STEP   Operations on AutoCAD 

GET READY. Before you going to begin these steps, make sure to set unit and you must 

have objects in your drawing. 

We are going to apply 3D Orbit on the following drawing as shown in the figure below. 

 

 

Step-1: Type orbit/3dorbit command in command bar <Enter> 

Step-2: You can orbit/revolve the drawing according to XY plane or the Z direction During 

any orbiting you can get other functions as shown below: 
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Whenever you apply any orbit, you will get the option “Press ECS or ENTER to exit or right-

click to display shortcut-menu”. 

· Use of ECS Button 

When you press ECS button during orbiting, as the name describe ECSAPE, you will get 

release or exit from the orbit command, and will get ready to prompt other commands of 

AutoCAD 

· Use of Right Click 

Whenever you right-click during orbiting you will get the following shortcut-menu as shown 

in the figure below 
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2.3.5.3. Discover Other Navigational Modes 

As we discussed other navigation from where you can get the nine orbiting types as shown 

in the figure below.  

Step-1: Type orbit/3dorbit command in command bar <Enter> 

Step-2: Right click at the drawing area, you will get the following 

 

 

2.3.5.4. 3D Orbit on Selected Object 

3D Orbit on selected object/s allows you to orbit / revolve the specific object within the 

drawing. 

· Procedure Apply Orbiting to Drawing 

STEP BY STEP   Operations on AutoCAD 

GET READY. Before you going to begin these steps, make sure to set unit and you must 

have objects in your drawing. 

We are going to apply 3D Orbit on the following selected object within the drawing as shown 

in the figure below 
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Step-1: Select the object before applying the orbit command, as shown here 

 

Step-2: Type orbit/3dorbit command in command bar <Enter> you will get the only selected 

object to orbit as shown in the figure below 
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Step-3: You can orbit/revolve the drawing according to XY plane or the Z direction. 

Step-4: When you press ECS button, you will get display the whole drawing again. 

 

2.3.5.5. Developing Pan and Zoom in 3D Orbit 

You can easily develop Zoom and Pan command during orbiting, the function of zoom and 

pan as the same as we discussed in previous module, but the only difference is to get 

Zoom and Pan after applying the orbit command then orbit/revolve that area 

3D Orbit on selected object/s allows you to orbit / revolve the specific object within the 

drawing. 

· Procedure Developing Pan and Zoom in 3D Orbit 

Step-1: Type orbit or any other orbit command in command bar <Enter>  

Step-2: Right click at the drawing area. 

Step-3: Go through Other Navigational Mode →zoom as shown in figure below 

 

Step-4: Zoom-In or Zoom-Out the object or drawing.  

Step-5: Then Right click again at the drawing area. 

Step-6: Go through Other Navigational Mode →constrained Orbit and continuing to orbiting 

as you need. 

Step-7: Repeat step-1 to step-6 for Pan and get the Pan functions 
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· Alternate Method for 3D Orbit Zoom 

You can also get all zooming option (extent, window, 

previous etc.) During orbiting by using direct command.  

Command to Enter: 3DZOOM 

Step-1: Type 3dzoom command in command bar 

<Enter>, you will get the following. 

 

 

Step-2: From here you can apply any of the zoom command as shown in the options to 

orbit the drawing or object/s 

 

2.3.5.6.

i. 

ii. 

iii. 

iv. 

v. 

vi. 

vii. 

viii. 

ix. 

x. 

 

· Procedure Apply Visual Styles in 3D Orbit 

STEP BY STEP   Operations on AutoCAD  

GET READY. Before you begin these steps, be sure to set unit and you must have an 

object in your drawing to apply visual styles on it. 

 

 

Remember 

All Zooming option work 

the same as we 

discussed in Previous 

Modules, if you need 

just glance back to the 

previous modules. 

X-ray

Wireframe

Sketch of Gray

Shaded of Gray

Shaded with edges

Shaded

Realistic

Hidden

Conceptual

2D Wireframe

Visual styles composites of the following styles in 3D Orbit.

get practice on Visual styles in 3D Orbit peSSPective.

In previous module we already discussed Visual Styles in detail but here we are going to 

Different Visual Styles in 3D Orbit
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Step-1: Type 3dorbit command in command bar <Enter>  

Step-2: Right click in the drawing area. 

Step-3: Go through Visual styles from the Popup menu as shown in the figure below. 

 

Step-4: Select 3D Hidden Styles, You will get the following figure below 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD | 376 

 Module-3 (LU-2): Develop 3D Model using AutoCAD 

  

Step-5: Repeat  

Step-4 for getting different visual styles in 3D Orbits. The following figures shown different 

visual styles: 

 

 

2.3.5.7. Walk and Fly 

You can simulate walking and flying through a 3D drawing. 

When you walk through a model, you travel along the XY plane. When you fly through a 

model, you are not constrained by the XY plane, so you appear to “fly” over an area in a 

model. 

Walk and Fly Navigation modes for the keyboard and mouse. 

 

i. Up arrow or W key =  Move forward 

ii. Down arrow or S key =  Move backward 

iii. Left arrow or A key =  Move left 

iv. Right arrow or D key =  Move right 

v. Drag mouse  =  look around and turn 

 

Step-1:  Open a drawing with 3D objects and display in a 3D view 

Step-2:  Crate a camera anywhere in the drawing and set the view to that camera 

Step-3:  3DWalk or 3DFky at the command  prompt. Command: 3DWALK 
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Step-4:  Press the Up, Down, Left, and Right keys on the keyboard to see how the camera 

location moves in the drawing and Position Locator dialog box. 

Step-5:  Move the camera and target in the Position Locator dialog box 

Step-6:  Click and drag your mouse to “fly” through the drawing 

 
Step-7:  Close the Position Locator dialog box and try walking and flying using only the 

keys on the keyboard and mouse 
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· Walk and Fly Settings 

Ribbon: Visualize tab  Navigation panel  Walk and Fly Settings.  

Controls the walk and fly navigation settings. 

 

· Settings 

Specifies settings related to the Walk and Fly Navigation Mappings balloon and 

the Position Locator window. 

· When Entering Walk and Fly Modes 

Specifies that the Walk and Fly Navigation Mappings balloon is displayed each time you 

enter walk or fly mode. 

· Once Per Session 

Specifies that the Walk and Fly Navigation Mappings balloon is displayed the first time in 

each AutoCAD session that you enter walk or fly mode. 

· Never 

Specifies that the Walk and Fly Navigation Mappings balloon is never displayed. 

· Display Position Locator Window 

Specifies whether the Position Locator window opens when you enter walk mode. 

· Current Drawing Settings 

Specifies walk and fly mode settings specific to the current drawing. 

· Walk/Fly Step Size 

Sets the size of each step in drawing units (the STEPSIZE system variable). 

· Steps Per Second 

Specifies how many steps occur per second (the STEPSPERSEC system variable). 
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PRACTICES 

 

Practice-1 

Develop an architectural 3D model of 35’ X 65’ plot dimension as per the following requirements 

Two Rooms with attached bath, Lounge, Drawing, Kitchen, Powder Bath, Store, Servant Bath, Porch 

Let the proposed drawing for above specifications/ requirement is as under: 
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Procedure 

Step 1: Draw the 2D plan of a plot whose width is 35’ and length is 65’ with the help of 2D commands as per 

given requirements. First of all, draw the 2D plan with the help of line command. Trim the required to have plan 

drawn as per given plan. Draw the lines at proper locations for positioning of doors and windows. Finish the 

drawing and annotate completely. 
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Step 2: Now create the boundary or regions to convert the 2D to 3D drawing. Create separate boundries for 

different heights of walls. Now use the extrude command in 3D isometric SE. Take the height of rooms walls 

as 11 feet and for the compound wall as 7 feet.  

 

 

Step 3: Now create the boxes of sizes equal to the sizes of doors. Place the boxes at the locations of doors. 

Apply Boolean operation of subtraction “SUBTRACT” command to have opening in the wall. First select the 

source from which you want to have openings of doors. Then after pressing Enter key select the boxes of doors. 

After the execution of command, you will have the openings of doors. 

Now create the boxes of sizes equal to the sizes of windows. Place the boxes at the locations of windows. 

Apply Boolean operation of subtraction “SUBTRACT” command to have opening in the wall. First select the 

source from which you want to have openings of windows. Then after pressing Enter key select the boxes of 

windows. After the execution of command, you will have the openings of windows. 

Now create the boxes of sizes equal to the sizes of ventilators. Place the boxes at the locations of ventilators. 

Apply Boolean operation of subtraction “SUBTRACT” command to have opening in the wall. First select the 

source from which you want to have openings of ventilators. Then after pressing Enter key select the boxes of 

ventilators. After the execution of command, you will have the openings of ventilators. 
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Step 4: Make the roof of this site plan by using extrude commands. 

 

 

Step 5: Design the parapet wall by using extrudes and subtracts commands. 
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Step 6: Make the floor with the help of rectangle and extrude commands. 

 

Step 7: Draw 3D doors, windows and ventilator by use of 2D commands and Pullpush/ extrude command. Fix 

the same by use of 3D move command. 
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Step 8: Draw 3D Main gate by use of 2D commands and Pullpush/ extrude command. Fix the same by use of 

3D move command. 
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Practice-2 

Make 3D Fan with 3 blades with dimension 12 Inches in diameter. 

Step 1: Make the 2d plan of fan whose size is 12” diameter having three blades with help of 2d commands. 

Step 2: Convert this 2d sketch into 3d model of fan by using extrude command. 

Step 3: Ake the rod of fan with the help of cylinder command 

step 4: Make the cup of the fan by using cone command 

Step 5: Make the round corner of the circle with the help of 3d fillet command 

Step 6: Make the blades of the fan by using mesh surface command  

Step 7: To join the motor rod and blades by using union command  
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Learning Unit 3:  

Render 3D Model 
 
In this learning unit you will learn how to have material and light control 

and how-to 3D navigate control 

 

After completion of this learning unit you will be able to understand 

following. 

 
v Apply material to required 3D Model as per given specification 

v Apply lights to get the requisite scene of required 3D model 

v Assign cameras to execute different views of required 3D 

Model. 

v Render and print the 3D model according to required size & 

orientation 
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3. Apply Material to Required 3D model as per Specifications: - 

Applying the materials is a relatively easy process, getting them to look exactly the same you want these. Once 

the materials are added, the lights and shadows look realistic. 

 

3.1. Material and light control. 

(Planner mapping, Texture map, Opacity control, Render context, Render sampling, etc.) 

 
3.1.1. Introduction to Render 

Rendering can be a very time-consuming aspect of a project. Because of the subtleties involved, 

you can spend a lot of time adjusting camera positions, lighting, and materials. In the past, you 

might spend more time creating a rendering than you spent actually building the 3D model. In 

addition, when you work with multiple light sources, each of which casts shadows, the computer 

calculations require a considerable amount of horsepower. Again, the good news is that the new 

tools in AutoCAD can help shorten this process, because you can now preview many aspects of 

your final image before actually creating a rendering. And as in previous versions, you can do initial 

renderings at lower quality settings or render just a portion of the final image, to test your changes 

before creating a final high-resolution rendering. 

The process of creating a computerized rendering involves four steps: 

· Create the actual model 

· Place lights 

· Attach materials to objects in the model 

· Render the image 

Other than creating the model, these procedures are conceptual rather than discrete sequential 

steps, and often are performed in an iterative process. For example, you may place some lights 

and create a test rendering. Then, after viewing the results of your test, you may change some of 

the lights and render the image again. 

3.1.2. Render Tab 

Render is used to get the most realistic and photorealistic view of your 3D drawing by adding 

realistic materials. 

Remember 
 

If the Render Option 

is not displayed on 

the Visualize tab, 

right-click the 

Visualize tab and 

click Panels 

àRender. 
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3.1.3. Texture Map 

Texture maps are useful for creating many kinds of materials, such as wood grains and wall 

surfaces. 

You can use the following file types to create texture maps: 

 

· BMP, RLE, or DIB 

· GIF 

· JFIF, JPG, or JPEG 

· PCX 

· PNG 

· TGA 

· TIFF 

  
To display he Texture Map Property Settings specific to Texture map, click the Click for Texture 

Map Settings button 

 
Procedure 

Command entry: materials 

Controls the property settings for Texture Map. 

· Click for Texture Map Settings 

Displays a window with property settings to adjust the appearance of the texture. This 

button appears once an image is selected for the Texture Map. 

 

· Collapse/Expand Display Panel 

Collapses (up arrows) and expands (down arrows) the display panel. 

 

· Texture Map Slider 

Controls the blending of the texture map with the assigned control properties for the 

material. 

 

· Scaling & Tiling 

Provides settings to adjust the scaling and tiling for the map. 

 

· Offset & Preview 

Provides settings to adjust the material offset and preview for the map. 
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3.1.4. Adding Material to a Drawing 

A material is simply an image stretched over an object to make it appear as if the object is made 

out of various materials such as wood, marble, brick, metal, plastic, glass, and so on. 

 
· To Browse Material 

 

Render Tab Button Command Entry 

Material à Browse 
Material.  

 
MARBROWSEROPEN 

 
 

Step -1 

ViewàRenderàMaterials Brower 

 

 
 
 

Step-2: Double Click or drag any of the material from material library into the document material 

list as shown in the figure below 
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Step-3: Go to the Material list and apply material as shown in the figure 

 

i. You will get the following. 

ii. Blank space showing the following 
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Step 4: Type render command in command bar to view the render with applied material. Past 

picture here 

 

3.1.5. Materials 

Material contains settings that affect how materials are handled by the renderer. 

· Apply Materials 

Apply the surface materials that you define and attach to an object in the drawing. If Apply 

Materials is not selected, all objects in the drawing assume the color, ambient, diffuse, 

reflection, roughness, transparency, refraction, and bump map attribute values defined for 

the GLOBAL material. 

i. Texture Filtering / Texture Mapping 

Specify how texture maps are filtered./  

ii. Force 2-Sided 

Control if both sides of faces are rendered. 

Visual Styles 
Control must be in 

realistic view 
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3.1.6. Control Sampling 

Control how the renderer performs sampling. 

Sampling provides a "best guess" color for each rendered pixel. The renderer first sample the scene 

color at locations within the pixel or along the pixel's edge, then uses a filter to combine the samples 

into a single pixel color. Increasing the minimum and maximum sample ranges greatly improves 

the quality of a rendering. 

If image quality is highly degraded 

· Min. Samples = 1/64; 

· Max. Samples = 1/4. 

 

In the following example, increased sampling smooth’s edges 

· Min. Samples = 1; 

· Max. Samples = 16. 

 

Note: 
Controls sampling 
can be applied. 
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i. Filter Type 

There are five filter methods: 

· Box 

· Gauss Triangle 

· Mitchell 

· Lanczos 
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3.2. Shadow 

 
Contains settings that affect how shadows appear in the rendered image. 

 
3.2.1. Mode 

· Simple 

Generates shadow shaders in a random order. 

· Sort 

Generates shadow shaders in order, from the object to the light. 

· Segments 

Generates shadow shaders in order along the light ray from the volume shaders to the 

segments of the light ray between the object and the light. 

 
3.2.2. Shadow Map 

Control if shadow mapping is used to render shadows. When on, the renderer renders shadow- 

mapped shadow. When off, all shadows are ray-traced. 

 
3.2.3. Sampling Multiplier 

 
Globally limits shadow sampling for area lights. 
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3.3. Ray Tracing 

 
Ray tracing contains settings that affect the shading of a rendered image, which effects of reflection and 

refraction. 

 
i. Max Depth 

Limit the combination of reflection and refraction. 

ii. Max Reflections 

Set the number of times a ray can be reflected. 

iii. Max Refractions 

Set the number of times a ray can be refracted 

 

3.3.1. Illumination 

Indirect illumination techniques, like global illumination and final gathering, enhance the realism of 

a scene by simulating radiosity, or the inter-reflection of light in a scene. 

 
3.3.1.1. Enable 

Specify if lights should cast indirect light into the scene. 

3.3.1.2. Photons/Samples 

Set how many photons are used to compute the intensity of the global illumination. 

Increasing this value makes global illumination less noisy but also more blurry. Decreasing 

this value makes global illumination more noisy but less blurry. The larger the Samples 

value, the greater the rendering time. 

Determine the size of photons. When on, the spinner value set the size of photon. When 

off, each photon is calculated to be 1/10 of the radius of the full scene. 

 

3.3.1.3. Radios 

Specifies the area within which photons will be used when luminance is computed. 

3.3.1.4. Max Depth 

Limit the combination of reflection and refraction. Reflection and refraction of a photon stop 

when the total number of both equals the Max Depth setting. For example, if Max Depth 

equals 3 and the trace depths each equal 2, a photon can be reflected twice and refracted 

once, or vice versa, but it can’t be reflected and refracted four times. 

3.3.1.5. Max Reflections 

Set the number of times a photon can be reflected. At 0, no reflection occurs. At 1, the 

photon can be reflected once only. At 2, the photon can be reflected twice, and so on. 
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· Diagnostic 

Diagnostic also called visual to help you understand why the renderer is behaving in a 

certain way. 

 
i. Grid: Render an image that shows the coordinate space of objects, the world, or camera. 

ii. Object. Shows local coordinates (UVW). Each object has its own coordinate space. 

iii. World. Shows world coordinates (XYZ). The same coordinate system applies to all 

objects. 

iv. Camera. Shows camera coordinates, which appear as a rectangular grid super imposed 

on the view. 

 

3.3.2. Material by Layers 

You can apply material by layer but the layer must be defined before apply “Material by layer”. In 

this example we have already defined layer for the drawing as shown in the figure below. 

 

Step-1: You can attach a material to an entire layer using the Material Attach command. 

MATERIALATTACH command in command bar <Enter> 

Output should be as follows 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 

| 398 

 Module-3 (LU-3): Develop 3D Model using AutoCAD 

 

 
 

Step-2: Apply render by render command 
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3.3.3. Create own Material 

You can create your own material to apply photo and images. 

Step-1: Type materials command in command bar or click Browse Material 

Step-2: Click Create New Material Option as shown in the figure below 

 
Step-3: Click a New Generic Material and then follow steps as described in the figure below 

 
 

 

Step-4: Browse to file for adding any Photo as shown in the figure below. 
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Step-5: Apply material to the selected object. 

 

 
Compose the papers 

 

 

Final Out Put 

 



Teaching and Learning Guide: Information Technology (CAD) AutoCAD 

 
| 401 

 Module-3 (LU-3): Develop 3D Model using AutoCAD 

 

 
 

 

 
Step-6: Apply render command to display render 
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3.4. Material Mapping 

You can map material to an object by using “MATERIALMAP” command. 

 

Step-1: Type MATERIALMAP command in command bar <Enter> 

Step-2: Select an option [Box/Planar/Spherical/Cylindrical/copy mapping to/Reset mapping]<Box>: p 

Step-3: Select faces or objects: 1 found 

Step-4: Select faces or objects: <Enter> 

Step-5: Accept the mapping or [Move/Rotate/reseT/sWitch mapping mode]: R enter 

Step-6: Rotate the selected face or object by GIZMO to map the material  applied. 

 

 
 

 

 

3.4.1. Remove Material 

You can remove Material from an object by using the following method. 

Method: 

Select the object 

Go through 3D Modeling à Render tab à Material à Remove Material 
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3.4.2. Access Advance Render Settings by the following methods 

Method-1: Type RPERF in command bar. 

Method-2: 

 

3.4.2.1. Procedure Apply Advanced Render Settings 

STEP BY STEP Operation on AutoCAD 
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GET READY. Before you begin these steps, be sure to set unit and you must have an 

object in your drawing to apply rendering. 

 

Step-1: Type RPERF command in command bar <Enter> 

Step-2: Select destination field and switch into viewport as shown below 

Step-3: Type render command in command bar. 

Step-4: Repeat the above steps for Window destination 

 

 
3.4.2.2. Deference between window and viewport:  

A separate window is open for window destination which you can save for future use while 

viewport destination rendered the drawing in the same window, which cannot be save and 

for temporary display 

 
i. Quality Setting 

You can set the quality of image for rendering by using Advance Render Setting as shown 

in figure below 
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ii. Crop Procedure 

 
 

Step-1: Type RPERF command in command bar <Enter> 

Step-2: Select Procedure field and switch into crop as shown below 

Step-3: Apply render by using render command 
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iii. Selected Procedure 

Step-1: Type RPERF command in command bar <Enter>. 

Step-2: Select Procedure field and switch into Selected as shown below. 

Step-3: Apply render by using render command. 

 

iv. Render to File and Turn off Render to File. 

You can turn on/off Render to file by the following procedure. 
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3.4.3. RENDERENVIRONMENT 

Create fog effect to enhance sense of distance. 

Step-1: Type RENDERENVIRONMENT command in command bar <Enter> 

 

Step-2: Apply render 
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· Creating Views and Applying Background 

View is used to create, set, rename, modify, and delete named view, including model 

named views and camera views, layout views, and preset view. 

Here we are using view command or view manager to set different background. 

Step-1: Type view command in command bar or click View tab àviews Manager to get 

the following. 

 

Step-2: Click the new button and get the following properties setting as shown in the figure below. 
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Step-3: Click the Edit Boundary option to define your own boundary for the background as shown 

in the figure below. 
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Step-4: After defining the boundary press Enter, you will get back to View Manager Window. 

 
 

Step-5: Now select background option to apply one of the three option of background as show in 

figure below. 

 

Step-6: Here we are going select the image option to select image from file and click Ok as shown 

in figure. 
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Step-7: Select view from view control as follow 

You should get the follow Out Put 
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Opacity is the opposite word for transparency. Each material has five categories of parameters you 

can set: Pattern, Reflectance, Transparency, Texture and Wrapping. Not all categories are used 

for each material, only those that are relevant.  

i. Select a material in the Materials Palette 

ii. Right click and select Edit Materials. 

iii. When the Render Manager appears click the small green help button. This will open the 

Lightworks help, which is replete with details on functions and settings. 

 

 

In the Preview section, you can change the shape and orientation of the preview object. Under 

Options, you can toggle the display of the preview object or desk. If Auto Update is checked, the 

preview will update each time a change is made (otherwise you must click the Preview button). 

 
The toolbar on the right side of the editor allows you to specify the elements of the preview. 

You can navigate within the preview window using the center mouse button. 

You can also see approximately how the material will appear on an object by entering a value into 

the Model Size field. Simply specify a size that is close to the size of the object to which you will 

be applying the material. Alternately, you can use the selection arrow under the preview. 

3.4.4. Opacity Control 
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This will show you exactly how the material will appear on the selected object. 

Warning: If the selection arrow is the specified option for the preview object, and no object is 

selected, you will get a warning that a preview cannot be generated. This will also happen if the 

selection arrow is the default and you open the Render Manager with no object selected. 
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3.5. Apply Lights. 

 

You will also be able to differentiate between the functionality of different types of light and its 

implementation in the drawing and get understanding of geographical location setting by specifying the 

latitude and longitude of a location for the sunlight. 

3.5.1. Light  

As we know that without a light, the scene cannot be looked attractive and realistic. Rendering has 

four conceptual steps to develop drawing more realistic. 

· Create the model 

· Attach materials to objects 

· Render the image 

· Place lights 

 

We already discussed the first three steps of rendering “Creating the model, attach material and 

then Render the image or drawing”, the last conceptual step Place lights will we covered in this unit 

3.5.2. Creating a Light Source  

AutoCAD has four kinds of lighting, each with a distinct method for distributing light rays into the 

scene. They are as follows: 

i. Point Light: 

All light rays are emitted from a single location and diverge as they get farther away. An 

incandescent light bulb is a real-world example of a point light, even though the light does 

not travel in the direction of the light’s fixture. 

ii. Spotlight: 

With this type of light, rays are emitted from a single point, but they are restricted to a conical 

portion of the amount of light that a similar point light would emit. Flashlights and headlights 

are examples. 

iii. Distant Light: 

With this type of light, all light rays are parallel. Although the sun is technically a point light, 

at the enormous distance the light rays travel to Earth, they are nearly parallel 

iv. Weblight:  

These are photometric lights with real-world distributions. These lights can be used in 

conjunction with light distributions derived by manufacturers of real-world lights. Using 

manufacturer data to establish lighting distributions helps ensure more accurate 

representation of rendered lights than possible when using point or spotlights. 

 

3.5.3. Default Lighting  

 

When there are no lights in a scene, the scene is shaded with default lighting. Default lighting is 

derived from two distant sources that follow the viewpoint as you move around the model. All faces 

in the model are illuminated so that they are visually discernible. You can control brightness and 

contrast, but you do not need to create or place lights yourself. 

When you insert custom lights or add sunlight, you can disable the default lighting. You can apply 

default lighting to the viewport only; at the same time, you can apply custom lights to the rendering. 
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3.5.4. Turn On/Off the default Lighting  

 

You can turn On/Off the default lighting by using “DEFAULTLIGHTING” command as shown below 

 

Method-1: 

Step-1: Type DEFAULTLIGHTING command in command bar <Enter> 

Step-2: Enter an option 

 

· Enter new value for DEFAULTLIGHTING <0>: 1 <For On> 

· Enter new value for DEFAULTLIGHTING <1>: 0 <For Off> 

 

Method-2: Follow the figure below. 
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3.5.5. POINTLIGHT  

Point light that radiates light in all directions from its location. 

Step-1: type pointlight command in command bar <Enter> 

Or  

Click go through 3D Modelling render tab Light PointLight 

Step-2: Specify source location <0,0,0>: <Click or Define Source Location> 

 

 
 

Step-3: Apply Rendering 
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3.5.6. Photometric Lights 

You can control over lighting; you can use photometric lights to illuminate your model. To change 

the intensity of light, you should follow the following figure step by step. 

 
 

Apply Rendering 

 

 

3.5.7. SPOTLIGHT 

Spot Light emits a directional cone of light 

Step-1: type spotlight command in command bar <Enter> 

Or  

Click go through 3D Modelling → render tab → Light→ SpotLight  

Step-2: Specify source location <0,0,0>: <Click or Define Source Location>  

Step-3: Specify target location <0,0,0>: <Click or Define Source Location> 
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3.5.8. Modification of Lights  

You can modify in light target location and area to cover by using LIGHTLIST command. 

Type LIGHTLIST command in command bar <Enter> you will get the following as shown in the 

figure below 

 
 

 

3.5.9. Lights Tool Palette  

Default lights can be added to your drawing from the Tool Palette menus  

· Press Ctrl + 3 From Keyboard to display Light tool palette 
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3.5.10. DISTANTLIGHT  

Distance light is used for uniform parallel light rays in one direction and mentioning from and to 

points. 

Step-1: type distantlight command in command bar <Enter> 

Or  

Click go through 3D Modelling →render tab →Light →DistantLight 

Step-2: Specify light direction FROM <0,0,0> or [Vector]:: <Click or Define Source Location> 

Step-3: Specify light direction TO <1,1,1>: <Click or Define Source Location> 

Step-4: Enter an option to change [Name/Intensity/Status/shadoW/Color/eXit] <eXit>: <Enter 
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Creating Camera3.6.1.

To Access Camera 

 

Render Tab Button Command Entry 

 

Camera panel à Create Camera 

 

 

 

Cam/camera 

 

Step-1:  Type cam/camera command in command bar <Enter>  

Step-2:  Click in the drawing to specify the camera’s location.  

Step-3:  Click again in the drawing to specify a target location. 

Step-4:  Press Enter to Finish, you will get the following as shown in figure below 

 
 

Step-5: To View the Camera, just click the camera location, you will get the following as shown in 

the figure below 

· 3D Navigate control (camera settings, scene creation, Walk, Constrained Orbit, etc.)

following.

Further you can define  its  name, height,  lens  length, and clipping planes. This can ve achieved by the 
objects. 
3D  view. You  can  Set  a  camera  and  target  location  to create  and  save  3D  peSSPective  views  of  

Camera is used to define a 3D view; you can place camera anywhere in the drawing to define a specific 

3.6.  Assign Cameras to execute different Views of Required 3D Model
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Step-6: You can show/hide the camera by clicking show camera button as shown in figure below 

 

 
 

Step-7: Lens length setting can be adjusted according to X, Y and Z coordinates as shown in the 

figure below. 
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To further define camera properties, you will get properties on the screen while you setting up 

camera or you can right-click and select from the list of options. 

 
3.6.2. Camera Properties 

Display a list of the currently defined Cameras if any.Just enter the name of  

the Camera or press Enter to list all cameras if created. 

Name You can Enter Name of the New Camera, if you never enter name of the Camera, 

by default it willnamed camera1, camera2… so on. 

Location          Specifies the location of the camera as we discussed previously. 

Height  You can define or changes the camera height. 

Target              Specifies the target of the camera as we discussed previously. 

Lens                 Changes the lens length of the camera as we discussed previously. 

Clipping           Defines front and back clipping planes and sets their values. 

 

3.6.3. Make Animation file in Auto CAD  

Animation Path is 3D Camera view through which you can view the object/s in as animated motion 

via a specified path. 

In the drawing, you can create a path object for either the camera or the target 

A path can be a line, polyline, 3D polyline, arc, elliptical arc, circle, or spline. To Access Camera 

 

Render Tab Button Command Entry 

 

Main Manu à  View àAnimation. 

 

                 

              ANIPATH 

 

We are going to apply animation path on drawing as shown in the figure below. 
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Step-1: Draw a line/polyline to consider a path for animation. 

 
 

 

Step-3: Type ANIPATH command in command bar or Click Render Tab àAnimations panel 

àAnimation Motion Path. 

 

Step-2: In the Motion Path Animations dialog box, do the following: 

i. Specify a point or path for the camera. 

ii. Specify a point or path for the target. 

iii. Modify any animation settings as you want. 
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For practice we select. 

i. Path for the camera. 

ii. Point for the Target. 

iii. Click Preview to View your work. 

iv. Click OK to save the file as shown in the figure-2. 
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Output Look like 

 

 

3.6.4. Walk and Fly 

You can simulate walking and flying through a 3D drawing. 

When you walk through a model, you travel along the XY plane. When you fly through a model, 

you are not constrained by the XY plane, so you appear to “fly” over an area in a model. 

The following shortcuts are available for walking: 

Up arrow / W key 

Move forward Down arrow / S key 

Move backward Left arrow / A key 

Move left Right arrow / D key 

Move right Drag mouse around & turn 

Step-1:  Open a drawing with 3D objects and display in a 3D view 

Step-2:  Crate a camera anywhere in the drawing and set the view to that camera 

Step-3:  3DWalk or 3DFky at the command prompt. Command: 3DWALK 

The following Position Locator dialog box will appear that you can use to navigate your drawing. 

 

 



- 427 - 

  Module-3 (LU-3): Develop 3D Model using AutoCAD 

 

 
 

Step-4:  Press the Up, Down, Left, and Right keys on the keyboard to see how the camera location 

moves in the drawing and Position Locator dialog box. 

Step-5:  Move the camera and target in the Position Locator dialog box 

Step-6:  Click and drag your mouse to “fly” through the drawing 

 
 

Step-7: Close the Position Locator dialog box and try walking and flying using only the keys on the 

keyboard and mouse 

 

3.6.5. Walk and Fly Settings 

If you are working in a drawing with a large architectural scale, be sure to set your drawing units to 

a large number, similar to the scale of the drawing. 
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· A-Settings 

Specifies settings related to the Walk and Fly Navigation Mappings balloon and 

the Position Locator window. 

 

i. When Entering Walk and Fly Modes 

Specifies that the Walk and Fly Navigation Mappings balloon is displayed each time you 

enter walk or fly mode. 

ii. Once Per Session 

Specifies that the Walk and Fly Navigation Mappings balloon is displayed the first time in 

each AutoCAD session that you enter walk or fly mode. 

iii. Never 

Specifies that the Walk and Fly Navigation Mappings balloon is never displayed. 

iv. Display Position Locator Window 

Specifies whether the Position Locator window opens when you enter walk mode. 

 

· B- Current Drawing Settings 

Specifies walk and fly mode settings specific to the current drawing. 

i. Walk/Fly Step Size 

Sets the size of each step-in drawing units (the STEPSIZE system variable). 

ii. Steps Per Second 

Specifies how many steps occur per second (the STEPSPERSEC system variable). 
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3.7. Render and Print the 3D Model According to Required Size & Orientationl 

 
3.7.1. By Render Command 

Creates a photorealistic or realistically shaded image of a three- dimensional wireframe or solid 

model 

Step-1:  Open an AutoCAD drawing with 3D objects to render 

Step-2:  RENDER at the command prompt. Command: RENDER 

The following render window is the result of default rendering 
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3.7.2. Render Quality 

Step 1: Type RPREF at the command prompt 

Step 2: Click the dropdown option for the render quality and choose Presentation 

 

3.7.3. Render Selection 

Controls the parts of the model that gets processed during rendering. The render procedure has 

three settings: View, Crop, and Selected 

Step 1:  Type RPREF at the command prompt 

Step 2:  The dropdown option for Procedure and choose Selected. 

 

The render preferences and render selected objects 

This result is a selected object in the drawing that is rendered. 

Note:  Depending 
on the objects, 
lights, materials, 
etc.  In your  
model, rendering in 
presentation mode 
might take a long 
time 
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3.7.4. Render Cropped Window 

 
Step 1: Type RPREF at the command prompt 

Step 2: The dropdown option for Procedure and choose Cr 

 
 

The render preferences and render a cropped window. 

The result is a cropped portion of the drawing that is rendered. 
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3.7.5. Print The 3D MODEL 

Step 1:  Type PLOT at the command prompt (Ctrl +P) 

 

Render Tab Button Command Entry 

Main Manu à File àPlot. 
 

Ctrl + P 

 

Open the Plot Window 
 
 
 

 
Step 2: Open the Plot window   

i. Select Plotter/Printer 

ii. Select Page Size 

iii. Select Plot area 

iv. Center the plot 

v. Set the plot Scale 

vi. Select shade plot 

vii. Select Print Quality 

viii. Save the layout 

ix. Select drawing Orientation 

x. Preview 

xi. Set number of copy 

xii. Ok 
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3.7.6. Constrained 3D Orbit 

3DORBIT activates a 3D Orbit view in the current viewport. You can view your entire drawing or 

select one or more objects before starting the command. 

When 3DORBIT is active, the target of the view stays stationary and the camera location, or point 

of view, moves around the target. However, from the user's point of view, it appears as if the 3D 

model is turning as the mouse cursor is dragged. In this way, you can specify any view of the model. 

Open a drawing with 3D objects. 

Choose View, Orbit, Constrained Orbit. 

or 

Type 3D Orbit at the command prompt. 

Command: 3DOrbit 

Click and drag to move your object in 3D. 

 

!

!

!

!

3.7.7. Zoom and Pan in 3D Orbit 

Click the right mouse button while in the 3D Orbit 

command. 

Choose Zoom Window from the pop-up menu. 

Zoom to a new area of the 3D drawing. 

Click the right mouse button while in the 3D Orbit 

command. 

Choose Zoom Previous or Zoom Extents  

!

!

!

!

!

!

!
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· Pan 

Click the right mouse button while in the 3D Orbit 

command. 

Choose Other Navigation Modes from the pop-up menu. 

Choose Pan. 

Pan to a new area of the drawing. 

Click the right mouse button while in the 3D Orbit 

command. 

Choose Other Navigation Modes from the pop-up menu. 

Choose Constrained Orbit to set the mode back to orbit 

!
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PRACTICES 

 

Practice-1 

Create and Apply wood material with the following material settings to previously created object in AutoCAD 

· Opacity 70% 

· Adjust Bitmap setting 

 

i. Fit to object 

ii. Un check tiles 

iii. Visual style: realistic. 

 

Step-1: Type materials command in command bar or click Browse Material 

 

Render Tab             Button Command Entry 

Material à Browse Material. 
 

Marbrowseropen 

 

Step-2:  Create New Material Option as shown in the figure below. 

 

 
 

Step-3: Click a New Generic Material and then follow steps as described in the figure below Write down step. 

Set the Transparency= 30% which will result 70% opacity. 
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Step-4: Right-click a material in the Document Materials section and click Edit 

 

 
 

Step-4: Render the viewport to see the material changes 

Step-5: Change one or more properties of the material. Select wood material e.g. door and window as under 
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Practice-2 

Apply spot and point light to previously created drawing and then render the drawing to show applied materials 

and lights. 

· Point Lights 

A point light radiates light in all directions from its location 
 

Step-1: Type POINTLIGHT at the command prompt à Enter 

Step-2: Turn Off default lighting in the following prompt if default lighting was on: 

 

 
 

 
Step-3: Specify source location <0,0,0>: .XY of pick bottom center of bottle (need Z): 15 

Step-4:  Enter an option to change [Name/Intensity/Status/shadoW/Attenuation/Color/eXit] à Enter 

Step-5: Render the current viewport View rendered using a point lite. Select the locations of the point lights as 

shown in the following drawings. Change light settings as per room requirements. 
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SPOTLIGHT 

 

A spotlight emits a directional cone of light. 

 
Step-1: Type SPOTLIGHT at the command prompt à Enter 

Step-2: Specify source location <0,0,0>: P1 

Specify target location <0,0,-10>: P2 

Enter an option to change [Name/Intensity/Status/Hotspot/Falloff/shadoW/ Attenuation/Color/eXit] <eXit>: 

press enter 

 

Step-3: Render the current viewport View rendered using a spotlight. 

One spot light from front and from left side. 

 

 
 

 

Step-4: Render the current viewport View rendered using a spotlight. 

One spot light from front and from left side with main gate. 
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Summary of Module 

Mesh split, Merge face, Mesh cap, helped you to edit mesh as you considered necessary.

which helped you to sharpen or crease the edges of mesh objects. Editing meshes command such as Mesh extrude, 
value. We also learnt about the adjustment of the smoothness of mesh and how to add or remove mesh crease 
circumscribed perimeter, Mesh wedge and Mesh torus which was used to create ring shape surface of two radius 
draw  cone,  Mesh  cylinder  used  to  create  cylinder  of  varying  radius,  Height,  Mesh  pyramid  of  inscribed  / 
various Mesh command such as mesh box used to create rectangular or cubical mesh box, Mesh cone used to 
In addition we learnt about fundamental mesh primitive command by which we can reshape mesh objects by using 

3Dface and edge.

Further we covered making of 3D Faces with Invisible and visible edge concepts by using pre-defined command 
areas like triangular areas and quadrilateral area with different colors and FILLMODE ON/OFF concepts as well. 
We learnt the concept of solid-filled area by using its pre-defined command in AutoCAD, filled two types of polygonal 

3D model.

for motion path animation along the XY plane, and saved the animation file of a camera moving and panning in a 
projection by using a camera and target with the help of DVIEW command. We also learnt the command ANIPATH 
peSSPective 
the   drawing   to   visualize   the   object/s   from   different sides   and   applied   dynamic   view   for   parallel   and   
We learnt about the camera setting for the objects in the drawing and created different position for the camera in 

collaboration of parallel and peSSPective projections mode.

drawing.  We  also  covered  different  visual  styles,  visual  aids,  preset  views  and  fly  and  walk  view  with  the 
space constrained to horizontal and vertical orbit, freely orbiting and continuously orbiting on selected object/s and 
With the completion of this module we acquainted with the AutoCAD 3D Orbit functionality to rotate the view in 3D 
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Question and Answers: 

 

FAQ - 1 Use of Polysolid Command? 

Answer : You can create walls with straight and curved segments of constant height and width. With the 

POLYSOLID command, 
 

FAQ - 2 Define inscribed or circumscribed perimeter?. 

Answer :  Specify whether the pyramid base is drawn inside or outside of the radius 

 
  Circumscribed           Inscribed 

FAQ - 3 How can you select face of 3D object? 

Answer : Press Ctrl+Click to select faces and edges on 3D objects. 

 

FAQ - 4 What is the use of loft command? 

Answer : LOFT command creates a solid by joining several crass sections lying on different 

 

FAQ - 5 Which command is used to hollow the object? 

Answer : Shell command 

 

FAQ - 6 Which command is used to color the face of an object? 

Answer : Color faces 

 

FAQ - 7 What is the location of modify solid tools? 

Answer : Main menuàmodifyàsolid editingàsolid editing tools 

 

FAQ - 8 How many options of extrude faces? 

Answer : Two 

1:  height   2:  path 

 

FAQ - 9 How can we pick the imprint command from menu? 

Answer : Main menuàmodifyàsolid editingàimprint 

 

FAQ - 10 How could you get render crop? 

Answer : You  can  get  render  crop  by  using  rendercrop  command  or  from  3D  Modellingàrender 

tabàrender region. 

 

FAQ - 11 How could you display rendered windows without rendering option? 

Answer : You can get render windows from 3D-Modellingàrender tabàrender windows. 
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FAQ - 12 How could you switch between different rendered windows without rendering option? 

Answer : Go through 3D-Modellingàrender tabàrender windows and switch between different render 

windows if you created with different setting. 

 

FAQ - 13 Is there any option to off material applied to an objects by using RPREF command? 

Answer : Yes! You can turn off material by using RPREF command in Materials option of Advance 

Rendering Properties. 

 

FAQ - 14 How can you search for materials? 

Answer : You can search for materials via search bar in Browse Materials dialog box  

 

FAQ - 15 How could you display Camera in render Tab, if camera option is not displayed? 

Answer : If the camera option is not displayed on the Visualize tab, right-click the Visualize tab and click 

panels à camera 

 

FAQ - 16 What is the purpose of EXTRUDE command? 

Answer : Creates a 3D solid or surface by extending the dimensions of an object in z-axis. 

 
FAQ - 17 What is a spot light? 

Answer : With this type of light, rays are emitted from a single point, but they are restricted to a conical portion 

of the amount of light that a similar point light would emit. Flashlights and headlights are examples. 

 

FAQ - 18 What is a point Light? 

Answer : All light rays are emitted from a single location and diverge as they get farther away. An 

incandescent light bulb is a real-world example of a point light, even though the light does not travel 

in the direction of the light’s fixture. 

 
FAQ - 19 What is the purpose of 3D Rotate? 

Answer : 3D Rotate command helps to constrain or in rotation of 3D objects and sub-objects along any 

axis up to a specified angle 

 

FAQ - 20 What is the difference between Transparency and Opacity? 

Answer : Transparency is the opposite of opacity. Transparent materials have visualization through them. 

Whereas the opaque materials have no visualization through them. 

 

FAQ - 21 What is the difference between Move and 3D Move? 

Answer :  Move command moves an object in two directions i.e. along x and y-axis. Whereas 3D Move 

command can move an object in three directions i.e. along x, y, and z-axis.  

 

FAQ - 22 Prepare list of Boolean operations. 

Answer : (1) Union  (2) Subtract  (3) Intersect 
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FAQ - 23 What is meant by Boolean Operations? 

Answer : The Boolean commands work only on solids or regions. The first stage in a solid model creation 

consists in obtaining one or more primitives. The next stage consists in using Boolean operations 

of Union, Subtract or Intersect in order to create the solid model. 

 

FAQ - 24 What is the function of vertical integration IN AutoCAD? 

Answer: The vertical integration program is used by AutoCAD to enrich the architectural designing of a 3D 

object. It includes elements that contain data as well as simple objects such as circles and lines. 

The information is structured to display the architectural products and the files that are extracted. 

These can be again worked as per the requirement. 

 

FAQ - 25 What is the use of variant in AutoCAD? 

Answer: Variants are utilized in AutoCAD to assist in the creation, conceptualization, and rendering of the 

3D models that incorporate 3D printing as well. They enable you to employ the functionality of the 

various application as per the need. 

 

FAQ - 26 How you can create a user interface in Autocad? 

 
Autocad Interview Questions 

Answer: User interface can be created by using the command prompts to draw the plots and dialog boxes. 

The dialog boxes can be displayed by the use of PLOT command and the external database 

commands (ASE).  Setting of CMDDIA to 1, allows the dialog boxes to run the command.  The user 

interface creation also needs the command line to display the entire file so that it can be edited or 

customized easily 

 

FAQ - 27 What is the use of variant in Autocad? 

Answer: In Autocad variants are used to help in creation, visualizing and rendering the 3D models that 

include 3D printing as well.  Variants allows you to use the functionality of different application 

according to the requirement. 
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FAQ - 28 How can you make a spring, spiral or screw thread? 

Answer: To make a spiral or screw thread use an AutoLISP routine such as spiral.1sp, it will create a spiral 

path according to your need. Then you can use EXTRUDE command with a reference object, using 

the spiral as the path.  Also, there is another way you can do this, by using Mechanical Desktop 

(MDT) or Autosurf by using augmented lines as path. 

 

FAQ - 29 What is Wireframes ? 

Answer: A wireframe model is a skeletal description of a 3D object. There are no surfaces in a wireframe 

model; it consists only of points, lines, and curves that describe the edges of the object. With 

AutoCAD you can create wireframe models by positioning 2D (planar) objects anywhere in 3D 

space. AutoCAD also provides some 3D wireframe objects. 

 
FAQ - 30 What is Solids modeling ? 

Answer: Solid modeling is the easiest type of 3D modeling to use. With the AutoCAD solid modeler, you can 

make 3D objects by creating basic 3D shapes: boxes, cones, cylinders, spheres, wedges, and tori 

(do-nuts). You can then combine these shapes to create more complex solids by joining or 

subtracting them or finding their intersecting (over-lapping) volume. You can also create solids by 

sweeping a 2D object along a path or revolving it about an axis. 
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Test Yourself 

 

Multiple Choice Questions (MCQs) 

 

1) The Model which is created by using basic entities of 2-dimenstioning is called_______.  

a) Surface model  

b) Wire frame model  

c) Solid model 

d) Isometric model 

 

2) Type of model which is commonly used are_____. 

a) Simple model 

b) Composite model 

c) Isometric model  

d) Solid model 

 

3) In which of the type of wire frame model is used for drawing flat objects______?. 

a) 2D wire frame model 

b) 2.5 wire frame model 

c) 3D wire frame model 

d) Solid model 

 

4) The ______________ form the bases for surface models. 

a) Surface model 

b) Solid model 

c) Wire frame model 

d) Isometric model 

 

5) The wire frame entities are_______?  

a) Plane surface 

b) Ruled surface 

c) Tabulated surface 

d) Polygons surface 

 

6) AutoCAD 3D basic ribbons are_____. 

a) Home  

b) Render  

c) Insert 

d) All of above 
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7) AutoCAD 3D modeling ribbons are_______? 

a) Surface 

b) Mesh 

c) Render 

d) All of above 

 

8) The representation of complex object which is not to be drawn by wireframe model is called______. 

a) Surface model 

b) Wire frame model  

c) Solid model  

d) Isometric model  

 

9) For the creation of pyramid, the option is_____. 

a) Sides 

b) Edges 

c) Frustum  

d) a, b and c 

 

10) What is the usefulness of view ports________? 

a) Allow us to see the screen or on paper different views of the same project. 

b) Give us the ability to see projects have become a newer version of AutoCAD from ours. 

c) We can make a change in one part of the plan, without effecting the rest.  

d) None of the above 

 

11) To print the entire project, you will choose to regulate what to plot? 

a)   Display  

b) Extends  

c)   Limits  

d) Windows 

 

12) Which of the following is NOT a property of an object? 

a) Line weight  

b) Measure 

c) Hyperlink 

d) Elevation 
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13) Which command convert discrete object in polyline? 

a) Union 

b) Subtract  

c) Join 

d) Polyline 

 

14) The primary difference between the model tab and the layout tab (s) is __________.  

a) The model tab is used for drawing 3D and a layout is used for drawing in 2D. 

b) The model tab is where you create the drawing a layout tab represents the sheet that you will plot 

are print on. 

c) The color of the background  

d) The model tab displaces the drawing you are coping from and the layout tab is where your layout 

the new drawing. 

 

15) What is the purpose of copy faces command? 

a) Copy faces                                                           

b) Copy Edge 

c) Copy object 

d) Both a and b 

 

16) From which menu, we can pick the 3D move? 

a) Draw 

b) Modify 

c) Format 

d) Dimension 

 

17) What is the use of copy faces? 

a) Faces extrude height                                           

b) Copy faces 

c) Move faces  

d) None of these 

 

18) How many options of extrude faces are available? 

a) Two 

b) Three 

c) Five 

d) Seven 
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19) What is the purpose of shell command? 

a) To Cut the object 

b) To change the plane 

c) To hollow the object 

d) None of these 

 

20) Which Visual Styles must be in ------------------------ view while you apply materials? 

a) Conceptual View 

b) Realistic View 

c) Hidden View 

d) None 

 

21) Command for Advance Render Properties? 

a) RPREF  

b) RENDER 

c) RPROP  

d) Both b and c 

 

22) Command for Materials Attach to an entire layer? 

a) Materials 

b) Materiallist 

c) Materialattach 

d) None 

 

23) Command for material mapping? 

a) Material Mapping 

b) Material map 

c) Material 

d) Materialist 

 

24) Command used for Light list is ----------------? 

a) LIGHTLIST 

b) LIST 

c) LLIST 

d) Both b and c 
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25)

 

26)  

 

27)  

28)

 

Command for zoom orbit?29)

a) Z 

b) 3DZ 

c) 3DZOOM 

d) Both b and c. 

 

What will happened if you used solid extrude co30) mmand on an open 2D Geometry. 

a) It will not create extrusion 

b) It will extrude a surface 

c) Command line will from you to make closed boundary before using extrude command 

d) Region will be created from extrusion 

 

 

  

d) None

c) Exit the active command

b) Delete the object

a) Reset the view

ECS button is used to?

oned)N

oth Parallel and perspectivec)B

nly Perspective viewSSPb)O

arallel viewa)P

Fly orbit works in_________________.

oth b and cd)B

c) FORBIT

b) 3DFORBIT

a) Ctrl + Click

Short cut key for Free Orbit.

oned)N

elected and entire drawingc)S

nly selected objectb)O

ntire Drawinga)E

3D Orbit is used to revolve?
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Answers key: 

 

1 B 2 D 3 A 4 B 5 D 

6 D 7 D 8 A 9 D 10 A 

11 C 12 B 13 C 14 B 15 D 

16 B 17 B 18 A 19 C 20 B 

21 A 22 C 23 B 24 A 25 C 

26 B 27 B 28 C 29 C 30 B 

 
  




